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Anexa nr. 7 

la Documentația standard nr._____ 

din “____” ________ 20___ 

CERERE DE PARTICIPARE 

Către  CENTRUL PENTRU ACHIZITII PUBLICE CENTRALIZATE IN SANATATE 

Stimaţi domni, 

     Ca urmare a anunțului/invitației de participare/de preselecție apărut în Buletinul achizițiilor 

publice și/sau Jurnalul Oficial al Uniunii Europene,  nr. ocds-b3wdp1-MD-1744812909692 din 
16.04.2025, privind Achiziționarea dispozitivelor medicale conform necesităților 
insituțiilor medico-sanitare publice (listă suplimentară nr.7),  noi Medist Grup SRL, am luat 

cunoștință de condițiile și de cerințele expuse în documentația de atribuire și exprimăm  prin prezenta 

interesul de a participa, în calitate de ofertant/candidat,  neavînd obiecții la documentația de atribuire. 

Data completării 30.05.2025

Cu stimă, 

Ofertant/candidat 

Gabriela-Cristina Anghel 
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DECLARAŢIE 

privind valabilitatea ofertei 

Către:  CENTRUL PENTRU ACHIZITII PUBLICE CENTRALIZATE IN SANATATE 

Stimaţi domni, 

    Ne angajăm să menținem oferta valabilă, privind Achiziționarea dispozitivelor medicale 

conform necesităților insituțiilor medico-sanitare publice (listă suplimentară nr.7), pentru o 

durată de 160 (una sută șasezeci) zile, respectiv până la data de 15/12/2025 (ziua/luna/anul), și ea va 

rămâne obligatorie pentru noi și poate fi acceptată oricând înainte de expirarea perioadei de 

valabilitate. 

Data completării 30.05.2025

  Cu stimă, 

Ofertant/candidat 

Gabriela-Cristina Anghel 

(semnătura autorizată) 
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DECLARAȚIE 

Subsemnata Gabriela Anghel, reprezentant împuternicit al  MEDIST GRUP S.R.L, cu sediul în 
mun. Chișinău, str. M.G. Bănulescu-Bodoni  25, Oficiul 33,  declar pe propria răspundere că: 

- instalarea și instruirea personalului beneficiarului privind utilizarea echipamentelor livrate, vor fi

organizate la sediul beneficiarului de către personal autorizat.

- termenul de garanție pentru echipament nu mai mic de 24 de luni,conform fiecărui lot în parte din

data instalării/livrării, va fi certificat conform specificației tehnice pentru fiecare lot.

- garantăm perioadă de reacție, jumătate de oră sau mai puțin la telefon și 24 ore sau mai puțin la

locul beneficiarului în cazul apariției defecțiunilor tehnice

- anul producerii dispozitivului este 2024.

-organizarea pe perioada garanției a inspecțiilor planificate/întreținere profilactică și calibrare conform

programului stabilit și mentenanța dispozitivului medical pe durata perioadei de garanție va fi

efectuată de către un inginer calificat.

- livrarea componentelor sistemului vor fi noi (nefolosite).

- bunurile ce urmează a fi achiziționate sunt înregistrate în Registrul de Stat al Dispozitivelor Medicale,

mai jos dovada:

Data completării 30.05.2025      Cu stimă, 

Ofertant/candidat 

Gabriela-Cristina Anghel 

(semnătura autorizată) 





MINISTERUL MEDIULUI
AL REPUBLICII MOLDOVA

AGENŢIA DE MEDIU

MINISTRY ENVIRONMENT
OF THE REPUBLIC OF MOLDOVA

ENVIRONMENTAL AGENCY

MD-2005 mun.Chişinău, str. Albișoara, 38
Tel. (022) 820-770, Email: am@am.gov.md

CONFIRMARE

privind înregistrarea în „Lista producătorilor” de produse 
supuse reglementărilor de responsabilitate extinsă a producătorului

(echipamente electrice și electronice)

În  scopul  plasării  pe  piață  a  produselor  de  echipamente  electrice  și
electronice, în conformitate cu  prevederile art. 12 alin. (5) și alin. (14) lit. b) din
Legea  nr.  209  din  29.07.2016  privind  deșeurile,  și  punctele  46  –  50  din
Regulamentul  privind deșeurile  de echipamente electrice  și  electronice,  aprobat
prin Hotărîrea Guvernului nr. 212 din 07.03.2018, se emite numărul de înregistrare

MD2024-6-EEE-140

pentru MEDIST GRUP   SRL, IDNO: 1018600004516, cu adresa juridică:
mun. Chişinău,  str. Mitropolit Bănulescu-Bodoni 25, of 33.

Numărul de înregistrare este valabil începînd cu data de 20.06.2024 pînă la
data de 20.06.2027.

Director adjunct 
Radu STRATUTA





Anexe la SNC

“Prezentarea situatiilor financiare”

Aprobat de Ministerul Finantelor

al Republicii Moldova

SITUAȚIILE FINANCIARE

pentru perioada 01.01.2023 - 31.12.2023

Entitatea:  MEDIST GRUP S.R.L.

Cod CUIÎO:  41247072

Cod IDNO: 1018600004516

Sediul:

MD:

Raionul(municipiul): 105, DDF BUIUCANI

Cod CUATM: 0120, SEC.BUIUCANI

Strada: Mitropolit Gavriil Banulescu-Bodoni nr.25 of.33

Activitatea principală: G4646, Comert cu ridicata al produselor farmaceutice

Forma de proprietate: 23, Proprietatea statelor străine

Forma organizatorico-juridică: 530, Societăţi cu răspundere limitată

Date de contact:

Telefon: 06868147

WEB:

E-mail:  natalia.mutu@medist.md

Numele și coordonatele al contabilului-șef:  Dl (dna) Natalia Mutu Tel. 068681147

Numărul mediu al salariaților în perioada de gestiune:  5 persoane.

Persoanele responsabile de semnarea situațiilor financiare*  Gabriela Anghel-Cristina

Unitatea de măsură: leu

BILANŢUL

Anexa 1

la 31.12.2023

Nr. cpt. Indicatori Cod rd.

Sold la

Începutul perioadei

de gestiune

Sfîrșitul perioadei de

gestiune

1 2 3 4 5

A C T I V

A. ACTIVE IMOBILIZATE

I. Imobilizări necorporale

1. Imobilizări necorporale în curs de execuție 010

2. Imobilizări necorporale în exploatare, total 020

din care:

2.1. concesiuni, licențe și mărci

021

2.2. drepturi de autor și titluri de protecție 022

2.3. programe informatice 023

2.4. alte imobilizări necorporale 024



3. Fond comercial 030

4. Avansuri acordate pentru imobilizări necorporale 040

Total imobilizări necorporale

(rd.010 + rd.020 + rd.030 + rd.040)
050

II. Imobilizări corporale

1. Imobilizări corporale în curs de execuție 060

2. Terenuri 070

3. Mijloace fixe, total 080 3028298 3859991

din care:

3.1. clădiri

081

3.2. construcții speciale 082

3.3. mașini, utilaje și instalații tehnice 083 3018214 3854288

3.4. mijloace de transport 084

3.5. inventar și mobilier 085

3.6. alte mijloace fixe 086 10084 5703

4. Resurse minerale 090

5. Active biologice imobilizate 100

6. Investiții imobiliare 110

7. Avansuri acordate pentru imobilizări corporale 120 141992 141992

Total imobilizări corporale

(rd.060 + rd.070 + rd.080 + rd.090 + rd.100 +

rd.110 + rd.120)

130 3170290 4001983

III. Investiții financiare pe termen lung

1. Investiții financiare pe termen lung în părți
neafiliate

140

2. Investiții financiare pe termen lung în părți
afiliate, total

150

din care:

2.1. acțiuni și cote de participație deținute în părțile
afiliate

151

2.2 împrumuturi acordate părților afiliate 152

2.3 împrumuturi acordate aferente intereselor de

participare
153

2.4 alte investiții financiare 154

Total investiții financiare pe termen lung

(rd.140 + rd.150)
160

IV. Creanțe pe termen lung și alte active

imobilizate

1. Creanțe comerciale pe termen lung 170

2. Creanțe ale părților afiliate pe termen lung 180

inclusiv: creanțe aferente intereselor de participare 181

3. Alte creanțe pe termen lung 190

4. Cheltuieli anticipate pe termen lung 200



5. Alte active imobilizate 210

Total creanțe pe termen lung și alte active

imobilizate

(rd.170 + rd.180 + rd.190 + rd.200 + rd.210)

220

TOTAL ACTIVE IMOBILIZATE

(rd.050 + rd.130 + rd.160 + rd.220)
230 3170290 4001983

B. ACTIVE CIRCULANTE

I. Stocuri

1. Materiale și obiecte de mică valoare și scurtă

durată
240 31649 63405

2. Active biologice circulante 250

3. Producția în curs de execuție 260

4. Produse și mărfuri 270 852838 765931

5. Avansuri acordate pentru stocuri 280

Total stocuri

(rd.240 + rd.250 + rd.260 + rd.270 + rd.280)
290 884487 829336

II. Creanțe curente și alte active circulante

1. Creanțe comerciale curente 300 3969789 2559140

2. Creanțe ale părților afiliate curente 310

inclusiv: creanțe aferente intereselor de participare 311

3. Creanțe ale bugetului 320 982652 991266

4. Creanțele ale personalului 330 856 300

5. Alte creanțe curente 340 1093188 1838152

6. Cheltuieli anticipate curente 350 48056 10942

7. Alte active circulante 360 27708

Total creanțe curente și alte active circulante

(rd.300 + rd.310 + rd.320 + rd.330 + rd.340 +

rd.350 + rd.360)

370 6094541 5427508

III. Investiții financiare curente

1. Investiții financiare curente în părți neafiliate 380

2. Investiții financiare curente în părți afiliate, total 390

din care:

2.1. acțiuni și cote de participație deținute în părțile
afiliate

391

2.2. împrumuturi acordate părților afiliate 392

2.3. împrumuturi acordate aferente intereselor de

participare
393

2.4. alte investiții financiare în părți afiliate 394

Total investiții financiare curente

(rd.380 + rd.390)
400

IV. Numerar și documente bănești 410 4161583 3229017

TOTAL ACTIVE CIRCULANTE

(rd.290 + rd.370 + rd.400 + rd.410)
420 11140611 9485861

TOTAL ACTIVE 430 14310901 13487844



(rd.230 + rd.420)

P A S I V

C.

CAPITAL PROPRIU

I. Capital social și neînregistrat

1. Capital social 440 373026 373026

2. Capital nevărsat 450
(

)

(

)

3. Capital neînregistrat 460

4. Capital retras 470
(

)

(

)

5. Patrimoniul primit de la stat cu drept de

proprietate
480

Total capital social și neînregistrat

(rd.440 + rd.450 + rd.460 + rd.470 + rd.480)
490 373026 373026

II. Prime de capital 500

III. Rezerve

1. Capital de rezervă 510

2. Rezerve statutare 520

3. Alte rezerve 530

Total rezerve

(rd.510 + rd.520 + rd.530)
540

IV. Profit (pierdere)

1. Corecții ale rezultatelor anilor precedenți 550 X -103

2. Profit nerepartizat (pierdere neacoperită) al

anilor precedenți 560 5402413 5402413

3. Profit net (pierdere netă) al perioadei de

gestiune
570 X 318340

4. Profit utilizat al perioadei de gestiune 580 X
(

)

Total profit (pierdere)

(rd.550 + rd.560 + rd.570 + rd.580)
590 5402413 5720650

V. Rezerve din reevaluare 600

VI. Alte elemente de capital propriu 610

TOTAL CAPITAL PROPRIU

(rd.490 + rd.500 + rd.540 + rd.590 + rd.600 +

rd.610)

620 5775439 6093676

D. DATORII PE TERMEN LUNG

1. Credite bancare pe termen lung 630

2. Împrumuturi pe termen lung 640 1579325 1307469

din care:

2.1. împrumuturi din emisiunea de obligațiuni

641

inclusiv: împrumuturi din emisiunea de obligațiuni

convertibile
642

2.2. alte împrumuturi pe termen lung 643 1579325 1307469

3. Datorii comerciale pe termen lung 650 299803



SITUAŢIA DE PROFIT ŞI PIERDERE
de la 01.01.2023 pînă la 31.12.2023

Anexa 2

4. Datorii față de părțile afiliate pe termen lung 660

inclusiv: datorii aferente intereselor de participare 661

5. Avansuri primite pe termen lung 670

6. Venituri anticipate pe termen lung 680

7. Alte datorii pe termen lung 690

TOTAL DATORII PE TERMEN LUNG

(rd.630 + rd.640 + rd.650 + rd.660 + rd.670 +

rd.680 + rd.690)

700 1579325 1607272

E.

DATORII CURENTE

1. Credite bancare pe termen scurt 710

2. Împrumuturi pe termen scurt, total 720 1344767 951672

din care:

2.1. împrumuturi din emisiunea de obligațiuni

721

inclusiv: împrumuturi din emisiunea de obligațiuni

convertibile
722

2.2. alte împrumuturi pe termen scurt 723 1344767 951672

3. Datorii comerciale curente 730 2165195 100772

4. Datorii față de părțile afiliate curente 740 3446175 4692920

inclusiv: datorii aferente intereselor de participare 741

5. Avansuri primite curente 750

6. Datorii față de personal 760

7. Datorii privind asigurările sociale și medicale 770 28990

8. Datorii față de buget 780 12542

9. Datorii față de proprietari 790

10. Venituri anticipate curente 800

11. Alte datorii curente 810

TOTAL DATORII CURENTE

(rd.710 + rd.720 + rd.730 + rd.740 + rd.750 +

rd.760 + rd.770 + rd.780 + rd.790 + rd.800 +

rd.810)

820 6956137 5786896

F.

PROVIZIOANE

1. Provizioane pentru beneficiile angajaților 830

2. Provizioane pentru garanții acordate

cumpărătorilor/clienților
840

3. Provizioane pentru impozite 850

4. Alte provizioane 860

TOTAL PROVIZIOANE

(rd.830 + rd.840 + rd.850 + rd.860)
870

TOTAL PASIVE

(rd.620 + rd.700 + rd.820 + rd.870)
880 14310901 13487844

Indicatori Cod rd. Perioada de gestiune



precedenta curenta

1 2 3 4

Venituri din vînzări, total 010 29021092 20271056

din care:

venituri din vînzarea produselor și mărfurilor

011 28497093 19719964

venituri din prestarea serviciilor și executarea

lucrărilor
012 126338 211868

venituri din contracte de construcție 013

venituri din contracte de leasing 014

venituri din contracte de microfinanţare 015

alte venituri din vînzări 016 397661 339224

Costul vînzărilor, total 020 20867803 15060163

din care:

valoarea contabilă a produselor și mărfurilor

vîndute

021 20867803 15060163

costul serviciilor prestate și lucrărilor executate

terților
022

costuri aferente contractelor de construcție 023

costuri aferente contractelor de leasing 024

costuri aferente contractelor de microfinanţare 025

alte costuri aferente vînzărilor 026

Profit brut (pierdere brută) (rd.010 - rd.020) 030 8153289 5210893

Alte venituri din activitatea operațională 040 135089 66300

Cheltuieli de distribuire 050 118118 146520

Cheltuieli administrative 060 4920088 4367490

Alte cheltuieli din activitatea operațională 070 1931079 570712

Rezultatul din activitatea operațională: profit

(pierdere) (rd.030 + rd.040 - rd.050 - rd.060 -

rd.070)

080 1319093 192471

Venituri financiare, total 090 786797 991278

din care:

venituri din interese de participare

091

inclusiv: veniturile obținute de la părțile afiliate 092

venituri din dobînzi 093

inclusiv: veniturile obținute de la părțile afiliate 094

venituri din alte investiții financiare pe termen lung 095

inclusiv: veniturile obținute de la părțile afiliate 096

venituri aferente ajustărilor de valoare privind

investițiile financiare pe termen lung și curente
097

venituri din ieșirea investițiilor financiare 098

venituri aferente diferențelor de curs valutar și de

sumă
099 786797 991278
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Cheltuieli financiare, total 100 904528 804089

din care:

cheltuieli privind dobînzile

101

inclusiv: cheltuielile aferente părților afiliate 102

cheltuieli aferente ajustărilor de valoare privind

investițiile financiare pe termen lung și curente
103

cheltuieli aferente ieșirii investițiilor financiare 104

cheltuieli aferente diferențelor de curs valutar și de

sumă
105 904528 804089

Rezultatul: profit (pierdere) financiar(ă)

(rd.090 - rd.100)
110 -117731 187189

Venituri cu active imobilizate și excepționale 120 5290 281416

Cheltuieli cu active imobilizate și excepționale 130 200390

Rezultatul din operațiuni cu active imobilizate

și excepționale: profit (pierdere) (rd.120 -

rd.130)

140 5290 81026

Rezultatul din alte activități: profit (pierdere)

(rd.110 + rd.140)
150 -112441 268215

Profit (pierdere) pînă la impozitare (rd.080 +

rd.150)
160 1206652 460686

Cheltuieli privind impozitul pe venit 170 380423 142346

Profit net (pierdere netă) al perioadei de

gestiune (rd.160 - rd.170)
180 826229 318340

Nr.

d/o
Indicatori Cod rd

Sold la

începutul

perioadei de

gestiune

Majorări Diminuări

Sold la sfîrşitul

perioadei de

gestiune

1 2 3 4 5 6 7

I.

Capital social și neînregistrat

1. Capital social 010 373026 373026

2. Capital nevărsat 020
(

)

(

)

(

)

(

)

3. Capital neînregistrat 030

4. Capital retras 040
(

)

(

)

(

)

(

)

5. Patrimoniul primit de la stat cu

drept de proprietate
050

Total capital social și
neînregistrat

(rd.010 + rd.020 + rd.030 + rd.040

+ rd.050)

060 373026 373026

II. Prime de capital 070

III. Rezerve

1. Capital de rezervă 080

2. Rezerve statutare 090



SITUAŢIA FLUXURILOR DE NUMERAR
de la 01.01.2023 pînă la 31.12.2023

Anexa 4

3. Alte rezerve 100

Total rezerve

(rd.080 + rd.090 + rd.100)
110

IV.

Profit (pierdere)

1. Corecții ale rezultatelor anilor

precedenți
120 X 103 -103

2. Profit nerepartizat (pierdere

neacoperită) al anilor precedenți 130 5402413 826229 826229 5402413

3. Profit net (pierdere netă) al

perioadei de gestiune
140 X 318340 318340

4. Profit utilizat al perioadei de

gestiune
150 X

(

)

(

)

(

)

Total profit (pierdere)

(rd.120 + rd.130 + rd.140 + rd.150)
160 5402413 1144569 826332 5720650

V. Rezerve din reevaluare 170

VI. Alte elemente de capital propriu 180

Total capital propriu

(rd.060 + rd.070 + rd.110 + rd.160

+ rd.170 + rd.180)

190 5775439 1144569 826332 6093676

Indicatori Cod rd

Perioada de gestiune

precedentă curentă

1 2 3 4

Fluxuri de numerar din activitatea

operațională

Încasări din vînzări 010 29053578 24793777

Plăți pentru stocuri și servicii procurate 020 20406745 19703580

Plăți către angajați și organe de asigurare socială și
medicală

030 2732087 1905611

Dobînzi plătite 040 19210

Plata impozitului pe venit 050 1868681 169911

Alte încasări 060 5290

Alte plăți 070 1588647 3499117

Fluxul net de numerar din activitatea

operațională

(rd.010 - rd.020 - rd.030 - rd.040 - rd.050 +

rd.060 - rd.070)

080 2462708 -503652

Fluxuri de numerar din activitatea de

investiții

Încasări din vînzarea activelor imobilizate 090

Plăți aferente intrărilor de active imobilizate 100

Dobînzi încasate 110

Dividende încasate 120

inclusiv: dividende încasate din străinătate 121
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Alte încasări (plăți) 130

Fluxul net de numerar din activitatea de

investiții
(rd.090 - rd.100 + rd.110 + rd.120 ± rd.130)

140

Fluxuri de numerar din activitatea financiară

Încasări sub formă de credite și împrumuturi 150 800000

Plăți aferente rambursării creditelor și
împrumuturilor

160 1457991 1375308

Dividende plătite 170

inclusiv: dividende plătite nerezidenților 171

Încasări din operațiuni de capital 180

Alte încasări (plăți) 190

Fluxul net de numerar din activitatea

financiară

(rd.150 - rd.160 - rd.170 + rd.180 ± rd.190)

200 -1457991 -575308

Fluxul net de numerar total

(± rd.080 ± rd.140 ± rd.200)
210 1004717 -1078960

Diferențe de curs valutar favorabile (nefavorabile) 220 73028 146394

Sold de numerar la începutul perioadei de

gestiune
230 3083838 4161583

Sold de numerar la sfîrşitul perioadei de

gestiune

(± rd.210 ± rd.220 + rd.230)

240 4161583 3229017
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To Whom It May Concern, 

Jiangsu Bioperfectus Technologies Co., Ltd. hereby declares that the STC-96A 
system will be delivered with an optical system featuring 6 channels plus HRM, 
detailed as follows: 

 Channel 1: FAM, SYBR-Verde (470nm-510nm)
 Channel 2: HEX, JOE, VIC, TET (530nm-565nm)
 Channel 3: ROX, Texas Red (585nm-620nm)
 Channel 4: CY5 (630nm-665nm)
 Channel 5: Quasar 705 (690nm-705nm)
 Channel 6: Atto 425 (420nm-470nm)

The STC-96A system is new, unused, and manufactured in 2025. It utilizes a 
photodiode for detection. Importantly, the STC-96A does not require calibration, as it 
is factory calibrated upon delivery. Additionally, the STC-96A system comes with a 
24-month warranty from Delivery Date.  

Jiangsu Bioperfectus Technologies Co., Ltd. 
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Capitolul 1 Măsuri de siguranță

înainte de a utiliza sistemul de PCR în timp real STC-96A PLUS, vă rugăm să citiți cu atenție măsurile de siguranță.

Dacă instrumentul este utilizat într-un mod nespecificat de producător, protecția oferită de echipament 
poate fi afectată.

1.1 Convenții utilizate în acest manual

Următoarele simboluri apar în textul acestui manual.

Simboluri Titlu Descrieri

Acest simbol este folosit pentru a indica faptul că nerespectarea instrucțiunilor sau 

procedurilor poate duce la vătămări fizice sau chiar deces sau poate cauza 

deteriorarea instrumentului.

AVERTIZARE

Suprafata fierbinte Acest simbol este folosit pentru a eticheta suprafețele instrumentelor potențial fierbinți.

Acest simbol este folosit pentru a indica faptul că trebuie luate anumite precauții 

atunci când lucrați cu materiale potențial infecțioase.
PERICOL BIO

Informații critice pentru succesul procedurii sau utilizării 

produsului.
NOTĂ IMPORTANTĂ

NOTĂ INFORMATIVĂ Informații suplimentare despre subiectul sau procedura curentă.

Următoarele simboluri apar pe instrument.

Simboluri Titlu Descrieri

Marcajul CE de pe plăcuța de tip instrument exprimă conformitatea cu 

cerințele directivelor relevante pentru acest instrument.
MARCA CE

AVERTIZARE Pe plăcuța de tipul instrumentului.

Suprafata fierbinte Pe marginea blocului.

PERICOL BIO Pe plăcuța de tipul instrumentului.

DIAGNOSTIC IN VITRO
DISPOZITIV MEDICAL

Pe plăcuța de tipul instrumentului.
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Simboluri Titlu Descrieri

Pe plăcuța instrumentului, indicând că dispozitivul electric și electronic este 

în conformitate cu Directiva 2002/96/CE. Dispozitivul, accesoriile și ambalajul 

trebuie aruncate corect la sfârșitul utilizării. Vă rugăm să urmați 

Ordonanțele sau Regulamentele locale pentru eliminare.

DEEE

1.2 Cerințe de manipulare

Sistemul PCR în timp real STC-96A PLUS trebuie utilizat numai de personal instruit și calificat.

► Instrumentul STC-96A PLUS este un instrument electromecanic. Există un pericol potențial de șoc electric 

sau rănire fizică dacă instrumentul nu este utilizat conform instrucțiunilor date în acest manual.

► Urmați toate instrucțiunile de siguranță imprimate pe sau atașate la instrumentul analitic.

► Utilizatorii pot înlocui siguranțele dacă urmează procedurile descrise în acest manual de utilizare. Orice 

altă modificare electrică nu este permisă și ar putea anula și nule garanțiile pentru Instrumentul STC-96A 

PLUS.

► Numai personalul de service autorizat are voie să efectueze service sau reparații necesare pentru instrumente.

► Nu deschideți capacul fierbinte în timpul funcționării.

► Instrumentul trebuie plasat într-o încăpere curată și bine ventilată. Gazele corozive și interferențele din câmpurile magnetice de mare 

intensitate pot dăuna instrumentului. Evitați lumina directă a soarelui și sursele de lumină de mare intensitate.

► Instrumentul este proiectat să funcționeze în siguranță în cadrul specificațiilor conform standardelor tehnice 

certificate CE la temperatura ambiantă a camerei între 10°C și 30°C, umiditate relativă mai mică de 85%.

► Purtați întotdeauna ochelari de protecție și mănuși atunci când aveți de-a face cu materiale toxice, caustice sau infecțioase.

► Deși lucrați cu acizi nucleici înalt purificați, pentru propria dvs. siguranță vă rugăm să tratați tot materialul biologic ca 

potențial infecțios. Manipularea și eliminarea acestor materiale trebuie efectuate în conformitate cu instrucțiunile locale de 

siguranță. Deversările trebuie dezinfectate imediat cu o soluție dezinfectantă adecvată pentru a evita răspândirea 

contaminării la personalul sau echipamentul de laborator.

► Instrumentul deteriorat trebuie livrat producătorului și reparat de producătorul acestuia. Înainte de 

livrare, suprafața instrumentului trebuie curățată și sterilizată cu dezinfectant.

► Blocul termic este fierbinte în timp ce instrumentul funcționează. Atingerea blocului metalic este strict interzisă 

pentru a preveni arsurile.

1.3 Siguranța electrică

► Instrumentul este proiectat în conformitate cu Clasa de protecție I (IEC).

► Pentru protecția împotriva șocurilor electrice, instrumentul STC-96A PLUS trebuie conectat direct la o sursă de 

alimentare aprobată, cum ar fi o priză cu trei fire cu împământare pentru linia de 230V (50Hz).

► Echipamentele conectate la interfețele analogice sau digitale trebuie să respecte standardele IEC respective (de ex. IEC 60950 

pentru echipamente de procesare a datelor).

► Înainte de a conecta cablurile de alimentare la instrument, asigurați-vă că tensiunea și frecvența sursei de alimentare CA este 

de 230V~, 50Hz. Întrerupătorul de alimentare trebuie să fie oprit înainte de conectarea cablurilor de alimentare.

► Pentru a evita deteriorarea accidentală, opriți alimentarea înainte de a conecta cablurile de alimentare sau de comunicare.

► Nu atingeți niciodată întrerupătoarele sau cablul de alimentare cu mâinile ude.

► Nu deconectați niciodată cablul de alimentare fără a opri instrumentul.
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► Nu curățați niciodată instrumentul fără a opri întrerupătorul instrumentului și a deconecta cablul de alimentare.

► Nu înlocuiți niciodată siguranța fără a opri instrumentul și fără a deconecta cablul de alimentare.

► Opriți întrerupătorul de alimentare al instrumentului atunci când nu este utilizat. Cablul de alimentare trebuie deconectat de la priza 

de alimentare înainte de a deschide carcasa în timpul reparației.

► Pentru a evita riscul de electrocutare, acest echipament trebuie conectat numai la o rețea de alimentare cu împământare de protecție.

1.4 Compatibilitate electromagnetică

► Acest instrument îndeplinește cerințele stabilite în GB\T18268 referitoare la transmisie și respingerea 

interferențelor.

► Nu utilizați acest instrument într-un loc apropiat de dispozitive cu radiații ridicate (de exemplu, surse de frecvență 

radio fără ecranare), altfel funcționarea acestui instrument poate fi interferată.

► Se recomandă evaluarea mediului electromagnetic înainte de a utiliza acest instrument.

► Producătorul este responsabil să furnizeze utilizatorilor informațiile EMC.

► Utilizatorii sunt responsabili să asigure un mediu EMC adecvat pentru a se asigura că acest instrument 

funcționează normal.
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Capitolul 2 Introducere
2.1 Domeniul de aplicare
Bazat pe reacția în lanț a polimerazei (PCR) și tehnologia de monitorizare a fluorescenței în timp real, sistemul STC-96A PLUS PCR în 

timp real este un produs de analiză automată, care este destinat să efectueze detecția calitativă sau cantitativă a probelor de acid 

nucleic (ADN/ARN) derivate din ser, plasmă, urină, mediu de cultură virală, probe nazale (faringiene) sau tampoane vaginale sau agenți 

patogeni, precum și analiza post-PCR a acidului nucleic amplificat prin analiza curbei de topire. Sistemul PCR în timp real STC-96A PLUS 

este destinat pentru: 1. Diagnosticul clinic in vitro; 2. Utilizare generală în laborator. Sistemul PCR în timp real STC-96A PLUS este 

utilizat exclusiv în cadrul unui laborator, iar utilizatorii săi trebuie să fie instruiți în tehnologia PCR și operarea instrumentelor și să fie 

familiarizați cu operațiunile aferente.

2.2 Principiul de bază
Reacția în lanț a polimerazei (PCR) este utilizată pentru a amplifica o singură copie sau câteva copii ale unei bucăți de ADN pe 

mai multe ordine de mărime, generând mii până la milioane de copii ale unei anumite secvențe de ADN. Metoda se bazează 

pe ciclul termic, constând din cicluri de încălzire și răcire repetate a reacției pentru topirea ADN-ului și replicarea enzimatică a 

ADN-ului. Primerii care conțin secvențe complementare regiunii țintă permit amplificarea selectivă. De obicei, PCR constă 

dintr-o serie de cicluri de temperatură și fiecare ciclu se împarte în trei etape: denaturare, recoacere și extindere.

PCR în timp real, care se bazează pe reacția în lanț a polimerazei, este utilizată pentru a amplifica și a cuantifica simultan ADN-ul vizat. 

Sondele oligonucleotidice fluorogene sau coloranții de legare la ADN sunt utilizați ca reporteri pentru a monitoriza reacția PCR. 

Creșterea semnalului fluorescent este proporțională cu cantitatea de amplicon care este amplificat. Cuantificarea în termeni de unități 

genomice poate fi calculată prin comparație cu curba standard. PCR în timp real este mai specifică și mai sensibilă decât PCR 

tradițională.

2.3 Funcția principală
Instrumentul poate efectua amplificarea PCR și monitorizarea fluorescenței în timp real a fiecărui tub simultan. După 

amplificare, software-ul de operare STC-96A PLUS va analiza datele de amplificare; efectuați analize calitative/cantitative sau 

analize curbei de topire și afișați și imprimați automat rezultatele pentru fiecare probă, de exemplu, concentrația inițială.

2.4 Componentele principale
Instrumentul constă din următoarele componente: sistemul de control, unitățile de alimentare, unitatea de termociclu, unitatea de 

detectare, carcasa instrumentului și software-ul (versiunea: 1.0.0).
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2.5 Structura principală

2.6 Aplicații
► Detectarea agenților patogeni clinici

► Cercetare științifică de bază

► Screening genetic

► Controlul igienei alimentelor

► Inspecție de carantină la import și export la vamă

► Sănătate publică și epidemiologie

► Detectarea agenților patogeni animale și vegetale

2.7 Panoul instrumentului STC-96A PLUS

Indicator luminos

● ● ●
BLOC A PUTERE BLOC B

Vedere din spate a instrumentului STC-96A PLUS
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2.8 Aranjarea Pozițiilor Puțurilor

2.9 Specificațiile sistemului STC-96A PLUS
General

Dimensiuni (L×A×A)
Greutate

Alimentare electrică

Consum de energie

Nivel de zgomot

Clasa de protectie

Interfață externă cu emisii 

electromagnetice

386×520×250mm

18 Kg

230V~, 50Hz

< 850VA
< 55dB (A)
Ⅰ
CLASA B
USB sau RS-232

Parametrii de mediu Temperaturi permise în timpul 

funcționării Umiditate relativă permisă în timpul funcționării 

Temperaturi permise în timpul depozitării/transportului 

Umiditatea relativă permisă în timpul depozitării/transportului 

Altitudine deasupra nivelului mării

10 ~ 30℃

< 85%

- 20 ~ 55℃

< 85%

< 2000 de metri

Specificațiile de performanță ale sistemului STC-96A PLUS 

Numărul de mostre

Volumul probei

Interval de temperatură

Precizia temperaturii 

Uniformitatea temperaturii 

Max. Rata de rampă

Metoda de încălzire/răcire

Mod de control al temperaturii Capac 

fierbinte

Protecție la oprire
Programare avansată

Segmente în fiecare program 

Pași în fiecare segment Cicluri 

în fiecare segment

96 × 0,2 ml

15 ~ 50µL

4 ~ 99℃

± 0,10℃

± 0,10℃

4.0℃/s

Peltier și Joule
Controlul tubului/controlul blocurilor 

Capac fierbinte automat

Da
Da
Max. 9

Max. 9

Max. 99
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STC-96A PLUSSistem PCR în timp real

Timpul de păstrare al fiecărui pas 00:01 ~ 99:59 (mm: ss)

Specificațiile unității de detectare 

Colorant/sondă de detectat

Canalul nr. 1 2 3 4 5 6
Filtru de excitare 470 nm 530nm 585 nm 630 nm

Rezervat Rezervat
Filtru de emisii 510 nm 565 nm 620 nm 665 nm

Configurație maximă √ √ √ √ √ √

Actual
Configurare

√ √ √ √ × ×

Fluorofori FAM
SYBR-verde

HEX
JOE
VIC
TET

ROX
Texas-Roșu

Cy5 × ×

Sursă de lumină

Sensibilitate între canale

Gama de liniaritate

Gama de liniaritate

Reproductibilitatea

LED fără întreținere
< 1,00%

≥ un exemplar

100~ 1010copii/mL | r 

| ≥ 0,9990

CV< 1,00%

Durata de viață a produsului

Durata de viață

Data producției

7 ani
Imprimat pe cartea de vizită

Durata de viață a produsului este determinată pe baza evaluării duratei de viață a componentelor sale critice. Utilizatorii 

trebuie să îl opereze, să îl întrețină și să îl repare așa cum este indicat în manualul operatorului. După întreținere și reparare, 

produsele care sunt verificate pentru a păstra siguranța și performanța așteptate sunt

permis să fie utilizat în mod normal.
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Capitolul 3 Instalarea instrumentului

3.1 Transport și depozitare
Instrumentul trebuie transportat în conformitate cu cerințele de transport din contractul de comandă. Ambalajul original 

trebuie utilizat în timpul transportului pentru a preveni deteriorarea instrumentului.

În timpul transportului/depozitării/ambalării, instrumentul trebuie depozitat într-un mediu în care temperatura este de 

-20°C.℃〜55℃cu umiditate relativă sub 85% și fără gaz corosiv.

3.2 Despachetarea
Instrumentul de PCR în timp real STC-96A PLUS este ambalat într-o cutie de carton cu polistiren paletizat umplut spațiul dintre 

instrument și cutie de carton. După despachetare vă rugăm să verificați dacă componentele menționate în capitolul 3.3 lipsesc sau 

sunt deteriorate.

o NU utilizați instrumentul și contactați imediat distribuitorul dacă se constată deteriorări după despachetare.

3.3 Lista de ambalare
Articol

STC-96A PLUS Cablu de alimentare al 

instrumentului principal

Cablu de comunicație

Cablu convertor USB-TO-RS232 

Configurare sofeware

Manual de utilizare

Lista de ambalare

Certificare
Siguranță (Ф5×20mm, 10A, 250V) 

Perie de suflare

Capac rezistent la praf

Vă rugăm să contactați distribuitorul autorizat Bioperfectus sau să ne contactați la timp prin support@bioperfectus.com dacă vreun articol este 

deteriorat sau lipsește.

Cantitate

1
1
1
1
1
1
1
1
2
1
1

3.4 Cerințe de instalare
3.4.1 Mediul de lucru

► Instrumentul trebuie așezat pe un banc de lucru orizontal stabil, departe de radiatoare sau dispozitive de încălzire. Evitați lumina directă a 

soarelui.

► Nu așezați instrumentul STC-96A PLUS lângă dispozitive cu interferențe electromagnetice sau inductanță ridicată (de 

exemplu, frigider, centrifuge sau oscilatoare).

► Păstrați instrumentul STC-96A PLUS la cel puțin 15 cm distanță de obiectele sau pereții din jur pentru a asigura ventilație 

și acces convenabil la comutatorul de alimentare.

Instrumentul NU trebuie acoperit cu nimic în timpul funcționării.

► Păstrați instrumentul în interior, la temperatura camerei între 10-30℃,umiditate relativă sub 85%.
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► Pentru a evita șocurile electrice, instrumentul trebuie conectat la o priză cu trei fire cu împământare, care respectă standardele 

de siguranță. Sursa de alimentare trebuie să fie de 230 V AC (50 Hz).

Utilizatorii sistemului STC-96A PLUS trebuie să fie instruiți de către personal tehnic profesionist de către 
producător sau distribuitor înainte de a instala sau utiliza sistemul STC-96A PLUS.

3.4.2 Cerințe de sistem PC
Computerul trebuie să îndeplinească următoarele cerințe înainte ca software-ul STC1.0.0 să fie instalat:

► Cerințe hardware recomandate: CPU Intel sau AMD Duo Core 2.8GHz, cu 4G RAM; Memorie video 2G.

► Sistem de operare: Windows XP/Vista/7/8/8.1, cu Windows Office Word/Excel 2007 sau versiunea superioară instalată;

► Rezoluția ecranului: 1280*768 sau mai mare.

3.5 Instalare software
► Scoateți instrumentul din ambalaj și plasați instrumentul urmând instrucțiunile din3.4.1.

► Asigurați-vă că instrumentul este în stare de oprire, apoi conectați-l la priza de alimentare folosind cablul de alimentare din 

pachet.

► Introduceți cablul RS232 (capătul cu un inel magnetic) în portul COM1 al instrumentului și strângeți șuruburile. Conectați 

celălalt capăt al cablului RS232 urmând instrucțiunile de mai jos:

-
-

Dacă există un port COM în computer, introduceți direct cablul în acest port COM și strângeți șuruburile; Dacă 

nu există un port COM în computer, conectați cablul la portul COM al cablului convertorului USB-TO-RS232 și 

strângeți șuruburile.Rețineți că NU introduceți portul USB al convertorului în computer în acest moment!

► Introduceți CD-ul de instalare în CD-ROM. Vă rugăm să așteptați un moment, apoi următoarea fereastră va apărea 

automat (Fig 3-1).

Fig 3-1
► ClicInstalați STC 1.0.0și veți vedea asistentul de instalare al programului. Faceți clic pe „Următorul” (Fig 3-2).

Fig 3-2
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► Urmați instrucțiunile asistentului pentru a instala software-ul. Pașii specifici de instalare sunt (Fig 3-3):

O B

C D
Fig 3-3

► Dacă este necesar un cablu convertor USB-TO-RS232, faceți clic pe „Instalați driverul USB” din ecranul Autorun și 

urmați instrucțiunile asistentului de instalare (Fig 3-4).Nu conectați cablul USB la computer înainte de a instala 

driverul convertorului USB.Conectați cablul USB la computer când primiți următorul indiciu (Fig 3-4 B).

O

B

C
Fig 3-4

► Scoateți CD-ul de instalare și porniți instrumentul. Efectuați verificarea sistemului înainte de a începe să utilizați instrumentul.

12
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3.6 Verificarea sistemului
Vă rugăm să parcurgeți următorii pași pentru a verifica dacă programul este instalat cu succes.

► Porniți alimentarea instrumentului;

► Deschideți cursorul blocului A și puneți patru tuburi PCR goale de 0,2 ml în godeurile A1, A6, H1 și H6. Închide glisorul; Deschideți 

glisorul albastru al blocului B și puneți patru tuburi PCR goale în godeurile A7, A12, H7 și H12. Închide glisorul;

► Deschideți interfața STC1.0.0. Faceți clic pe fișierul șablon„Verifica"în zona din stânga sus a ecranului de pornire al experimentului;

► SelectaFugifilă și faceți clicÎnceputbutonul din partea dreaptă sus a ecranului pentru a începe experimentul.

Odată ce programul a început, vă rugăm să observați cu atenție procesul experimental și să verificați următoarele puncte:

► Capacul fierbinte poate fi închis cu succes.

► Temperatura blocului crește sau scade cu succes. Verificați dacă temperatura în timp real afișată pe ecran 

este aceeași cu temperatura țintă;

► Detectarea fluorescenței poate fi efectuată și valoarea fluorescenței poate fi afișată în timp real pe ecran.

► Dacă experimentul de verificare se poate termina normal, înseamnă că sistemul este instalat cu succes

Dacă instrumentul NU poate porni sau apar erori în timpul funcționării, vă rugăm să opriți instrumentul și să 
contactați imediat producătorul sau distribuitorul!

3.7 Cerințe de reactivi
Dacă instrumentul este utilizat pentru diagnosticarea clinică in vitro a bolilor, pot fi utilizați numai reactivi cu licență de înregistrare a produsului, o 

licență de autorizare a produsului și un certificat de produs emis de Biroul național de supraveghere a medicamentelor. Nu utilizați reactivi după data 

de expirare deoarece este posibil ca acuratețea detectării să nu fie asigurată.

3.8 Controlul calității în sistemul STC-96A PLUS
Pentru a asigura acuratețea detectării sistemului STC-96A PLUS, trebuie respectate următoarele puncte:
► În experimentul cantitativ, probele de control standard, negative și pozitive ar trebui să fie conținute pentru a monitoriza fiabilitatea 

experimentului și performanța instrumentului.

► Eșantioanele de control al calității de la autoritatea relevantă trebuie achiziționate în mod regulat pentru a verifica performanța reactivilor și 

a instrumentului.
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3.9 Flux de lucru

Eşantion Creați un experiment Creați proiect

Pregătiți specimenul Deschideți Instrumentul Deschideți Project Wizard

Pregătiți reactivii Deschideți Experiment Wizard Selectați tipul de proiect

Placă de încărcare Import

Șablon
Configurare instrument Definiți ținte

Definește Wells Definiți programul termic

Introduceți informații despre eșantion Parametrii de configurare

Începeți experimentul Creați reguli

Monitor Run Salvați&Închideți proiectul

Analizați datele

Imprimare rezultat
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Capitolul 4 Experiment

Programul STC 1.0.0 al Sistemului PCR în timp real STC-96A PLUS este compus din trei module funcționale: Experiment, Proiect și Instrumente. 

Acest capitol explică principalele funcții ale Experimentului. Experimentul este compus din ecranul de pornire și Expertul pentru experiment. 

Acasă oferă acces rapid la crearea și deschiderea experimentelor, în timp ce Expertul pentru experimente oferă utilizatorilor un ghid procedural 

pentru configurarea, rularea și analizarea experimentelor. Înainte de a începe operarea, vă rugăm să consultați capitolul pentru a vă familiariza 

cu software-ul. Conținutul acestui capitol este următorul:

► Experiment Home;

► Introducere în Experiment Wizard;

► Cum să creați și să rulați un experiment;

► Cum să vizualizați și să analizați un experiment;

► QuickStart Experiment din șablon;

► Imprimare/export de date.

4.1 Experimentează Acasă

Faceți dublu clic pe pictograma software-ului STC 1.0.0

Sistem PCR în timp real 1.0.0> STC 1.0.0pentru a intra în ecranul de start al STC 1.0.0. Ecranul de start al programului STC 1.0.0 este compus din 

trei file: Experiment, Proiect și Instrumente. Faceți clic pe „Experiment” în ecranul de pornire al experimentului (Fig 4-1).

pe desktop pentru a deschide software-ul sau faceți clic„Start”> Programe> STC

Rulați experimente Fila Modul Pornire rapidă

Analizați experimentul Experimente recente Bara de activități

Fig 4-1

Experiment Home oferă mai multe comenzi rapide pentru crearea sau analizarea experimentelor, după cum este descris mai jos:

► Expertul experimentului:Creați un nou experiment urmând Expertul pentru experimente.

► Ultimul experiment:Creați un nou experiment cu setări și placă din cel mai recent experiment.

► Importați aspectul plăcii:Rulați un experiment importând un fișier de configurare a experimentului în format csv.

► Experiență deschisă:Deschideți un fișier de experiment pentru analiză.
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► Pornire rapidă din șablon:Faceți clic pe un buton șablon pentru a începe imediat un experiment.

► Deschideți experimente recente:Lista arată experimentele care au fost deschise sau rulate recent. Faceți clic pe un nume de fișier pentru a-l 

deschide.

Faceți clic dreapta pe un experiment pentru a deschide folderul fișierului specificat sau ștergeți fișierul din listă sau ștergeți lista 
curentă.

► Bara de activități:Afișați experimentele deschise sau în curs de desfășurare și Pagina principală a experimentului. Utilizatorii pot deschide până la 10 

fișiere (inclusiv fișierele care rulează în prezent) în același timp. Faceți clic pe fila cu numele experimentului pentru a-l deschide. Clic pictograma

pentru a închide fișierul curent; Clic pictograma pentru a comuta la Experiment Home, care este întotdeauna afișată în

stânga jos a barei de activități

4.2 Introducere în Experiment Wizard
Această secțiune descrie interfața Experiment Wizard și procesul său de lucru, precum și funcțiile de bază ale Well Selector și Well 

Information Table, care sunt elemente cheie ale Experiment Wizard. Înainte de a crea un experiment, utilizatorii ar trebui să citească cu 

atenție această secțiune pentru a afla operațiunile de bază.

4.2.1 Prezentare generală a Expertului Experiment

Interfața luiExperimentează Acasăoferă mai multe comenzi rapide către Experiment Wizard - utilizatorii pot accesa Experiment 

Wizard fie făcând clic pe „Expertul de experimentebutonul ” sau butonul “Deschideți experimentul” și alegeți un fișier. Într-un mod 

orientat spre proces, Expertul pentru experimente ghidează utilizatorii prin setările, rularea și analizele experimentului. În interfața sa 

(Fig 4-2), puteți găsi filele procesului de experiment în partea stângă, cu comenzile de meniu disponibile pentru procesul curent în 

partea de sus. Funcționalitățile disponibile procesului curent pot fi găsite în mijlocul ecranului. Meniurile și zonele funcționale variază 

în funcție de aplicațiile experimentale diferite. Mai jos este fila de analiză experimentală pentru experimentul cantitativ absolut.

Faceți clic pe

meniul va fi de asemenea ascuns.

pictograma din dreapta barei de meniu pentru a ascunde textul meniului. În timp ce textul meniului este ascuns, meniul drop-down

Fila Modul Bara de meniu

Fila Procesul experimentului Zona Funcțională
Fig 4-2

Bara de activități

Tabelul de mai jos explică principalele funcții ale filelor din procesul de experiment.
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Procesul de experiment Conținut de lucru Referinţă

Pentru a afișa informații despre instrument; editați sau afișați informații de bază despre 

experimente și setările instrumentului.
Înființat 4.3.2

Editați și vizualizați informații despre puțuri de reacție, inclusiv importarea proiectelor 

și definirea proprietății puțului.
Placă 4.3.3

Eşantion Pentru a introduce informații despre eșantion, inclusiv descrieri ale pacientului. 4.3.4

Alergați (înainte/în timpul

funcţionare)
Începeți experimentul și monitorizați datele în timp real. 4.3.5

Aleargă (după alergare) Afișarea curbei de temperatură și a informațiilor de funcționare. 4.4

Analiză Afișarea și analizarea datelor experimentului. 4.4

4.2.2 Lucrul cu Well Selector
Well Selector (Fig. 4-3) este o placă de puțuri virtuală în partea de jos a ecranelor din fila Plată și Analiză. Este folosit pentru selectarea, 

editarea și afișarea mostrelor. Un tabel de 12*8 este afișat în Well Selector, locația fiecărei celule corespunzând fiecărui godeu din 

blocurile de reacție din instrumentul STC Real-TimePCR. Pentru STC-96A Plus, celulele de la coloana 1 la coloana 6 reprezintă blocul A 

în timp ce restul corespund blocului B. Godeul colorat din selectorul godeului indică faptul că există probe în godeu. Culorile diferite 

indică diferite tipuri de mostre, ale căror legende sunt afișate sub placa puțului.

Fig 4-3

4.2.2.1 Selectarea bine

► Faceți clic pe un puț pentru al selecta; apăsați peCtrltasta și faceți clic pe un godeu selectat pentru al deselecta. Puțul selectat este colorat cu 

gri pe fundal, în timp ce informațiile sale detaliate sunt afișate în tabelul cu informații despre puț și în curbele aferente. Vă rugăm să 

consultați 4.4 pentru mai multe informații.

► După ce ați selectat un puț, apăsați tastaSchimbaretasta și țineți apăsat în timp ce faceți clic pe un alt puț, apoi veți selecta 

continuumul dintre două puțuri.

► Apăsați tastaCtrltasta și țineți apăsat în timp ce faceți clic pe mai multe godeuri pentru a selecta câteva godeuri discrete.

► Faceți clic pe zona goală din partea stângă sus a selectorului de godeuri pentru a selecta toate godeurile.

► Apăsați tastele săgeți pentru a naviga prin puțuri.

4.2.2.2 Selectarea probei

► În experimentele cu un singur tub, fiecare probă corespunde unei eprubete; selectarea unei sonde este egală cu selectarea unei probe.

► În experimentele cu mai multe eprubete, fiecare probă corespunde la 2 sau mai multe eprubete. Puteți selecta un puț sau o probă după cum 

urmează:

-
-

Pentru a selecta o probă: Faceți clic pe o sondă, apoi veți selecta un set de sonde provenite dintr-o probă;

Pentru a selecta un godeu: Apăsați <Ctrl> de pe tastatură și mențineți apăsat în timp ce faceți clic pe un godeu pentru a selecta un singur godeu.

Dacă doriți să personalizați preferințele de selecție a puțurilor, vă rugăm să accesațiInstrument > Opțiune de selectare a 

puțurilor. Pentru mai multe informații despre experimentul cu un singur tub sau cu mai multe tuburi, consultați 5.2.

4.2.2.3 Funcțiile selectorului de puțuri

17



Versiunea 1.7

► Schimbați informațiile pentru a fi afișate pe placa de puț:În mod implicit, numele proiectului este afișat pe placa puțului. 

Utilizatorii pot schimba afișarea informațiilor pe placa puțului. Faceți clic dreapta pe Well Selector, selectați meniul de

Afișează bine, și puteți alege să afișați numele proiectului, numele pacientului (Fig 4-4), eticheta, numele tubului sau numele 

probei. Utilizatorii pot deschide și meniul dePreferințeși schimbațiAfișează bineînOpțiuni de selectare a puțurilor.

Fig 4-4

► Ascunde selectorul de bine:Faceți clic dreapta pe Tabelul de informații Well și deselectațiAfișați selectorul de bine.

► Salvare Well Selector ca imagine:Faceți clic dreapta pe Well Selector și selectați comandaSalvați imaginea capentru a salva selectorul 

de puțuri ca imagine.

► Omiteți puțurile:Când există date anormale în probe, programul va marca automat godeurile anormale (cum ar fi 

standardele nu au putut fi amplificate) ca godeuri omise. Aceste godeuri omise sunt marcate cu alb

cruci , în timp ce datele lor nu sunt afișate în Well InformationTable și pe diagramele corespunzătoare. Dacă

doriți să omiteți puțurile manual, faceți clic dreapta pe selectorul puțurilor și selectați meniulOmite Wellspentru a eticheta curentul

puțuri selectate ca puțuri omise. DeselectațiOmite Wellspentru a elimina semnele.

► Modificați stilurile de urmărire pentru godeurile selectate:Selectați mai multe godeuri în selectorul de godeuri și marcați 

curbele godeurilor selectate. Pentru o descriere detaliată, consultați Stiluri de curbe la pagina 20.

4.2.3 Lucrul cu tabelul cu informații despre sonde

În ecranul Analiza experimentului, informațiile detaliate ale probelor selectate din Selectorul godeului sunt afișate în Tabelul cu informații 

despre godeu de mai sus (Fig. 4-5), inclusiv numărul godeului, numele țintei, rezultatele calculului și informațiile despre pacient. Utilizatorii pot 

face o selecție suplimentară de mostre în Tabelul cu informații despre sonde. Sondele selectate au un fundal gri, în timp ce curbele lor sunt 

afișate pe diagramele corespunzătoare.

Fig 4-5

4.2.3.1 Afișare și selecție
► Ascunderea/Afișarea coloanelor din tabel:Faceți clic peMasămeniu pentru a deschideSetări de câmpcaseta de dialog (Fig 4-6). Dacă 

doriți să afișați o coloană, bifați câmpul; pentru a ascunde o coloană, debifați acest câmp.
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Fig 4-6

► Modificați ordinea coloanelor din tabel:Dacă trebuie să ajustați locația unei coloane în tabelul cu informații 

despre puț, selectați-o în tabelul de mai sus și faceți clic pe butonul Mutare în sus sau în jos.

► Afișarea probelor cu mai multe tuburi:În mod implicit, probele cu mai multe tuburi sunt separate prin linii de împărțire între; 

dacă doriți să ascundeți linia de despărțire, mergeți la Preferințe din meniu și deselectați „Afișați exemple de linii de despărțire."

► Selectarea datelor:selecția implicită a datelor este selectarea mostrelor. Dacă doriți să schimbați modul de selectare a datelor, „

Modul de selectare a datelor” în comanda de clic dreapta (sau meniuPreferințe > Opțiuni tabel cu informații despre puț > Modul 

de selecție a datelor) oferă 4 moduri de selecție a datelor:

-
-
-

în

Țintă: faceți clic pe o celulă pentru a selecta rândul care conține celula. În acest fel, puteți selecta o singură țintă; Ei bine: Faceți clic 

pe o celulă pentru a-i selecta godeul corespunzător;

Sample: Faceți clic pe o celulă pentru a selecta eșantionul corespunzător; dacă proba este dintr-un singur tub, se selectează un 

singur godeu; dacă proba este multitub, atunci sunt selectate mai multe godeuri dintr-un set de probe.

Celulă: Faceți clic pentru a selecta o celulă.-

4.2.3.2 Filtrare și sortare
► Sortarea mostrelor:În mod implicit, mostrele din tabel sunt sortate într-un mod de sus în jos în Well Selector 

(vertical, A1,B1,...,G1,H1). De asemenea, puteți face clic pe

următoarele moduri:

-
-

pictograma de pe antetul coloanei puțului pentru a sorta datele

Orizontală: Probele sunt aranjate de la stânga la dreapta, adică A1,A2,A3 ... ;

Prioritate orizontală și bloc A (numai pentru STC-96A Plus/STC-96A): eșantioanele sunt aranjate de la stânga la 

dreapta, începând de la blocul A la blocul B, adică A1,….,A6, B1, …H6, A7 , A8...H12;

► Sortarea coloanelor:Faceți clic pe pictograma de pe antetul coloanei (cu excepția coloanei Well) și selectați

Ascendent(Fig 4- 7), apoi datele sunt sortate în ordine crescătoare iar pictograma de sortare apare pe antetul coloanei; 

ClicDescendentpentru a afișa datele în ordine descrescătoare; dacă doriți să anulați sortarea, faceți clic pe

clic dreapta pe comandaȘtergeți Sortarea.

Fig 4- 7

► Filtrare:Faceți clic pe

lista (Fig 4-8). Faceți clic peFiltrare personalizatăpentru a efectua filtrarea avansată pe această coloană (Fig 4-8).

pictograma de pe antetul unei coloane, puteți filtra datele selectând datele din date
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Fig 4-8

► Sortare multiplă:Faceți clic dreapta în zona Tabelului cu informații despre sonde, selectațiSortare multiplă...comandă și 

apare următoarea casetă de dialog (Fig 4-9). Puteți efectua mai multe tipuri de date pe acest ecran. De exemplu, dacă 

doriți să sortați valorile Ct ale diferitelor ținte din diferite proiecte în ordine crescătoare, selectați „Proiect”, „Target” și „Ct” 

în „Sort By”, „Then By” și, respectiv, „Then By” .

Fig 4-9

► Ștergeți sortarea și filtrarea:Utilizați comanda clic dreaptaȘtergeți Sortarea și filtrareapentru a șterge toate criteriile de sortare și 

filtrare.

4.2.3.3 Imprimarea sau exportul datelor rezultate

Făcând clic dreapta în zona Tabelului cu informații despre sonde (Fig 4-10), puteți utiliza următoarele comenzi pentru a obține comoditate în 

procesarea datelor:

► Copiați datele selectate în clipboard:Copiați datele selectate în Clipboard.

► Exportați datele selectate:Exportați datele selectate în Excel.

► Tipăriți datele selectate:Imprimați datele selectate.

Dacă doriți să copiați sau să exportați anumite date ale tabelului, selectați meniul cu clic dreaptaModul de selectare a datelor>celulă, 
atunci sunteți liber să selectați orice date și să le exportați sau să le copiați în Clipboard.

Fig 4- 10

4.2.4 Lucrul cu Chart
Diagramele curbe sunt afișate în partea dreaptă aAnalizăfila din Expertul experiment; acestea pot varia în funcție de diferitele moduri de 

analiză. Următoarele sunt principalele caracteristici ale diagramelor curbe; pentru mai multe informații, vă rugăm să consultațiCapitolul 7 

Aplicația software.
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4.2.4.1 Vizualizarea diagramelor curbe

Plasați mouse-ul peste o curbă; apoi va fi îngroșat cu negru și va apărea o casetă de mesaj care arată informațiile detaliate 

ale curbei; între timp, toate informațiile aferente din ecran vor fi evidențiate (Fig 4-11).

Pentru a închide caseta de mesaj, faceți clic pePreferințemeniu și apoi debifați „Afișați detalii când treceți cu mouse-ul 
peste curbe” înOpțiuni grafice.

Fig 4- 11

► Reglați valoarea maximă a axei Y:În mod implicit, maximul axei Y a unei diagrame curbe este fix, arătând valoarea 

maximă a tuturor datelor. Dacă doriți să modificați setarea implicită, accesațiPreferințemeniu >Opțiuni grafice> Scalarea 

axei Y se ajustează automat prin:

Opțiuni Descrieri

Valoarea maximă a axei Y este valoarea maximă a tuturor curbelor din selectorul 

de godeuri.
Toate curbele

Canale selectate Maximul Y variază în funcție de canalele selectate.

Proiecte selectate Maximul Y variază în funcție de proiectele selectate.

Fântâni alese Y maxim variază în funcție de godeurile selectate

► Mărire/Micșorare:SelectaZoomîn meniul de clic dreapta. În fereastra pop-up (Fig 4-12), introduceți valorile maxime și minime 

ale Axei X și Axei Y. ClicAplicațisi inchide fereastra. Dacă trebuie să restabiliți cântarul, faceți clic pe Implicitbutonul sau în 

meniul contextual cu clic dreapta, faceți clic pe „Setați Scala la implicit” comanda.

Fig 4- 12

► Măriți o porțiune dintr-o diagramă:Dacă doriți să vizualizați detaliile unei anumite zone dintr-o diagramă, plasați cursorul deasupra 

și în stânga zonei diagramei pe care doriți să o măriți; apoi faceți clic și trageți mouse-ul în jos și la dreapta (Fig 4-13); regiunea din 

dreptunghiul pe care l-ați tras va fi mărită automat. Pentru a restabili diagrama la dimensiunea inițială, faceți clic și trageți mouse-ul în 

sus și la stânga.
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Fig 4- 13

4.2.4.2 Schimbarea stilurilor curbei

Utilizatorii pot personaliza culorile curbelor și pot schimba stilurile curbelor adăugând etichete la curbe. Dacă trebuie să modificați stilul unei 

curbe, treceți cursorul peste curbă (când curba devine neagră și aldine); alege „Stiluri de urmărire” în meniul de clic dreapta. În următoarea 

casetă de dialog, modificați culoarea curbei sau adăugați etichete (Fig 4-14).

Fig 4- 14

Dacă doriți să modificați stilurile mai multor godeuri simultan, mai întâi selectați sondele care urmează să fie modificate în Selector de godeuri, 

apoi faceți clic dreapta în zona Selectorului de godeuri și selectați „Stil curba” pentru a deschide următorul ecran (Fig 4-15), puteți modifica 

stilurile de curbă pentru toate sondele selectate sau pentru o anumită țintă a sondei selectate.

Fig 4- 15

4.2.4.3 Copiere și export

► Salvați o imagine grafică:În meniul de clic dreapta, faceți clic pe „Salvați imaginea ca..." pentru a salva diagrama curentă ca imagine.

► Copiați o imagine grafică:În meniul de clic dreapta, faceți clic pe „Copiați în Clipboard" pentru a copia diagrama curentă în clipboard.

► Imprimare:În meniul de clic dreapta, faceți clic pe „Imprimare...” pentru a imprima imaginea grafică curentă.

► Exportați datele curbei: Selectați „Curba de export..." în meniul de clic dreapta pentru a exporta datele tuturor curbelor de pe diagramă în 

fișiere Excel.

► Copiați datele curbei selectate:Treceți cursorul peste o curbă; atunci curba este îngroșată în negru. În meniul de clic 

dreapta, faceți clic pe „Copiați datele selectate în Clipboard...” pentru a salva datele curbei în Clipboard.

4.3 Cum să creați și să rulați un experiment
Această secțiune descrie cum să utilizați software-ul STC1.0.0 pentru a crea și rula un experiment, precum și caracteristicile detaliate ale tuturor 

interfețelor. Pentru diferite experimente, opțiunile de meniu afișate pot varia. Pentru mai multe informații, vă rugăm să consultațiCapitolul 7 

Aplicația software.
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4.3.1 Creați un nou experiment
❶ Conectați cablul USB Converter sau cablul serial RS-232 la computer și porniți instrumentul.

Software-ul STC1.0.0 este capabil să controleze mai multe sisteme STC Real-TimePCR (inclusiv 
STC-96A, STC-96A PLUS și STC-48A) simultan.

Pentru mai multe informații despre cum să conectați instrumentul la computer, vă rugăm să consultați3.5 Instalare 
software.

❷ Faceți dublu clic pe pictograma software-ului pe desktop pentru a rula software-ul sau faceți clicStart > Programe > STC

Real-TimePCR System 1.0.0pentru a deschide software-ul. Faceți clic peExperimentdin partea de sus a ecranului pentru a intra în 

ecranul principalAcasă experimentală(Fig 4- 16).

Fig 4- 16

❸ Pentru a crea un nou experiment, faceți clicExpertul de experimentebutonul din stângaAcasă experimentalăecran:

► Dacă există un singur instrument conectat la computer, veți intra direct în expertul de experiment, unde 

modelul și numărul de serie al acestui instrument sunt afișate înInstrumentzona (Fig 4- 17).

STC-96A PLUS

Fig 4- 17

► Dacă există două sau mai multe instrumente conectate la computer, următoarea casetă de dialog (Fig 4-18) apare după ce 

ați făcut clic. Selectați un instrument de utilizat din listă, faceți clicConfirmabutonul pentru a intra în interfața expertului de 

experiment.
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STC-96A PLU S

STC-96A PLUS

STC-96A PLUS

STC-96A PLUS

Fig 4- 18

► Dacă nu este conectat niciun instrument la computerul dvs., după ce faceți clic apare următoarea casetă pop-up (Fig. 4-19). 

Puteți reconecta instrumentul sau puteți face clicModul virtualpentru a intra în modul virtual în care puteți configura un 

experiment în loc să îl rulați.

Fig 4- 19

Pentru mai multe informații despre crearea unui experiment, consultați4.2.1 Ecranul Experiment Wizard.

4.3.2 Definiți proprietățile experimentului

STC-96A PLUS

Fig 4- 20

❶ Faceți clic peÎnființatfila(Fig 4- 20) și introduceți informațiile generale înInformații despre experimentzonă:

► În domeniulNumele experimentului, introduceți numele experimentului. Lungimea numelui experimentului 

trebuie să fie cuprinsă între 1 și 50 de caractere. Numele implicit este momentul creării noului experiment (format: 

AAAA-LL-ZZ_HH-LL-SS).

► Selectați tipul de experiment înTip de experimentlista derulantă.

► (Opțional) Puteți modifica calea în care este salvat fișierul în „Salvați Calea” câmp; dacă nu modificați calea, 

fișierele sunt salvate implicit în folderul Experiment din directorul de instalare a software-ului.

► (Opțional) dacă este necesar, introduceți informații despre operator, auditor și note.

❷ În zona deSelectați Blocuri de reacție, selectați bolck(e) în funcție de cantitatea dvs. de probă. Pentru instrumentele 

STC-96A PLUS, există două blocuri de reacție independente, Blocul A și Blocul B.

24



STC-96A PLUSSistem PCR în timp real

❸ Selecta„Folosiți capacul fierbinte”în zona deModul cu capac fierbinte. Folosirea capacului fierbinte înseamnă că în timpul experimentului 

temperatura capacului fierbinte va fi menținută la 105℃,care împiedică evaporarea reactivilor.

Dacă nu se folosește capacul fierbinte, trebuie adăugat ulei de olefină pentru a preveni evaporarea și condensarea reactanților, ceea 

ce poate duce la rezultate eronate.

❹ Alegeți modul de control al temperaturii în„Modul de control al temperaturii”zonă. Implicit,Controlul blocuriloreste 

recomandat.

► Controlul blocurilorînseamnă că timpul de menținere al programului termic nu începe să se reducă până când 

temperatura din blocul de reacție atinge temperatura țintă.

► Controlul tubuluiînseamnă că timpul de menținere al programului termic PCR nu începe să se reducă până când 

temperatura medie a soluției dintr-un tub nu atinge temperatura țintă. Tube Control este mai precis decât Block 

Control, dar durează mai mult timp pentru a finaliza experimentul.

❺ ÎnModul de scanare a canalelorzona, selectați modul de scanare adecvat. Implicit,Scanați toate canaleleeste 

recomandat.

► Scanați canalele selectateînseamnă că sistemul optic scanează doar canalele care sunt utilizate în proiecte. De 

exemplu, dacă canalele FAM, VIC și HEX sunt utilizate într-un proiect, instrumentul scanează doar aceste trei 

canale.

► Scanați toate canaleleînseamnă că sistemul optic scanează toate canalele (în total 4 canale) în timpul 

experimentului.

Dacă selectați „Scanați canalele selectate” și doriți să adăugați un nou proiect în timpul experimentului, atunci 
când numărul de canale îl depășește pe cel al primului proiect, atunci datele noului canal adăugat nu sunt 
înregistrate. Prin urmare, „Scan All Channels” este recomandat dacă reactivul nu este sensibil la expunerea la 
fluorescență.

Pentru informații despre proiect și canal, vă rugăm să consultați5.2 Creare proiect.

4.3.3 Configurare bine

❶ ClicPlacăpentru a intra în ecranul pentru definirea corectă (Fig 4-21). Alegeți puțurile pentru a fi editate înSelector de bine. În cazul 

probelor cu mai multe tuburi, numărul de godeuri pe care trebuie să le selectați ar trebui să fie cel puțin mai mare decât numărul de 

godeuri ale unei probe.

sau mai multe informații despre funcționarea de bază a selectorului de puțuri, vă rugăm să consultați4.2.2 Lucrul cu Well elector.

Fig 4- 21

❷ Selectați un proiect adecvat din lista de proiecte din partea dreaptă sus a ecranului. Toate fișierele de proiect salvate anterior de 

utilizatori în software sunt afișate în lista de proiecte. Mutați cursorul la numele proiectului pentru o previzualizare a
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informatii despre programul termic al proiectului; click pe 

proiect.

pictograma numelui proiectului pentru a vedea detaliile pentru acesta

Dacă nu puteți găsi fișierul de proiect în lista de proiecte, trebuie să creați un fișier de proiect sau să contactați 
producătorul reactivului. Vă rugăm să consultați5.2 Creare proiect.

Puteți rula mai multe proiecte într-un singur experiment. După ce selectați un proiect din lista de proiecte, 
fișierele de proiect cu același program termic ca și în proiectul selectat sunt încă disponibile pentru a fi utilizate 
(Fig 4-22); în timp ce proiectele cu diferite programe termice sunt estompate (indisponibile).

Fig 4- 22

❸ Editați tipul eșantionului și proprietatea înPasul 3: Definiți bine(Fig 4- 23). În mod implicit, tipul sondelor selectate este 

Necunoscut. Dacă este necesar, modificați tipul făcând clic peTip eșantionmeniul derulant.

Fig 4- 23

Dacă este necesar, introduceți informații despre eșantioane înProprietatedomeniu. Puteți edita proprietățile pentru fiecare 

țintă separat în tabelul țintă.

► Dacă trebuie să definiți replici, selectațiSetați Replicatecaseta de selectare și introduceți un numărReplica ID 

domeniu. Software-ul va efectua analize statistice ale SD și CV ale acestor replici.

► Pentru a curăța puțurile, selectați-le și faceți clicŞtergebutonul sau utilizați comanda cu clic dreaptaȘterge Probă.

Tipurile de mostre și proprietățile pot varia în diferite moduri de experiment. Pentru mai multe informații, vă rugăm să consultați 
Capitolul 7: Aplicație software.

❹ Când terminați editarea puțurilor, informațiile detaliate despre puțuri sunt afișate în tabelul din stânga sus al ecranului.

Editarea bine se poate face înainte, în timpul sau după finalizarea unui experiment. Odată ce utilizatorii reeditează setările 
puțului, reanalizați experimentul pentru a genera un nou rezultat.

4.3.4 Introduceți informații despre eșantion

❶ ClicEşantionpentru a accesa ecranul pentru editarea probei (Fig 4-24). Acest ecran afișează toate mostrele „Necunoscute” și puteți 

introduce informații detaliate pentru fiecare eșantion. ClicImportmeniu pentru a importa informații despre pacient din fișierul CSV 

extern.
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Fig 4- 24

Faceți clic pe „Mod tabel”, mostrele „Necunoscute” sunt listate într-un tabel.

► Faceți clic pe o celulă și introduceți informații, apoi apăsați tasta Enter pentru a confirma și a trece la următoarea celulă sau pentru a 

afișa un meniu derulant; apăsați tasta Tab pentru a muta cursorul.

► Copiere/Lipire: Selectați o celulă, faceți clic dreapta și selectațiCopie; apoi selectați o altă celulă și faceți clic dreapta pentru a alege „Pastă.”

► Utilizați comanda clic dreaptaŞtergesauŞtergebutonul din bara de meniu pentru a șterge conținutul celulelor selectate.

Informațiile pacientului despre mostre pot fi editate înainte, în timpul sau după finalizarea unui experiment.

❷ Eticheta este folosită ca un marcaj unic pentru eșantion în legătură cu sistemul LIS. ClicEtichetabutonul de pe

bara de meniu, alegeți intervalul corespunzător din meniul derulant alInterval de probă,și introduceți valoarea 

corespunzătoare.

Interval de probă Descrieri

Toate mostrele Creați etichete pentru toate mostrele

Creați etichete pentru mostrele selectate (trebuie să selectați mostre specifice 
pe ecran în prealabil).

Mostre selectate

Numele proiectului Creați etichete pentru toate mostrele provenite din proiectul selectat.

De exemplu, marcați toate mostrele de „Shuiyuan” în ordinea „20150526-01; 20150526-02; 

20150526-03......".

Fig 4- 25

► Selectați „Shuiyuan” din lista derulantă aInterval de probă.

► Introduceți „20150526-” înPrefixul eticheteidomeniu.

► Introduceți „1” înValoarea inițialăcaseta, „1” înIntervalcaseta și „2” înCifrăcaseta (Fig 4- 25).

❸ Dacă coloana tabelului nu corespunde nevoilor dvs., puteți personaliza coloanele noi dupăMasămeniu (Fig 4-

26).
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Fig 4- 26

De exemplu, dacă doriți să adăugați o nouă coloană „Starea eșantionului”, lista derulantă ar trebui să afișeze „Normal” și 

„Icter”.

► Faceți clic peMasămeniu pentru a deschideSetări de câmpcaseta de dialog, apoi faceți clic pe „Câmp noubutonul „ din partea de 

jos a ecranului pentru a crea un nou câmp „Coloană”

► ÎnNume câmpîn dreapta, introduceți „Starea eșantionului”;

► În lista derulantă aTip câmp, selectați „Lista”;

► ClicConținut noubutonul și introduceți „Normal” în ecranul său pop-up (Fig 4-27). ClicConfirma. În mod similar, adăugați o 

altă valoare implicită a „icterului”.

► ÎnSelectați Câmpurilistă, selectați câmpul „Stare eșantion” pentru a-l adăuga la tabelul Sample.

Fig 4- 27

4.3.5 Rulați un experiment

Fig 4- 28

❶ ClicFugifila pentru a intra înFugiecran (Fig 4-28), pe care sunt afișate informații precum eșantioanele de testare și 

proiectele. Așezați tuburile de probă în blocul de reacție al instrumentului conform secvenței godeului

Selector. Faceți clic pe butonul pentru a rula experimentul.

Pentru experimentele create în modul virtual,Începutbutonul este dezactivat și experimentul nu poate fi 
pornit.
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❷ Funcționarea monitorizării: Curba de temperatură în timp real și starea de funcționare sunt afișate în partea dreaptă sus a 

ecranului Executare experiment (Fig 4-29), în timp ce curba în timp real este afișată în dreapta jos.

Fig 4- 29

În cazul erorilor care anulează experimentul (cum ar fi întreruperile de curent), atunci când programul este repornit, va apărea o 
casetă de dialog pentru a vă întreba dacă veți continua rularea de unde a anulat. Dacă alegeți să continuați, datele 
experimentale anulate vor fi reluate și continuate. Acest lucru poate duce la rezultate nesatisfăcătoare.

❸ Dacă trebuie să modificați programul termic în timpul, faceți clic dreapta în zona Program termic din partea dreaptă sus a 

ecranului. ClicAdăugați cicluri pentru segmentul curentpentru a crește numărul de cicluri ale segmentului curent; faceți clic pe „

Ștergeți segmentul curent" pentru a sări peste segmentul curent în următorul segment (Fig 4-30).

Fig 4- 30

❹ Când experimentul este terminat, modulul de reacție este răcit și capacul fierbinte este deschis automat. Software-ul 

va salva automat rezultatele și va redirecționa către fila Analiză.

Utilizatorilor li se permite să personalizeze timpul de așteptare pentru deschiderea capacului fierbinte. Faceți clic peInstrumentefila >

Opțiune software. Modificați timpul de așteptare înSetare capac fierbintealAlţiisecțiune.

4.4 Vizualizați și analizați un experiment
❶ ClicDeschideți Experimentebutonul dinExperimentează Acasăecran sau faceți clic peDeschidebutonul din bara de meniu din 

Experiment Wizard. În fereastra pop-up, alegeți un fișier de experiment și deschideți-l.

❷ Puteți comuta între filele Expertului pentru experiment pentru a vedea sau edita informațiile despre experiment:

► Înființat:Vizualizați numărul de serie și setările instrumentului; modificați numele fișierului sau calea de salvare.

► Placă:Pentru a vizualiza sau a reedita bine reacția.

► Eşantion:Pentru a vizualiza sau reedita informațiile despre pacient ale mostrelor.

► Run:Vizualizați informațiile de rulare, curba temperaturii și ora la care începe/se finalizează 

experimentul.

► Analiză:Vizualizați datele rezultatelor, modificați parametrii, exportați date și așa mai departe.

Pentru mai multe informații despre fila Opțiuni Expert Expert, consultați4.3Cum să creați și să rulați un 
experiment.

❸ ClicAnalizăpentru a intra în ecranul Analiză (Fig 4-31). În partea stângă a ecranului de analiză se află Tabelul cu 

informații despre sonde, Tabelul cu parametrii de analiză și Selectorul sondei; în dreapta sunt curbe de experiment care 

variază în funcție de diferitele tipuri de analiză.
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Fig 4- 31

Vizualizarea datelor experimentului

► Selectați o probă în selectorul de godeuri; apoi detaliile sale sunt afișate în Tabelul cu informații despre sonde în partea de sus, în timp 

ce curbele sondei sunt afișate în graficele curbelor din dreapta.

► Plasați mouse-ul peste datele de pe ecran; apoi toate informațiile asociate cu datele sunt afișate împreună (datele din Selectorul 

godeului sau din tabelul Informații despre sonde sunt afișate cu caractere aldine, în timp ce curba este afișată cu aldine negru) 

(Fig 4-32). Dacă trebuie să închideți această funcție, faceți clic pePreferințemeniu, iar înAlţiizona a ecranului pop-up, debifați

Evidențiați informațiile conexe pe Hover.

Fig 4- 32

► Pentru experimentele cu mai multe canale, faceți clic pe butoanele Canale 
canale;

pentru a arăta datele specifice

Dacă doriți să schimbați modul de selectare a canalului, faceți clicPreferințemeniu și schimbareSelectarea canaluluiîn zona deAlţii.„
Apăsați butonul Ctrl+Canal pentru a selecta mai multe canale”înseamnă că atunci când apăsați butonul de canal, selectați doar 
datele canalului curent; dacă doriți să selectați mai multe canale simultan, țineți apăsată tasta CTRL și faceți clic pe butoanele pentru mai 
multe canale; „Apăsați butonul Canal pentru a selecta/deselecta”înseamnă că apăsați butonul canal pentru a-l selecta și faceți din nou 
clic pentru a-l deselecta.

► Pentru a mări/micșora tabelul sau graficele, faceți clic şi butoane sau trageți marginile acestora;

Pentru mai multe informații despre funcțiile Tabelului cu informații despre sonde și ale Selectorului sondei, vă rugăm să consultați4.2.2 Selector 
de puțurişi4.2.3 Tabel cu informații despre sonde.

Ajustarea parametrilor de analiză

Instrumentul colectează date de fluorescență în timp real în timpul experimentului; când experimentul se termină, software-ul 

procesează automat datele brute în conformitate cu parametrii de analiză ai proiectului.

► Parametrii de analiză cei mai des utilizați ai experimentului curent sunt afișați în tabelul cu parametrii de analiză (Fig 4-33), care 

se află sub Tabelul cu informații despre eșantion. Puteți modifica aici parametrii de analiză și faceți clic pe

Analizabuton pentru a reanaliza datele.
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Fig 4- 33

► Faceți clic peParametrii de analizămemu în meniul derulant alAnalizăpentru a vizualiza toți parametrii de analiză. După modificarea 

parametrilor, faceți clicAnalizabutonul pentru a actualiza rezultatele.

Pentru a ascunde parametrii de analiză, faceți clic pe pictograma.

Pentru mai multe informații despre parametrii de analiză a diferitelor tipuri de proiecte, vă rugăm să consultațiCapitolul 7 Aplicația 
software.

4.5 Șablon de experiment
Un șablon de experiment este un fișier pre-stocat care conține toate informațiile despre setări, cum ar fi informații despre experiment, setarea sondei și 

parametrii de analiză. În partea dreaptă sus aExperimentează Acasăecranul este (Fig 4-34) lista de șabloane de experiment. Faceți clic pe un șablon 

pentru a introduceFugiecran; apoi apăsațiÎnceputbutonul pentru a începe experimentul.

Fig 4- 34

4.5.1 Manager de șabloane

În zona șablonului de experiment, faceți clic dreapta și apoi selectațiManager de șabloanepentru a intra în următorul ecran (Fig 4-35).

Fig 4- 35

► Import:Importați fișiere de șablon de experiment în software.

► Export:Salvați șablonul de experiment selectat într-un alt director.

► Redenumiți:Redenumiți fișierul șablon selectat.

► Şterge:Ștergeți fișierul șablon selectat.

► Afișare/Ascunde:bifați caseta de selectare din partea dreaptă jos a unui șablon pentru a-l face să apară pe ecranul de pornire al 

experimentului. Pentru a ascunde un șablon, faceți clic dreapta pe el și selectațiEliminați din listăComanda.

4.5.2 Creați un model de experiment

În ecranul Experiment Wizard, faceți clic peȘablonînExportmeniu pentru a deschide următorul ecran (Fig 4-36). Introduceți numele fișierului; dacă este 

necesar, introduceți numele complet și comentariile. PresaConfirma.

31



Versiunea 1.7

Fig 4- 36
4.6 Export
4.6.1 Exportați datele experimentului

ClicDateîn bara de meniu pentru a exporta datele acestui experiment (Fig 4-37). Datele pot fi salvate în formate XLSX, CSV sau TXT.

Fig 4- 37

Tabelul de mai jos afișează datele de exportat. Datele disponibile pot varia în funcție de diferitele tipuri de analize.

Export: Descrieri

Informații generale Numele și ora experimentului, Auditor/Operator/Comentarii, Configurarea instrumentului.

Tabel cu informații despre puț Toate informațiile din Tabelul de Informații Puț

Curba de amplificare Curba de amplificare a tuturor probelor

Curba brută de amplificare Curbele brute ale tuturor probelor

4.6.2 Export RDML
Faceți clic pe meniul drop-down alExportși selectațiExportați RDMLpentru a exporta fișierul RDML.

4.7 Imprimare

4.7.1 Imprimare raport pacient

Selectați eșantionul de imprimat din Well Selector și apoi faceți clic peRaportmeniu pentru a deschide următorul ecran (Fig 4-38). ClicImprimarepentru a 

tipări toate rapoartele; clicImprimare curentpentru a tipări raportul în previzualizare; clicAnterior/Următorulpentru a vizualiza rapoartele.

Puteți imprima numai rapoarte de pacient ale godeurilor cu tipurile de eșantion „necunoscut” sau „Retestat”.
Pentru a afla cum să personalizați șablonul de raport al pacientului, vă rugăm să consultațiAnexa I Șablon de raport al pacientului.
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Fig 4- 38

4.7.2 Print Experiment Tale
Faceți clic peMasămeniul înImprimaregrup de meniu pentru a tipări Tabelul cu informații despre sonde (Fig 4-39).

Fig 4- 39

Pentru a seta marginile, faceți clic pe meniuFișier>Configurare pagină(Fig 4- 40).

Fig 4- 40
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Capitolul 5 Proiect
Un proiect este un profil unic al sistemului STC Real-TimePCR, care conține tipul de experiment, informații despre 

canal, profilul PCR, parametrul de analiză, regulile de evaluare a rezultatelor etc. acces la experimente setate. 

Utilizatorii pot crea sau edita proiecte conform protocolului de experiment sau pot contacta producătorul reactivului 

pentru a achiziționa fișiere de proiect. Conținutul acestui capitol este următorul:

► Manager de proiect

► Crearea unui nou proiect

5.1 Manager de proiect

Faceți dublu clic pe pictograma software-ului STC1.0.0

1.0.0pentru a intra în software. Faceți clic peProiectdin bara de module pentru a intra înManager de proiect(Fig 5- 1). Proiectul

Manager este utilizat pentru a gestiona toate fișierele de proiect salvate în software, inclusiv vizualizarea, editarea, copierea sau importul/eportarea. Ecranul

deManager de proiectconține următoarele informații:

pe desktop sau faceți clicStart> Programe> STC Real-TimePCR System

Fila Modul Lista de proiecte

Butoanele de proiect Previzualizare proiect

Fig 5-1

► Butoanele de proiect din stânga managerului de proiect:

-
-
-

Crearea proiectului:Deschideți expertul de proiect pentru a crea un proiect nou. 

Import:Importați un fișier de proiect în managerul de proiect.

Export:Exportați fișierele de proiect din managerul de proiect în alt director. În ecranul Export (Fig 5-2), selectați proiectul(ele) de 

exportat și calea de salvare; și apoi faceți clicExportbutonul pentru a le exporta. ClicExportați toatepentru a exporta toate proiectele 

din listă.
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Fig 5-2

► În partea dreaptă sus a ecranului Project Mager, toate fișierele de proiect clasificate pe tipuri de experiment sunt listate aici. Faceți clic pe 

un proiect pentru o previzualizare a informațiilor detaliate în partea dreaptă jos a ecranului. Butoanele din dreapta sunt:

-
-
-
-
-

Edita:Editați fișierul proiect selectat. 

Copie:Copiați fișierul proiect selectat. 

Pastă:Lipiți proiectul copiat.

Redenumiți:Redenumiți proiectul selectat în ecranul pop-up. 

Şterge:Ștergeți fișierul proiect selectat.

5.2 Creare proiect
❶ ClicCreabutonul din stânga ecranului Manager de proiect pentru a deschide expertul de proiect (Fig 5-3).

Fig 5-3

În timp ce experimentul rulează, nu puteți edita proiectul utilizat de experiment.

❷ Faceți clic peGeneralfila din stânga și introduceți informațiile generale pentru proiectul dvs. pe ecran:

► Numele proiectului:Introduceți un nume de proiect. Lungimea șirului numelui variază de la 1 la 50.

► Tip proiect:Selectați tipul de proiect din lista verticală Tip proiect.
► Volumul de reacție:Introduceți volumul de reactiv. Volumul de reacție permis este de 15~50μL.

► (Opțional)Comentarii：Introduceți informații despre notă pentru proiectul dvs., dacă este necesar.
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❸ Introduceți informații despre țintă înInformații țintăzonă. O țintă este o secvență de acid nucleic pe care doriți să o 

amplificați și să o detectați. Este identificat cu o sondă marcată cu colorant specific de fluoență. Sondele/coloranții care 

sunt suportați de instrument sunt enumerate în tabelul următor.

Canal Lungime de undă de excitație-emisie Fluorofori

Canalul 1 470nm-510nm FAM, SYBR-Verde

Canalul 2 530nm-565nm HEX, JOE, VIC, TET

Canalul 3 585nm-620nm ROX, Texas-Roșu

Canalul 4 630nm-665nm CY5

În ceea ce privește cantitatea de ținte, probele pot fi împărțite în probe cu un singur tub și probe cu mai multe tuburi. 

Probele cu un singur tub se referă la acele probe, cu mai puține secvențe de acid nucleic de detectat (de exemplu, 1 sau 2 

ținte), care pot fi măsurate într-un sistem de reacție (o eprubetă PCR). În timpul dezvoltării tehnologiei PCR în timp real, 

experimentele din ce în ce mai complicate au mai mult de 10 gene țintă de detectat. Cu toate acestea, având în vedere 

limitarea spectrului de coloranți, există o limitare a canalelor de detecție în instrumentul PCR în timp real. În această 

situație, utilizatorii trebuie să pună o probă în mai multe tuburi și să le detecteze simultan, ceea ce se numește probe cu 

mai multe tuburi, de exemplu, cele 13 tipuri cu risc ridicat de papilomavirus uman (HPV).

Definiți obiectivele unei probe cu un singur tub

► În conformitate cu protocolul setului dvs., determinați canalele adecvate bifând caseta de selectare 

canale.

► Introduceți numele țintelor. Vă rugăm să rețineți că un nume țintă trebuie să fie exclusiv. Faceți clic pe caseta de culoare și selectați o culoare pentru 

această țintă.

► (Opțional) Dacă trebuie să modificați informațiile despre coloranți, faceți clic pe fișierele deFluorofori/Coloranți, apoi selectați 

numele coloranților din meniul derulant sau introduceți numele coloranților.

de mai jos

Definiți ținte pentru o probă cu mai multe tuburi

► Conform instrucțiunilor kit-ului, introduceți numărul tubului înTube Couts per Probă; apoi se adaugă noi 

tuburi „Tube 2”, „Tube 3”…. Schimbați numele tuburilor dacă este necesar;

► Configurați ordinea tubului verificând butoanele radio aleComanda tubului. Există două secvențe de aranjare 

a probelor cu mai multe tuburi;

-
-

► Verificați canalele de detectare corecte și introduceți numele țintelor. Dacă nu există nicio țintă care să fie detectată într-un 

canal al unui anumit tub, faceți clic pe câmpul său pentru a deschide meniul derulant și selectați„N / A".

Orizontal: Tuburile dintr-o probă sunt aranjate de la stânga la dreapta în selectorul de godeuri; 

Vertical: Tuburile dintr-o probă sunt aranjate de sus în jos în selectorul de godeuri;

Ar trebui să existe cel puțin o țintă pentru fiecare canal de detectare.

❹ Faceți clic peProgrampentru a merge la ecranul programului termic (Fig 5-4). Un program termic PCR conține de 

obicei 2 până la 3 segmente, fiecare conținând mai mulți pași și uneori cu o curbă de topire.
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Fig 5-4

Elementele de bază ale unui program termic sunt enumerate în tabelul următor.

Articol Descrieri Valori valide

Cicluri de temperatură compuse din 1 sau mai multe 

trepte.

1-9
Segment

De câte ori trebuie repetat segmentul 
curent.

1-99
Ciclu

Pas Conține temperatura țintă și timpul de păstrare. 1-99
Temperatura țintă, inclusiv temperatura de 

denaturare, temperatura de recoacere sau 

temperatura de extindere în amplificarea PCR.

4℃ -99℃
Ţintă

Temperatură

Timp de menținere, durata de timp în care 

temperatura este menținută atunci când temperatura 

din bloc sau tub atinge temperatura setată.

00:01 - 99:59

Timp de Reținere

Fluorescenţă

detectare

Un singur pas poate fi 

setat într-un segment
Detectați semnalul de fluorescență în pas.

Procesul de creștere a temperaturii încet de la o 

temperatură la alta. Pe parcursul întregului 

proces sunt detectate semnale de fluorescență.

1
Curba de topire

Segment

Editați un program termic

► Inserați segment:Faceți clic peInserați un segmentmeniu pentru a adăuga un segment la sfârșitul segmentului 

selectat curent (marcat cu roșu). În meniul derulant alInserați un segment, puteți alege să inserați noul segment înainte 

sau după segmentul selectat curent sau chiar la sfârșitul tuturor segmentelor. De asemenea, puteți insera segmente prin 

comanda de clic dreaptaInserați un segment.

Dacă trebuie să modificați numele unui segment, faceți dublu clic pe câmpul de nume și introduceți un nume nou.

► Modificare cicluri:Faceți clic pe caseta Ciclu

► Pasul de inserare:Selectați un pas dintr-un segment, apoi faceți clicIntroduceți pasulmeniu pentru a insera un nou pas 

după pasul selectat curent. În meniul derulant alIntroduceți pasul, puteți alege să inserați noul pas înainte sau după pasul 

selectat curent sau chiar la sfârșitul segmentului curent. De asemenea, puteți introduce pași prin comanda de clic dreapta

Introduceți pasul.

sub segment și introduceți numărul de cicluri.

Dacă trebuie să modificați un nume de pas, faceți dublu clic pe nume și editați-l.
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► Modificați temperatura țintă:Faceți clic pe linia albastră a casetei de 

temperatură de sub caseta de temperatură pentru a schimba temperatura.

și introduceți o temperatură sau trageți butonul

► Modificați timpul de reținere:Faceți clic pe caseta de timp și introduceți ora;

► Setați detectarea fluorescenței:Dacă aveți nevoie de un pas pentru detectarea fluorescenței, faceți clic pe casetă şi

apoi pictograma devine albastră , arătând că „achiziția” fluorescenței va fi efectuată la curent

pas. Un program termic comun este prezentat mai jos (Fig 5-5).

Într-un segment, doar un pas poate fi setat pentru „achiziția” fluorescenței. Un pas cu un timp de 
menținere mai mic de 15 secunde nu suportă achiziția fluorescenței.

Faceți clic dreapta pe programul termic; selectați „Salvare ca figură” pentru a salva programul curent ca imagine.

Fig 5-5

Program avansat
Funcția Advanced Program este utilizată pentru a seta TouchDown PCR sau pentru a controla viteza de încălzire și răcire a 

instrumentului. Selectați un pas și faceți clicProgramare avansatămeniu pentru a deschide următorul ecran (Fig 5-6).

Fig 5-6

► Setați TouchDown PCR:TouchDown PCR poate crește specificitatea de amplificare prin reducerea treptată a 

temperaturii de recoacere. Selectați TouchDown PCR Setarecaseta și introduceți numărul corespunzător de cicluri de 

pornire, precum și valorile variației temperaturii/timpului.

- Ciclu de pornire:Ciclul de pornire este utilizat pentru a determina în ce ciclu urmează să fie efectuat TouchDown. 

Ciclul de pornire nu trebuie să depășească numărul de cicluri ale segmentului curent. Variația timpului: De la

Ciclu de pornire, măriți sau micșorați timpul de reținere în fiecare ciclu. Variația temperaturii:De laCiclu de 

pornire, creșteți sau micșorați temperatura țintă în fiecare ciclu.

-
-
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Când configurați TouchDown PCR, asigurați-vă că temperaturile și valorile de timp trebuie să fie într-un interval 
rezonabil (temperatura variază de la 4 la 99℃,în timp ce timpul variază de la 00:01 la 99:59).

► Rata rampă:Înseamnă viteza cu care instrumentul se încălzește sau se răcește până la temperatura țintă. Selecta Rata de 

rampăcasetă și introduceți o valoare adecvată. Intervalul ratei rampei este de 0,1 ~ 4,0℃/doilea.

Exemplul demonstrează cum să editați un program termic, care este prezentat mai jos:

Segment Temperatură Timp Ciclu

50℃ 2 min 1
Segmentul 1

95℃ 10 min

95℃ 15s 10
65℃~56℃,scade cu 1℃

în timpul fiecărui ciclu.
Segmentul 2 15s

76℃ 20 de ani

95℃ 15s 40
Segmentul 3 55℃dobândirea fluorescenței 30 de ani

76℃ 20 de ani

► Faceți clic peProgramfila, segmentul implicit este prezentat după cum urmează (Fig 5-7); Faceți clic pe caseta Ora

Segmentul 1 - Pasul 2 și schimbați valoarea Time la „10:00”;

de

Fig 5- 7

► Faceți clic pentru a selecta Segmentul 1, care devine roșu; clicInserați un segmentmeniu și veți găsi că Segmentul 2 este adăugat 

după Segmentul 1. Faceți clic pe caseta Cycle din partea de jos și introduceți „10” (Fig 5-8 din stânga). Faceți clic pentru a selecta 

Segment 2-Step 1, apoi faceți clic pe Insert Step de două ori și veți găsi 2 noi pași (Fig 5-8 dreapta);

Fig 5-8
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► Faceți clic pe caseta Timp din Segmentul 2-Pasul 1 pentru a introduce „15”; faceți clic pe caseta Temperatură și caseta Timp din 

Segmentul 2-Pasul 2 și introduceți „65” și, respectiv, „00:15”; în mod similar, faceți clic pe Segment 2-Step 3 și introduceți

Valori de temperatură „76” și „00:20”;

► Faceți clic pe Segmentul 2-Pasul 2 și faceți clic pe meniuProgram avansat. VerificaSetare PCR TouchDown; intra

„1” înCiclu de pornirecasetă, selectați

butonul și ecranul este afișat după cum urmează (Fig 5-9).

în caseta Temperature Variation și introduceți „1”. PresaConfirma

Fig 5-9

► Selectați Segmentul 3 - Pasul 1 și faceți clicIntroduceți pasulmeniu. În pasul 2 nou adăugat, introduceți valoarea temperaturii „55” și 

valoarea timpului „00:30”. Faceți clic pentru a-și schimba culoarea în albastru. Valoarea temperaturii de intrare „76” și valoarea timpului 

„00:20” la Pasul 3. În cele din urmă, ecranul programului termic este afișat mai jos (Fig 5-10).

Fig 5-10

Aplicați Profilul termic

Puteți aplica programele termice ale altor experimente sau proiecte în următoarele două moduri:

► Faceți clic peImportmeniu pentru a importa programe termice ale altor proiecte (Fig 5-11).

Fig 5- 11

► Faceți clic dreapta pe zona programului termic din oricare dintre ecrane; apoi selectațiSetați la Programul termic implicitpentru a seta 

programul termic curent ca implicit.

❺ (Opțional) Faceți clic peParametrupentru a intra în ecranul de parametri unde sunt afișați toți parametrii de analiză. 

Parametrii pot varia în funcție de proiecte.
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► Parametrii impliciti furnizați în software sunt de obicei compatibili cu majoritatea kirurilor comerciale. De asemenea, 

puteți modifica parametrii în funcție de rezultatele testelor sau de protocolul truselor de reactivi.

► Dacă trebuie să copiați și să lipiți parametrii, faceți clic pe celula parametrilor și selectațiCopiemeniu; apoi selectați 

celulele de lipit și faceți clicPastămeniu. Funcțiile de copiere și inserare sunt disponibile și în meniul de clic dreapta.

► Dacă trebuie să restabiliți parametrii actuali la valorile implicite, faceți clic pe meniuReveniți la implicit.

Pentru mai multe informații despre parametrii de analiză a diferitelor tipuri de proiecte, vă rugăm să consultațiCapitolul 7 
Aplicația software.

Fig 5- 12

❻ (opțional) Dacă este necesar, faceți clicRegulăpentru a edita regulile de interpretare sau pentru a aplica un fișier extern cu reguli avansate. Regulile de 

interpretare sunt folosite pentru a analiza datele experimentale și apoi pentru a obține concluziile eșantionului. Vă rugăm să contactați furnizorul de 

reactivi pentru regulile de interpretare a rezultatelor. Introduceți comentariile în caseta „Interpretarea rezultatelor”.

Fig 5-13

❼ ClicSalvameniu și apoi faceți clicAproapemeniu pentru a închide proiectul.

Închideți fișierul de proiect după ce l-ați creat sau editat sau nu îl puteți aplica în experiment.
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Capitolul 6 Instrumente

Modulul Instrument al software-ului STC-96A PLUS Real-time PCR System este compus din trei funcții: Opțiunea software este utilizată pentru 

configurarea software-ului; Interogarea datelor este folosită pentru a interoga anumite date în mai multe rezultate; Informațiile de sistem sunt 

utilizate pentru a vizualiza informațiile LOG ale sistemului. Această versiune de software STC oferă doar funcția Opțiune software. Pentru mai 

multe informații despre alte funcții, vă rugăm să contactați producătorul.

6.1 Opțiune software
TheOpțiune softwarefuncția (Fig 6-1) din fila Instrument este utilă în modificarea afișajului interfeței și a modurilor implicite de operare. 

Puteți personaliza tabelul cu informații despre puțuri, selectorul puțurilor și modurile de funcționare și afișare ale curbelor după preferințele 

dvs. Funcția de opțiune software este valabilă pentru fișierele de experimente viitoare, dar nu este validă pentru fișierele aflate în derulare sau 

existente.

sau fișierele care rulează în prezent sau existente, puteți modifica opțiunile software făcând clic pe meniuPreferințeşi capabilîn 
Expertul de experiment (eficient numai pentru fișierul de experiment curent).

Fig 6-1

6.1.1
6.1.1.1 Opțiuni pentru tabelul cu informații despre sonde:

► Ordinea implicită a mostrelor:Pentru a afla despre cum să configurați ordinea probelor în Tabelul cu informații despre sonde, vă rugăm să 

consultați pagina 19.

-
-
-

Preferințe

Vertical:Eșantioanele din tabel sunt sortate într-un mod de sus în jos în Selector de godeuri (A1, B1... G1, H1). 

Orizontală:Probele sunt aranjate de la stânga la dreapta în Selectorul de godeuri, adică A1, A2... A11,A12; Prioritate 

orizontală și bloc A:Probele sunt aranjate de la stânga la dreapta, începând de la Blocul A la Blocul B, adică A1,….,A6, 

B1, …H6, A7, A8…H12;

► Modul de selectare a datelor:Pentru mai multe informații despre cum să configurați selecția datelor în Tabelul de informații despre eșantion, 

consultați pagina 19.

- Ţintă:Faceți clic pe o celulă pentru a selecta rândul care conține celula. În acest fel, puteți selecta infrmația unei ținte;

Bine:Faceți clic pe o celulă pentru a selecta godeul corespunzător;

Eşantion:Faceți clic pe o celulă pentru a selecta eșantionul corespunzător. Dacă proba este dintr-un singur tub, este selectat un 

singur godeu; dacă proba este multitub, atunci sunt selectate mai multe godeuri dintr-un set de probe.

Celula:Faceți clic pentru a selecta o celulă.

-
-

-
► Dimensiunea fontului tabelului:Setați dimensiunile fontului din Well Information Table.
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► Utilizarea marcajelor de linie pentru a delima mostre:Dacă probele curente sunt cu mai multe tuburi, acestea sunt separate prin semne de linii. Vă rugăm 

să consultați pagina 19.

► Afișați valorile concentrației în notație științifică:Dacă există valori ale concentrației, cum ar fi concentrația și 

concentrația medie în Tabelul cu informații despre sonde, acestea sunt afișate în notație științifică.

6.1.1.2 Opțiuni grafice
► Stilul curbei:personalizați grosimea curbelor în diagramele de curbe.

► Culoare curba:personalizați culoarea curbelor pentru fiecare canal în diagramele cu curbe (Fig 6-2).

Fig 6-2

► Scalarea axei Y se ajustează automat prin:Determinați cum este afișată axa Y în diagramele curbe atunci când selectați diferite puțuri. Vă rugăm să 

consultați pagina 21 pentru mai multe informații.

-
-
-
-

► Afișați detalii când treceți cu mouse-ul peste curbe:Treceți cursorul peste curbă pentru a afișa toate informațiile detaliate ale curbei (cum ar fi 

numărul puțului, canalul). Vă rugăm să consultați pagina 21.

► Algoritm de normalizare a curbei de amplificare:Puteți modifica algoritmul normalizat implicit al curbei 

de amplificare. După comutarea algoritmului, trebuie să ajustați valoarea pragului.

-

Toate curbele:Valoarea maximă a axei Y este valoarea maximă a tuturor curbelor din selectorul de godeuri. Canale 

selectate:Valoarea maximă a axei Y variază în funcție de canalele selectate. Proiect selectat:Valoarea maximă a axei 

Y variază în funcție de proiectele selectate. Bine selectat:Valoarea maximă a axei Y variază în funcție de godeurile 

selectate.

Algoritm de fluorescență relativă:Curba de amplificare normalizată este formată din fluorescența relativă a fiecărui 

ciclu. Fluorescența datelor brute împărțită la fluorescența liniei de bază este fluorescența relativă. Algoritmul implicit al 

sistemului STC este algoritmul de fluorescență relativă.

Algoritm de fluorescență absolută:Curba de amplificare normalizată este formată din fluorescența absolută a fiecărui 

ciclu. Fluorescența datelor brute scade fluorescența liniei de bază pentru a obține fluorescența absolută.

► Afișează bine selectat pe curba standard:Dacă Ct al unui eșantion selectat se încadrează în intervalul curbelor standard, 

această probă (concentrație și Ct) va fi afișată în diagrama cu curbe standard. Consultați pagina 51.

► Afișați linia de bază pe diagrama curbei de amplificare:Pentru a afla cum să afișați linia de prag pe curba de 

amplificare, consultați pagina 50.

-

6.1.1.3 Opțiuni de selectare a puțurilor

► Selectarea probei cu mai multe tuburi:Pentru a afla cum să configurați modul de selecție al probelor cu mai multe tuburi, consultați 

P17.

- Eşantion:În experimentele cu mai multe tuburi, atunci când se selectează un godeu în Well Selector, sunt selectate toate 

godeurile asociate cu acest godeu, adică o probă este unitatea minimă de selecție. Dacă bifați caseta de selectare aApăsați 

Ctrl+well pentru a selecta un singur godeu, vi se permite să selectați un singur wel făcând clic pe el și apăsând între timp 

tasta „CTRL”.
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-
► Afișare bine:Modificați informațiile implicite din selectorul de puțuri. Vă rugăm să mergeți la P18 pentru mai multe informații.

-
-

Bine:Faceți clic pe godeuri pentru a le selecta.

Numele proiectului:Afișează numele proiectului.

Nume:Afișează numele mostrelor de „Necunoscut” sau „Retest”; pentru alte tipuri de probe, proprietățile probelor 

sunt afișate în selectorul de godeuri.

Eticheta:Pentru mostrele „Necunoscute” și „Retestare”, sunt afișate etichetele mostrelor. Pentru alte mostre, sunt afișate 

valorile Proprietății.

Numele tubului: Afișați numele tubului al probelor în selectorul de godeuri.

-

-

6.1.1.4 Altele
► Selectarea canalului:Personalizați modul Selectare canal în funcție de preferințele dvs. Pentru mai multe informații, consultați 

pagina 30.

- Apăsați CTRL + butonul Canal pentru a selecta mai multe canale:Când apăsați butonul de canal, selectați 

doar datele canalului selectat; dacă doriți să selectați mai multe canale simultan, țineți apăsată tasta CTRL și 

faceți clic pe butoanele de canal.

Apăsați butonul Canal pentru a selecta/deselecta:Faceți clic pe butonul canal pentru a selecta canalul și faceți clic din nou pentru a 

anula selecția.

► Setări capac fierbinte:După experiment, instrumentul va deschide automat capacul. Această funcție este folosită pentru a seta timpul de 

așteptare înainte ca capacul să se deschidă automat. Vă rugăm să consultați pagina 29.

► Evidențiați informații legate de trecerea cu mouse-ul:Treceți cursorul pe o anumită valoare (placă de godeu, curbă sau tabel) și toate 

informațiile legate de acea valoare sunt evidențiate (datele sunt afișate cu caractere aldine, în timp ce curbele sunt cu caractere aldine și negru.).

Consultați P30 pentru mai multe informații.

► Utilizați tabelul de parametri:Pentru a seta dacă se afișează sau nu tabelul cu parametrii de analiză pe ecranul Analiză. Consultați pagina 31 

pentru mai multe informații.

► Export personalizat:Exportați datele experimentului pe baza unui fișier de configurare extern.

-

6.1.2

Opțiunea Coloană tabel (Fig 6-3) este utilizată pentru setarea tabelului cu informații despre sonde. Prin Table Column, puteți seta informațiile 

care urmează să fie afișate sau ascunse sub diferite tipuri de analize sau puteți defini noi coloane.

Opțiuni pentru coloana tabelului

Fig 6-3

► Setați coloanele de afișare implicite:Selectați Tip de analiză din lista derulantă aTip de experimentși verificați câmpurile corespunzătoare 

din lista de câmpuri. Pentru a muta un fișier, selectați-l și faceți clicDeplasați-vă în sussauMutați în josbuton. Pentru a reveni la implicit, faceți 

clicimplicitbutonul din partea de jos a ecranului. Vă rugăm să consultați pagina 18 pentru mai multe informații.

► Creați coloane noi: Dacă nu găsiți coloana necesară, faceți clic peAdăugați câmpbutonul pentru a adăuga unul nou. Pentru a afla cum 

să adăugați o coloană, consultați pagina 27.

44



STC-96A PLUSSistem PCR în timp real

Capitolul 7 Aplicație software
Sistemul PCR în timp real STC-96A PLUS acceptă mai multe aplicații de testare, inclusiv detecția absolută cantitativă/calitativă, 

discriminarea alelică a punctului final, analiza curbei de topire și analiza curbei de topire de înaltă rezoluție. Această versiune 

STC1.0.0 acceptă analiza calitativă/absolută cantitativă, precum și analiza curbei de topire. Acest capitol descrie modul de realizare 

a acestor aplicații de analiză.

7.1 Experiment calitativ / absolut cantitativ
7.1.1 Introducere în experimentul calitativ / absolut cantitativ
Experimentele calitative / cantitative absolute sunt funcțiile cele mai de bază și utilizate în mod obișnuit. Un experiment 

calitativ este de a detecta dacă genele țintă există în probe necunoscute, cu alte cuvinte, de a face judecăți pozitive/

negative ale probelor. O analiză cantitativă absolută, care este utilă în detectarea conținutului de virus în diagnosticul 

clinic in vitro, este de a determina concentrațiile genelor țintă în probe necunoscute (de exemplu, numărul de copii pe 

ml). Următoarea secțiune prezintă teoria analizei calitative/cantitative absolute și explică semnificațiile parametrilor de 

analiză implicați în software.

Despre testul PCR cantitativ în timp real

În timpul fazei inițiale a amplificării PCR, secvența țintă a segmentelor de ADN a crescut exponențial. Cu toate acestea, 

odată cu acumularea produselor de amplificare și degradarea activității enzimelor, eficiența amplificării scade. Ca urmare, 

reacția atinge o perioadă de platou. Sistemul monitorizează și înregistrează întregul proces PCR și trasează curba de 

amplificare. Următoarea figură prezintă o curbă tipică de amplificare (Fig 7-1).

Fig 7-1

Graficul de mai sus arată că curbele de dezvoltare a topirii PCR cu fluorescență în timp real sunt împărțite în 3 faze:

Perioada de referință:Perioada de referință se referă la ciclurile inițiale ale PCR în care există puține modificări ale semnalului 

fluorescece, de obicei primele 10-15 cicluri. Linia de bază este utilizată pentru a normaliza semnalele de fluorescență. În fazele inițiale 

ale PCR, având în vedere numărul limitat de produse de amplificare, semnalele de fluorescență sunt destul de slabe și, prin urmare, 

sunt îngropate în fundalul fluorescent. Ca rezultat, perioada de referință reflectă în general fundalul întregului sistem (inclusiv 

instrumentul și reactivii).

Perioada liniară:Pe măsură ce reacțiile PCR continuă; semnalele de fluorescență ale produselor de amplificare continuă să 

crească și în cele din urmă trec dincolo de fondul fluorescent în perioada liniară. Aceasta este reprezentată de o pantă ascendentă 

pe graficul curbei de amplificare. Panta perioadei liniare poate reflecta practic randamentul de amplificare. Eficiența amplificării 

variază de la 0 la 1.

În etapele inițiale ale perioadei liniare, fluorescența ajunge la un anumit nivel, numit pragul de fluorescență. Pragul de fluorescență 

este setat să fie deasupra liniei de bază și suficient de scăzut pentru a fi în regiunea de creștere exponențială a
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curba de amplificare. Când amplificarea PCR atinge nivelul pragului de fluorescență, numărul corespunzător de cicluri se 

numește valoare Ct, cu C pentru ciclu și t pentru prag. Ct este corelat negativ cu cantitatea șablon brută de probe.

Perioada platoului:Pe măsură ce reacțiile PCR au loc, eficiența de amplificare scade și reacția atinge o perioadă de 

platou.

Despre experimentul cantitativ absolut și curba standard

În PCR în timp real, există o relație log-liniară între valoarea Ct a fiecărui șablon și copiile inițiale ale șablonului. Cu cât sunt mai 

multe copii inițiale, cu atât valoarea Ct este mai mică.

Analiza cantitativă absolută este o analiză care testează un set de standarde diluate în gradient de concentrații cunoscute și probe 

necunoscute în același timp. La sfârșitul testului se obțin valorile Ct ale standardelor și probelor necunoscute. Cu valoarea log a 

concentrațiilor standardelor pentru axa X și valorile Ct ale standardelor pentru axa Y, sistemul desenează automat o curbă standard. 

După obținerea valorilor Ct ale probelor necunoscute, concentrația inițială a acestor probe poate fi calculată cu ușurință prin 

intermediul curbei standard. Această abordare presupune că toate standardele și eșantioanele necunoscute sunt similare ca eficiență 

de amplificare. Concentrația standardelor diluate în gradient ar trebui să includă intervalul de concentrație a probei clinice și ar trebui 

să se încadreze în intervalele liniare ale instrumentului PCR în timp real și ale protocolului trusei.

7.1.2 Crearea unui proiect calitativ / cantitativ absolut

❶ ClicCreabutonul din stânga ecranului Manager de proiect.

❷ Apoi faceți clic peGerenalpentru a merge la următorul ecran (Fig 7-2). Introduceți „HBV” înNumele proiectuluidomeniu; în Tip de 

proiectmeniu derulant, selectațiCalitativ/Absolut Cantitativ.Introduceți „30” înVolumul de reacțiedomeniu. Dacă este necesar, 

editați informațiile unității și comentariile.

Fig 7-2

❸ Definiți informațiile țintă. Bifați caseta de selectare a Canalului 1 și introduceți numele țintei „HBV”. În mod similar, introduceți „IC” în 

canalul 2.

❹ Faceți clic peProgrampentru a edita programul termic. Pentru mai multe informații despre cum să creați un program 

termic, consultați P31.

❺ ClicParametriipentru a modifica parametrii experimentului în conformitate cu protocolul setului dvs. Parametrii implicați sunt 

introduși după cum urmează.

Fig 7-3

Parametrii de bază
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Tabelul de mai sus reprezintă parametrii de bază pentru experimentul calitativ / cantitativ absolut (Fig 7-3). Fiecare țintă 

definită în ecranul General are mai jos parametrii.

- Tip de analiză:DacăCantitativeste selectat, concentrația țintei este calculată prin intermediul unei curbe 

standard interne sau externe; dacăCalitativeste selectat, concentrația țintei nu este calculată.

Linia de referință:Configurați parametrii deÎnceputul liniei de bază,Sfârșitul liniei de bazăşiOptimizare de 

bazăpentru ținta actuală. Având în vedere influența sondei sau a altor factori, linia de bază a unor probe poate 

înclina ușor în sus sau în jos, ceea ce ar putea fi optimizat prinOptimizare de bază.

► Linia de referință Început/Sfârșit:În mod implicit,Începutul liniei de bazăeste „6”, în timp ceSfârșitul liniei de bazăeste „12”. 

The Începutul liniei de bazăar trebui să evite ciclurile inițiale ale căror valori de fluorescență sunt încă instabile; cel Sfârșitul 

liniei de bazăar trebui să fie înaintea regiunii de liniaritate a curbelor de amplificare.

► Optimizare inițială:ImplicitAutooptimizarea va selecta automat începutul corespunzător liniei de bază/valorile 

finale pentru fiecare țintă. TheOptimizare manualăva folosi valoarea de început/terminare a liniei de bază 

manuală. Dacă nu trebuie să optimizați linia de bază, selectațiN / A.

Prag:ImplicitPrag automatva calcula automat valoarea limitei optime. Dacă doriți să determinați pragul 

manual, debifați caseta de selectare aPrag automatși introduceți valoarea corectă înPrag manual

domeniu. Se recomandă utilizarea începătorilorPrag automatsau introduceți pragul corespunzător 

conform protocoalelor kitului. Principiile de stabilire a pragului de fluorescență sunt:

► Pragul de fluorescență trebuie să fie în regiunea liniară;

► Dacă pragul este prea scăzut, erorile de detectare vor avea un efect mare asupra rezultatelor experimentului;

► Dacă pragul este prea mare, diferența dintre tuburi devine exagerată și un rezultat slab pozitiv 

poate fi ratat.

► Pragul de fluorescență este ajustat pentru a obține cea mai bună liniaritate a curbei standard. . Filtru digital: filtru digital

este folosit pentru a elimina erorile de fluctuație în timpul detectării și pentru a aplica algoritmul de filtrare pentru a face datele 

fluorescenței fluide. „Filtrul digital” se aplică în general atunci când semnalul de fluorescență este slab.

-

-

-

Interval de liniaritate cantitativă

Interval de liniaritate cantitativăeste utilizat pentru a seta limitările de detecție max/min ale reactivilor. De obicei, 

intervalul cantitativ al unui kit comercial este de obicei de la 500 UI/mL la 50.000.000 UI/mL. Dacă probele depășesc 

limitele de detectare, concentrația probei va afișa „Dincolo de limitări”. Puteți introduce intervalul liniar de detecție 

cantitativă prin protocolul kit (Fig 7-4).

Fig 7-4

Calibrare Crosstalk
Tabelul de calibrare a diafoniei este utilizat pentru a calibra diafoniile potențiale dintre canalele unui experiment cu mai multe culori 

(experiment cu mai multe canale). Puteți introduce valorile corecte ale calibratorului de diafonie (Fig 7-5) urmând protocolul kit-ului. 

Într-un experiment multiplex, lungimile de undă ale luminii emise de coloranți se suprapun, determinând ca un canal să capteze 

semnale de la mai mult de un colorant. Această așa-numită diafonie, care variază în funcție de kiturile diferite, poate provoca date 

înșelătoare. Calibrarea de diafonie (numită și compensare de culoare) este necesară pentru a corecta această scurgere între canale în 

experimentele multiplex.

47



Versiunea 1.7

Fig 7-5

UtilizareCopieşiPastămeniul din bara de meniu (sau comenzile de clic dreapta) pentru a face editarea mai 
comodă.

❻ Faceți clic peRegulăfila pentru a merge la ecranul regulilor de interpretare.Dacă regulile de interpretare a rezultatului kit-ului sunt simple, selectați 

Utilizați regula de bază.Dacă regulile de interpretare sunt prea complicate pentru a fi efectuate de Basic Rule, trebuie să selectațiUtilizați o regulă 

avansată. Vă rugăm să contactați furnizorul de reactivi pentru regulile avansate ale trusei. Regula de bază (Fig 7-6) este împărțită în trei elemente:

Controlul experimentuluieste folosit pentru a determina dacă experimentul este valid sau nu; Sample Control este utilizat pentru a determina 

dacă eșantionul este valid sau nu;Interpretarea rezultateloreste utilizat pentru a analiza rezultatele eșantionului și a genera concluzii.

Fig 7-6

Iată un exemplu de kit de detectare cantitativă pentru acidul nucleic hepatitei B:

Controlul calității:Rezultatul controlului negativ ar trebui să fie „Fără Ct”. Concentrația de control pozitiv ridicat 

este mai mare de 1000000 de copii/ml.

Interpretarea rezultatelor:Dacă concentrația unei probe este între 5000 ~ 500000000copii/mL, atunci proba este 

„Pozitivă”. Dacă concentrația este peste 500000000, concluzia probei ar trebui să fie „>500000000”. Dacă 

concentrația este mai mică de 5000, proba este raportată ca „negativă”.

Următorii pași arată cum să editați regulile de bază de mai sus:

► Faceți clic pentru a selectaUtilizați regula de bază.

► SelectaUtilizați controlul experimentuluiși Faceți clicAdăugabutonul pentru a adăuga o nouă regulă. Selectați 

„Negativ” în meniul derulant alTip eșantion. Selectați „HBV” din meniurile derulante aleŢintă.Selectați „Ct” din 

meniurile derulante aleTip de date.Selectați „=” din meniurile derulante aleComparaţie.Selectați „NoCt” din meniurile 

derulante aleValoare(Fig 7- 7). Această regulă reprezintă faptul că rezultatul controlului negativ ar trebui să fie „Fără 

Ct”.

Fig 7- 7

► ClicAdăugabutonul din nou pentru a crea o nouă regulă. Selectați „Pozitiv” și „HBV” pentruTip eșantioncâmpul și

Ţintădomeniu. Introduceți „100000000” în câmpul deValoare. În meniul derulant alComparaţie, selectați „≤”. 

Selectați „Cn” pentruTip de datecâmp (Fig 7-8). Această regulă reprezintă că concentrația de control pozitiv ridicat 

este de peste 1000000 de copii/mL;
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Fig 7-8

► Bifați caseta de selectare aUtilizați Interpretarea rezultatelor. ClicAdăugabutonul pentru a crea o nouă regulă. 

Selectați „Eșantion” și „HBV” pentruTip eșantioncâmpul șiŢintădomeniu. Introduceți „5000”, „500000000” în cele 

două câmpuri aleValoarerespectiv. Selectați „≤” pentru douăComparaţiecâmpuri. Selectați „Cn” pentruTip de 

datedomeniu. (Fig 7-9). Introduceți „Pozitiv” în câmpul deConcluzie. Selectați culoarea roșie înCuloarecutie. Această 

regulă reprezintă că probele cu concentrația în „5000-500000000” primesc concluzii „pozitive”.

Fig 7-9

► În mod similar, editați regula de odihnă după cum urmează (Fig 7-10).

Fig 7- 10

❼ Faceți clic peSalvabuton; apoi faceți clic peAproapebutoane pentru a închide proiectul.

7.1.3 Creați experiment calitativ / cantitativ absolut
❶ ClicExpertul de experimentebutonul de peAcasă experimentalăecran pentru a crea un nou experiment. Selectați 

„Calitativ / absolut cantitativ” dinTip de experiment, introduceți informații generale despre experiment și configurați 

instrumentul după cum este necesar.

❷ ClicPlacăfila. Selectați puțul de definit pe selectorul de puțuri; apoi selectați proiectul creat anterior „HBV” din lista 

de proiecte din dreapta sus a ecranului. Definiți proprietatea puțurilor selectate în dreapta jos. Tipurile de mostre 

și proprietățile experimentelor cantitative calitative/absolute sunt prezentate în tabelul de mai jos:

Tip eșantion Descrieri Proprietate

Eșantioane cu cantități cunoscute, utilizate pentru a genera 
curbe standard

Standarde concentraţie

Necunoscut Probele de testat

Retestați Probele suspecte care urmează să fie retestate

Negativ Probe de control negative

Pozitiv Probe de control puternic pozitive

Scăzut pozitiv Probe de control slab pozitive

QC Probe de control pozitiv al calității cu cantități cunoscute concentraţie

NTC Fără mostre de control șablon

Creați standarde după standarde automate:

Selectați godeuri înmulțite în Selector de godeuri și faceți clicAuto-Standardemeniu din bara de meniu pentru a 

deschide următoarea casetă care este utilizată pentru a crea standarde în serie. Introduceți numărul de replici în

Replicate caseta.Apoi introduceti valorile corespunzatoare in casetele deConcentrarea inițialăşiFactorul de diluție. 

După cum se arată în figura de mai jos (Fig 7-11), sunt selectate 5 godeuri, concentrațiile fiind „1000”, „10000”, „100000”, 

„1000000” și respectiv „10000000”.
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Fig 7- 11

❸ Dacă este necesar, faceți clic peEşantionfila și introduceți informațiile pacientului.

❹ ClicFugifila și apoi faceți clic peÎnceputbutonul din dreapta barei de meniu pentru a începe experimentul.

❺ După ce rularea este terminată, apare o casetă de dialog care sugerează că experimentul este finalizat; iar fișierul rezultat va fi 

salvat pe calea definită anterior. Apoi împingeți glisoarele deschise ușor și scoateți tuburile de reacție. În cele din urmă, închideți 

glisoarele albastre împingând-o ușor înapoi. Acoperiți instrumentul cu un capac rezistent la praf.

Pentru mai multe informații despre cum să efectuați un experiment, consultați4.3 Cum să creați și să rulați un 
experiment.

7.1.4 Analiza experimentului calitativ / absolut cantitativ
❶ După finalizarea experimentului, programul va analiza automat datele și va trece laAnalizăfila (Fig 7-12). Puteți 

vizualiza datele experimentului pe interfața de analiză. În partea stângă sus a interfeței se află Tabelul cu 

informații despre Well. În analiza calitativă, vor fi afișate Ct și concluzia. În analiza cantitativă, Ct, concentrația și 

concluziile vor fi afișate în tabel. Caracterele curbei afișate în partea dreaptă includ Curba de amplificare brută, 

Curba de amplificare, programul termic și Curba standard.

Fig 7- 12

► Curbe de amplificare:arată curba de amplificare normalizată și linia pragului de fluorescență. Pentru a ascunde 

linia de prag, faceți clic pe meniuPreferințesi deselecteaza "Afișați linia de bază pe diagrama curbei de 

amplificare" înOpțiuni grafice.Dacă în diagramă sunt afișate curbe ale unei singure ținte, utilizatorilor li se 

permite să modifice valorile pragului trăgând linia de prag (Fig 7-13).
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Fig 7- 13

► Curba brută de amplificare:Curba de amplificare brută (Fig 7-14) arată curba de fluorescență originală 

a probei selectate, care este semnalul de fluorescență real detectat de instrument.

Fig 7- 14
Pentru mai multe informații despre vizualizarea informațiilor despre experiment, consultați4.4 Vizualizați și analizați un 
experiment.

❷ În analiza cantitativă, programul va calcula concentrațiile probelor (Fig 7-15).

Fig 7- 15

Curba standard

În partea dreaptă sus a ecranului sunt afișate toate curbele standard (Fig 7-16) ale țintelor de analiză cantitativă. Curbele 

standard pot fi clasificate după surse în curbe standard externe și curbe standard interne. Curba standard internă se referă 

la curba standard desenată pe baza standardelor din experimentul curent. Pentru a exporta datele curbei standard, faceți 

clic dreapta și selectați „Exportare date”.

Fig 7- 16
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Dacă proba selectată se încadrează în intervalul liniar al curbei standard, eșantionul va fi afișat pe curba standard. Pentru a 

ascunde această funcție, faceți clic pePreferințesi debifati "Afișați puțurile selectate pe diagrama curbă standard" în

Opțiuni grafice.

Salvați ca curbă standard externă

Pentru a salva curba standard internă, faceți clic peSalvabutonul dinCurbe standard externemeniu; verificați proiectul a cărui curbă 

standard urmează să fie salvată, introduceți un nume și informații despre lotul de reactiv, apoi faceți clicSalva(Fig 7- 17).

Fig 7- 17

Importați curba standard externă

Dacă nu este setat niciun standard în experiment sau numărul de standarde valide este mai mic de 2, software-ul va apărea 

următoarea casetă (Fig 7-18 din stânga) pentru a reaminti utilizatorilor să aplice un standard extern. Când dai clicConfirma, 

caseta de dialog aAplicați curba standard externăva apărea (Fig 7-18 dreapta). Verificați opțiuneaUtilizați curba standard 

externăîn spatele numelui proiectului, selectați o curbă standard externă corespunzătoare în meniul derulant alNume de fișier, 

apoi faceți clicConfirma.

Fig 7- 18

Dacă nu sunteți mulțumit de curba standard internă din experiment, puteți aplica curbe standard externe.

Managementul curbelor standard externe

ClicManager de curbe standard externîn meniul derulant alCurba standardpentru a deschide următoarea fereastră (Fig 

7-19). Ecranul arată toate curbele standard înregistrate de software. ClicImportpentru a importa o curbă standard în acest 

folder; selectați o curbă standard din listă și faceți clicExportpentru a-l salva pe altă cale.

Fig 7- 19
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7.2 Experimentul curbei de topire
7.2.1
Scopul analizei curbei de topire este de a determina temperatura caracteristică de topire a ADN-ului țintă și de a identifica sau 

genotipiza produsele pe baza temperaturii lor de topire. Temperatura la care se topește o catenă de ADN atunci când este 

încălzită poate varia într-un interval larg, în funcție de secvență. , lungimea șuviței și conținutul de GC al șuviței. Temperatura 

de topire (sau Tm) a unei probe este definită ca punctul în care jumătate din ADN s-a topit sau jumătate din sonde s-au topit 

de ADN. Acesta variază în funcție de diferite secvențe de ADN. Pe baza diferențelor de performanță de topire și a valorilor Tm, 

putem discrimina diferitele probe, de exemplu, verificarea specificității produselor de amplificare PCR, analiza genotipării.

Introducere în analiza curbei de topire

7.2.2 Crearea proiectului curba de topire

❶ ClicCreabutonul din stânga ecranului Manager de proiect pentru a crea un nou proiect.

❷ ClicGeneral(Fig 7-20) și selectați „Curba de topire” din meniul derulant alTip de proiect; Introduceți numele proiectului și volumul 

de reacție. Dacă este necesar, introduceți informații despre comentarii.

Fig 7- 20

❸ Definiți informațiile țintă (Fig 7-20) în tabelul deInformații țintăconform protocolului trusei.Mai multe 

informații despre definirea țintei, accesați5.2 Creare proiect.

❹ Faceți clic peProgramfila.Urmeaza protocolul kit-ului, editeaza programul termic. Programul termic al curbei de topire este 

compus de obicei dintr-un program PCR și un segment de topire. Pentru a vedea cum să editați programul PCR, vă rugăm

consultați pagina 36.Pentru a modifica segmentul de topire, modificați temperatura cutiei de topire trăgându-l.

Apoi selectați modul de scanare adecvat în partea de jos a segmentului de topire. Următorul tabel explică 

semnificațiile celor două moduri de scanare.

Tip Descrieri Parametrii Descriere

În timp ce blocul de reacție al instrumentului se 
încălzește la o viteză dată, sistemul de scanare 
continuă să scaneze și să colecteze semnale.

Viteza de rampă a modulului de 
reacție.
Valoare de intrare în intervalul 
0,01 ~ 0,06℃/s.

Continuu Rata de rampă

Intervalele de scanare ale 
temperaturilor pentru sistemul de 
scanare.
Valoare de intrare în intervalul 
0,1 ~ 1℃.

Scanare
IntervalSistemul de scanare scanează și colectează 

semnale la anumite temperaturi, când modulul 
de reacție menține nivelul de temperatură 
pentru o anumită perioadă de timp.

Pas

Timpul de menținere al fiecărui pas 
Introduceți valoarea în intervalul 
8~99s.

Deţinere
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Fig 7- 21

❺ ClicParametriipentru a modifica parametrii experimentului. Dacă este inclusă amplificarea PCR, poate fi necesar să ajustați 

parametrii de bază. Pentru experimentele cu curbe de topire multiplex, uneori este necesară calibrarea Crosstalk. Pentru mai multe 

informații despre opțiunea de bază și corectarea diafoniei, consultați pagina 47.

TheParametrii curbei de topirefila este folosită pentru a analiza curbele de topire, funcțiile acestora sunt introduse după cum 

urmează:

► Temperatura minima:definiți temperatura minimă a curbei de topire. Toate vârfurile de topire sub această 

temperatură sunt ignorate.

► Temperatura maxima:definiți temperatura maximă a curbei de topire. Toate vârfurile de topire peste această 

temperatură sunt ignorate.

► Pragul de înălțime maximă:este folosit pentru a exclude vârful nespecific.

Fig 7- 22

❻ Dacă este necesar, faceți clicRegulăpentru a aplica fișierul cu reguli avansate obținut de la producătorul reactivului.

❼ Salvați și închideți proiectul.

7.2.3 Crearea experimentului curbei de topire

❶ Pentru a crea un nou experiment, faceți clicExpertul de experimentebutonul de peAcasă experimentalăecran.

❷ Faceți clic peÎnființatfila, selectați „Curba de topire” dinTip de experiment, introduceți informații generale despre experiment și 

configurați instrumentul după cum este necesar.
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Fig 7- 23

❸ ClicPlacăfila. Selectați puțurile de definit în selectorul de godeuri; și apoi selectați proiectul creat anterior din lista de 

proiecte din dreapta sus a ecranului. Definiți proprietățile puțurilor.

Fig 7- 24

❹ Dacă este necesar, faceți clicEşantionfila și introduceți informațiile pacientului.

❺ ClicFugifila și apoi faceți clic peÎnceputbutonul din dreapta barei de meniu pentru a începe experimentul.

❻ După ce rularea s-a terminat, apare o casetă de dialog care sugerează că experimentul este finalizat. Împingeți glisoarele deschise ușor și 

scoateți tuburile. În cele din urmă, închideți glisoarele albastre împingând-o ușor înapoi. Acoperiți instrumentul cu un capac rezistent la 

praf.

Pentru mai multe informații despre cum să creați un experiment, consultați4.3 Cum să creați și să rulați un 
experiment.

7.2.4 Analiza curbei de topire standard

❶ După finalizarea experimentului, programul va analiza automat rezultatele și va schimba interfața de analiză. În 

partea stângă sus a interfeței se află Tabelul cu informații despre sonde, care afișează valoarea Tm și valoarea Rm 

a țintei.

Fig 7- 25
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Pentru mai multe informații despre vizualizarea informațiilor despre experiment, consultați4.4 Vizualizați și analizați un 
experiment.

❷ Diagramele curbelor afișate în partea dreaptă includ curba de vârf de topire, vârf de topire normalizat, curba de 

amplificare brută, curba de amplificare, curba de amplificare brută și programul termic.

► Curba de topire brută:Curba de topire brută arată temperatura reală Vs curbele valorii fluorescenței ale 

probei selectate.

Fig 7- 26

► Curba vârfului de topire:Se mai numește și curbă de topire derivată. În grafic sunt afișate curbele pragului de 

temperatură max/min. Dacă graficul arată doar curbele pentru o singură țintă, puteți ajusta pragul de temperatură 

trăgând linia pragului de temperatură.

Fig 7- 27

► Vârful de topire normalizat:Curba de topire brută, după deducerea fondului fluorescent în 

perioada de bază a amplificării PCR, derivă în vârful de topire normalizat.

Fig 7- 28
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Capitolul 8 Întreținere

8.1 Curăţarea instrumentului
Curățarea Instrumentului

► Suprafața instrumentului trebuie curățată periodic cu o cârpă moale, fără scame, umezită cu apă. Dacă este necesar, 

utilizați soluție de etanol 70% pentru a șterge murdăria.

Curățarea puțurilor de probă

► Praful sau alte impurități căzute în godeurile de reacție pot interfera cu colectarea semnalului fluorescent. Utilizați peria de suflare 

furnizată de producător pentru a curăța godeurile de reacție la 3 luni.

► Pentru a preveni pătrunderea prafului în godeul de probă, țineți întotdeauna glisorul albastru închis, cu excepția cazului în care introduceți tuburile 

de probă și acoperiți instrumentul cu antipraf furnizat de producător atunci când instrumentul nu este utilizat.

► Dacă praful cade în godeurile de reacție, curățați godeurile de reacție cu o cârpă moale, fără scame, umezită cu soluție de etanol 70%.

Opriți întotdeauna alimentarea și scoateți cablul de alimentare înainte de curățarea instrumentului. 

Nu turnați niciodată fluide în puțurile de reacție sau în interiorul instrumentului.

Consultați producătorul sau distribuitorii dacă utilizatorii folosesc soluții de curățare care nu sunt recomandate de 
producător.

8.2 Protecția instrumentelor
► Nu porniți și opriți instrumentul frecvent. Trebuie să existe un interval mai mare de 30 de secunde între 

pornirea și oprirea mașinii.
► Nu opriți instrumentul imediat după funcționare, deoarece blocul de reacție este încă fierbinte, așteptați o perioadă de timp adecvată 

(ventilatoarele din instrument vor răci blocul de reacție) pentru a lăsa temperatura să scadă la temperatura camerei.

► Utilizați întotdeauna cabluri de alimentare furnizate de producător.

Fierberea instrumentului la 99°C sau menținerea la 4°C este strict interzisă.

Utilizatorilor le este interzis dezasamblarea instrumentului.

8.3 Înlocuirea siguranțelor

Instrumentul STC-96A PLUS conține două siguranțe de 10A, 250V situate pe panoul din spate al instrumentului. Pentru a înlocui o siguranță: 

Folosiți o șurubelniță pentru a deșuruba capacul cutiei de siguranțe în sens invers acelor de ceasornic, apoi schimbați siguranța arsă cu o 

siguranță de schimb (Φ5×20mm – 10A, 250V) și introduceți siguranța împreună cu capacul. Conectați cablul de alimentare după înlocuirea 

siguranței.

Opriți întotdeauna alimentarea și scoateți cablul de alimentare înainte de a înlocui siguranțele.

8.4 Manipularea deșeurilor
Există o mulțime de produse de amplificare în tuburile PCR după rulare, care ar trebui eliminate cât mai repede posibil.

Nu deschideți tuburile PCR, deoarece aceasta va duce la contaminarea laboratorului.

8.5 Protecție la supraîncălzire
Unitatea de termociclare a instrumentului este echipată cu un dispozitiv de protecție la supraîncălzire. Când unitatea termociclorului se 

defectează și temperatura acesteia depășește pragul de temperatură, protecția împotriva supraîncălzirii se va deconecta automat și nu va 

relua automat încălzirea când dispozitivul se răcește. Când se întâmplă acest lucru, unitatea termică nu funcționează corespunzător pentru a 

controla creșterea și scăderea temperaturii.

Utilizatorii trebuie să înceteze imediat utilizarea instrumentului și să contacteze producătorul odată ce apare defecțiunea de mai sus.
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Anexa I Șablon de raport al pacientului

1. Manager de rapoarte pacient
În ecranul Experiment Wizard, faceți clic pe meniul drop-down alImprimareși selectațiManager rapoarte pacientmeniu pentru a intra în 

Manager rapoarte pacient(Anexa 1- 1). Aici software-ul oferă șabloane de înmulțire a rapoartelor pacientului. Faceți clic pe un șablon pentru 

o previzualizare. ClicImportpentru a salva alte șabloane de stil în calea implicită; clicExportpentru a salva șablonul de stil selectat pe o altă 

cale. Pentru a șterge un șablon de raport al pacientului, faceți clic pe el și faceți clicŞterge.

Anexa 1-1

Vă rugăm să consultați4.7.1 Imprimare raport pacientpentru informații despre modul de tipărire a rapoartelor pacientului.

2. Creați șablon de raport pentru pacient
Faceți clic pe meniul drop-down alImprimareși selectațiȘablon nou de raport al pacientuluipentru a crea un nou șablon. În caseta pop-up, introduceți 

numele fișierului. ClicConfirmapentru a deschide un fișier Microsoft Word 2007 necompletat, în care puteți crea șablonul de raport al pacientului. Software-

ul localizează informații prin găsirea/înlocuirea cuvintelor cheie. Următorul tabel prezintă toate informațiile și cuvintele cheie ale unui formular de raportare 

a pacientului.

Nume Cuvinte cheie

Exemplu de etichetă $label#

Nume $nume#

Sex $sex#

Vârstă $ varsta #

Spital $spital#

ID caz $caseid#

ID patul $bedid#

ID ambulatoriu $outpatientid#

ID-ul pacientului internat $inpatientid#

Data colectării $collectdate#

Data testului $testdate#

Data raportului $reportdate#

Departament $office#

Diagnostic $diagnosis#

Tipul specimenului $sampletype#

Doctor $doctor#

Operator $operator#

Auditor $evaluator#

Ţintă $targetname|extensie#
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Ct $ct|extensie#

Concentraţie $cn|extensie#

Unitate $unit|extensie#

Concluzie țintă $targetconclusion|extensie#

Ei bine Concluzia $wellconcluzie|extensie#

Exemplu de concluzie $sampleconclusion|extensie#

Prag $threshold|extensie#

Remarcă $remark|extensie#

Curba de amplificare $curba#

Numele proiectului $proiect#

Notă: Formatul extensiei este „nume proiect | numărul tubului|numărul canalului”. Dacă în raport există un singur proiect, numele 

proiectului este omis în timp ce extensia este scrisă în formatul „număr tub|număr canal;” dacă trebuie să tipăriți mai multe proiecte 

într-un singur raport, numele proiectului nu poate fi omis.

Următorul exemplu arată cum să creați un șablon de raport al pacientului (Anexa 1-2). Acest raport oferă informații 

despre spital, pacient, concluzia diagnosticului și curba de amplificare PCR a pacientului.

Anexa 1-2

În ecranul de cuvinte deschis, introduceți informații și cuvinte cheie urmând figura de mai jos (Anexa 1-3).

Anexa 1-3

Introduceți orice imagine în locația potrivită. Faceți clic dreapta pe imagine, selectați „Dimensiune...” pentru a deschide următoarea casetă de dialog.

Anexa 1-4
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Faceți clic peAlt textfila și introduceți „$curva#” în caseta de text. Când editarea șablonului de stil este finalizată, șablonul apare 

după cum urmează (Anexa 1-5).

Anexa 1-5

3. Configurați șablonul de raport al pacientului

Faceți clic peImprimaremeniul derulant și selectațiSetarea raportului pacientului(Anexa 1- 6). Introduceți informațiile corespunzătoare în

Numele spitaluluicâmp, care va fi afișat în titlul formularului de raportare a pacientului. Potriviți formularul de printare potrivit pentru proiect 

făcând clic pe câmp și selectând un raport.

Anexa 1-6

Faceți clic peOpțiune de imprimarefila. Aveți voie să acordați semne fiecărui canal atunci când imprimați rapoarte cu o imprimantă alb-

negru (Anexa 1-7).

Anexa 1-7
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Anexa II Algoritmul fundamental
1. Algoritmul fundamental în detectarea PCR cantitativă este derivat după cum urmează: 

F1

F2
f1
f2
K0
K
I1
I2
C1
Ct1
C2
Ct2
E

Dacă eficiența de amplificare a godeului de referință 1 este egală cu godeul 2 și coeficienții lor de fluorescență de fond sunt, de asemenea, aceiași, 

intensitatea fluorescenței celor două godeuri este:

F1 = K0*I1 + K*I1*C1*（1+E）Ct1 F2 

= K0*I2 + K*I2*C2*（1+E）Ct2

Unde K0*I este intensitatea fluorescenței în linia de bază.

f1 = LOG（F1/（K0*I1））=Jurnalul（1+（K/K0）*C1*（1+E）Ct1） f2 

= LOG（F2/（K0*I2））=Jurnalul（1+（K/K0）*C2*（1+E）Ct2）

Deoarece intensitatea fluorescenței normalizată la ciclul Ct al fiecărei godeuri este egală, adică f1 = f2 = Pragul de 

fluorescență, se obțin următoarele expresii:

Jurnalul（1+（K/K0）*C1*（1+E）Ct1）=Jurnalul（1+（K/K0）*C2*（1+E）Ct2）

1+（K/K0）*C1*（1+E）Ct1 = 1+（K/K0）*C2*（1+E）Ct2
C1*（1+E）Ct1 = C2*（1+E）Ct2

C1/C2 =（1+E）Ct2-Ct1

- Valoarea originală a intensității fluorescenței în godeul de referință 1 la ciclul Ct1

- Valoarea originală a intensității fluorescenței în godeul de referință 2 la ciclul Ct2

- Intensitatea fluorescenței după normalizare în godeul de referință 1 la ciclul Ct1

- Intensitatea fluorescenței după normalizare în godeul de referință 2 la ciclul Ct2

- Coeficient de fluorescență de fond

- Coeficient de fluorescență a semnalului

- Intensitatea luminii emoționante a puțului de referință 1

- Intensitatea luminii emoționante a sondei de referință 2

- Concentrația inițială a godeului de referință 1

- Valoarea Ct a sondei de referință 1

- Concentrația inițială a sondei de referință 2

- Valoarea Ct a sondei de referință 2

- Eficienta amplificarii

Luarea jurnalului de mai sus îl convertește în

（Jurnalul（C1）-Jurnalul（C2））/（Ct1 – Ct2）= -Jurnalul（1+E）

Formula de mai sus arată că: Valoarea LOG a concentrației inițiale a probei detectate este invers proporțională 

cu valoarea sa Ct. Panta sa este -LOG (1+E).

2. Formula pentru calcularea valorii R

Cea mai bună valoare R este -1, ceea ce înseamnă că toate punctele standardelor sunt situate în curba standard. Vă rugăm să consultați instrucțiunile 

privind reactivii pentru intervalul acceptabil al valorii R. În general, valoarea R este -0,99 ~ -1.

Formula pentru calcularea valorii R este:

X - X Y - Y
X - X 2Y - Y

r =
 2

Unde: r
X
X

Valoare în axa X 
Date în axa X
Valoarea medie a tuturor datelor din axa X. Date din axa Y 

Date din axa Y

Valoarea medie a tuturor datelor din axa Y.

Y
Y
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3. Algoritm pentru valoarea CV

Valoarea CV indică repetabilitatea detectării. După detectarea a n tuburi cu aceeași concentrație inițială, valoarea CV a acestor tuburi este 

calculată pentru a verifica repetabilitatea. Cea mai bună valoare CV este 0%, unde toate valorile sunt identice.

Formula pentru calcularea CV-Value este:

X - X 2n - 1
XCV = × 100%

Unde, CV
X
X

Valoarea CV-ului

Date
Valoarea medie a tuturor numărului de 

date de daten
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Anexa III Depanare
Nu. Observare Cauza posibila Acțiune recomandată

1 Imposibil de instalat software-ul STC1.0.0 sau 

software-ul care rulează incorect

1. Sistem de operare

corupţie.
2. Hardware-ul computerului nu 

îndeplinește minimul

cerințe.

1. Reinstalați sistemul de 

operare Windows.

2. Înlocuiți computerul cu unul 

dintre cele mai bune

configuratii.

2 Mesaj de eroare: „Nu se poate conecta la 

instrument!”

1. Instrumentul este 
oprit;
2. Cablul RS232 sau USB-

la-RS232 nu este

conectat în siguranță;

3. Driverul adaptorului USB nu 

este instalat

cu succes.

1. Porniți instrumentul;
2. Verificați cablurile 

dintre PC și

instrument;

3. Instalați manual 

driverul USB

3 Mesaj de eroare: „Eșec la localizarea glisorului!” Glisorul instrumentului este

nu pe loc.
Împingeți cursorul în locația 

corectă.

4 Mesaj de eroare: „Nu s-a putut închide capacul fierbinte!” 1. Eșec de comunicare
2. Defecțiune a capacului fierbinte

1. Verificați conexiunea de 
comunicare între PC
și instrument și apoi 

reporniți rularea;

2. Contactați distribuitorul sau 

producătorul.

5 Mesaj de eroare: „Nu s-a putut încălzi capacul fierbinte!” Defecțiune a capacului fierbinte Contactați distribuitorul sau 

producătorul dvs.

6 Mesaj de eroare: „Temperatura capacului fierbinte în afara 

intervalului!”

Defecțiune a capacului fierbinte Contactați distribuitorul sau 

producătorul dvs.

7 Mesaj de eroare: „Nu s-a putut deschide capacul fierbinte!” Eșec de comunicare Opriți instrumentul; 

așteptați câteva minute și 

apoi porniți instrumentul

8 Mesaj de eroare: „Blocați temperatura în afara 

intervalului!”

Unitate de termociclare

defecțiune.

Reporniți instrumentul și 

contactați distribuitorul sau 

producătorul.

9 Mesaj de eroare: „Trimiterea comenzilor a eșuat!” Eroare de comunicare a datelor. Reporniți instrumentul/PC-ul.

10 Mesaj de eroare: „Eroare de comunicare!” 1. PC-ul a rămas fără minory;

2. Funcționare defectuoasă a instrumentului

1. Închideți inutil
aplicatii.

2. Contactați distribuitorul sau 

producătorul dumneavoastră.

11 Mesaj de eroare: „Eșec conexiunea 

instrumentului!”

1. Instrumentul este 
oprit;
2. Cablul serial RS232 sau

1. Verificați puterea 

instrumentului;

2. Verificați cablurile
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Nu. Observare Cauza posibila Acțiune recomandată

Convertor USB la RS232

cablul nu este 

conectat corect;

între PC și
instrument;

12 PC/instrumentul își pierde brusc puterea în timpul 

rulării.

Pana de curent extern. Porniți instrumentul/PC-ul și 

reluați rularea de la punctul de 

întrerupere.

13 Coeficient de corelație nesatisfăcător al 

curbei standard

1. Inexactitatea concentrației 

standardului cauzată de 

repetate

etape de îngheț-dezgheț.

2. Eroare operațională.

3. Reactivii PCR nu 

funcționează corect.

4. Reactivii utilizați sunt 
incompatibili cu
STC-96A PLUS
instrument.

5. Introducerea greșită a 

concentrațiilor

standardele.

1. Refaceți diluția în serie a 

„standardelor”.

2. Standardizați
operare.

3. Contactați furnizorul de 

reactivi.

4. Contactați furnizorul 

de reactiv sau

producător.
5. Reintroduceți

concentraţiile de
standardele.

14 Curbele de fluorescență în timp real în ciclurile timpurii 

nu sunt clare

1. Capacitate termică mare a uleiului 

de olefină.

2. Calitatea slabă a sondei 

de fluorescență.

3. Bulă(e) de aer în tuburile 

PCR

Software-ul STC-96A PLUS a fost 

optimizat pentru a elimina 

efectele cauzate de curbele 

neuniforme în ciclurile timpurii.

Cu toate acestea, utilizatorii trebuie 

să centrifugă înainte de testarea 

PCR pentru a îndepărta bulele sau 

reziduurile de reactivi de pe 

peretele tubului.

15 Unele mostre cu o pantă severă a liniei de 

bază a fluorescenței

1. Prelevare sau pretratare 

necorespunzătoare (eliberarea de 

hemoglobină cauzată de

hemoliză, sau

contaminate cu altele

impuritate)

2. Proteina/impuritatea a fost 

inclusă la colectarea 

supernatului.

3. Fără standardizare a 
pretratării probelor.

1. Îndepărtați impuritățile, evitați 

hemoliza, centrifugeți pentru 

a îndepărta sedimentul.

2. Aveți grijă când 

colectați supernatul.

3. Standardizați
pretratarea probelor.

16 Toate probele cu o uşoară pantă a liniei 

de bază a fluorescenţei

Calitatea proastă a sondei de 

fluorescență.

Selectați Linia de bază

„optimizare” pentru a minimiza 

panta nedorită.
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Nu. Observare Cauza posibila Acțiune recomandată

17 Probă(e) sporadică(e) cu o uşoară pantă a liniei 

de bază a fluorescenţei

Tuburile curg sau capacul este 

slăbit.

Selectați Linia de bază

„optimizare” pentru a minimiza 

panta nedorită.

18 Probă(e) sporadică(e) cu oscilații severe ale 

curbelor de fluorescență

Semnale cu fluorescență scăzută, 

puțuri goale, tuburi goale sau fără 

substanță fluorescentă, cum ar fi 

apa, etc.

Desemnați godeurile de probă 

gratuite drept „Blank”.

19 Toate probele cu o ușoară oscilație a 

curbelor de fluorescență

Semnale cu fluorescență scăzută. Selectați „Filtru digital” 

pentru a netezi curbele
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Chapter 1 Safety Precautions

Before using STC-96A PLUS Real-time PCR System, please read the safety precautions carefully.

If the instrument is used in a manner not specified by the manufacturer, the protection provided by the
equipment may be impaired.

1.1 Conventions Used in This Manual
The following symbols appear in the text of this Manual.

The following symbols appear on the instrument.

Symbols Heading Descriptions

CE MARK
The CE mark on the instrument type plate expresses conformity with
requirements of the directives relevant for this instrument.

WARNING On the instrument type plate.

HOT SURFACE On the margin of the block.

BIO HAZARD On the instrument type plate.

IN VITRO DIAGNOSTIC
MEDICAL DEVICE

On the instrument type plate.

Symbols Heading Descriptions

WARNING
This symbol is used to indicate that noncompliance with instructions or
procedures could lead to physical injury or even death or could cause
damage to the instrument.

HOT SURFACE This symbol is used to label potentially hot instrument surfaces.

BIO HAZARD
This symbol is used to indicate that certain precautions must be taken
when working with potentially infectious material.

IMPORTANT NOTE
Information critical to the success of the procedure or use of the
product.

INFORMATION NOTE Additional information about the current topic or procedure.
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Symbols Heading Descriptions

WEEE

On the instrument plate, indicaing the electrical and electronics device
complys with Directive 2002/96/EC. The device, accessories and the
packaging have to be disposed of correctly at the end of the usage.
Please follow Local Ordinances or Regulations for disposal.

1.2 Handling Requirements

The STC-96A PLUS Real-time PCR System must only be used by trained and skilled personnel.

► The STC-96A PLUS Instrument is an electromechanical instrument. There is a potential danger of electric
shock or physical injury if the instrument is not used according to the instructions given in this manual.

► Follow all safety instructions printed on or attached to the analytical instrument.
► Users may replace fuses if they follow the procedures described in this Operator’s Manual. Any other

electrical modification is not allowed and could render the warranties on the STC-96A PLUS Instrument
null and void.

► Only authorized service personnel are allowed to perform service or repairs required for the instruments.
► Do not open the hot lid during operation.
► The instrument should be placed in a clean, well-ventilated room. Corrosive gas and interference from high

intensity magnetic fields can harm the instrument. Avoid direct sunlight and high intensity light sources.
► The instrument is designed to safety operate within specifications according to CE certified technical

standards at ambient room temperature between 10°C and 30°C, relative humidity less than 85%.

► Always wear safety goggles and gloves when dealing with toxic, caustic or infectious materials.
► Although working with highly purified nucleic acids, for your own safety please treat all biological

material as potentially infectious. Handling and disposal of such material should be performed according to
local safety guidelines. Spills should be immediately disinfected with an appropriate disinfectant solution to
avoid spreading contamination to laboratory personnel or equipment.

► The damaged instrument must be delivered to the manufacturer and be repaired by its manufacturer. Before
delivery, the surface of the instrument should be cleaned and sterilized by disinfectant.

► The thermal block is hot while the instrument is operating. Touching the metal block is strictly prohibited
to prevent burn injuries.

1.3 Electrical Safety

► The instrument is designed in accordance with Protection Class I (IEC).
► For protection against electrical shock, the STC-96A PLUS instrument must be connected directly to an

approved power source such as a three-wire grounded receptacle for the 230V line (50Hz).
► Equipment connected to the analog or digital interfaces must comply with the respective IEC standards (e.g.

IEC 60950 for data processing equipment).
► Before connecting power cables to the instrument, make sure the voltage and frequency of AC power

supply is 230V~, 50Hz. The power switch must be off before the power cables are connected.
► To avoid accidental damage, switch the power off before connecting power or commnucation cables.
► Never touch switches or the power cord with wet hands.
► Never disconnect the power cable without turning the instrument power switch off.
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► Never clean the instrument without turning the instrument power switch off and disconnecting the power
cable.

► Never replace the fuse without turning the instrument power switch off and disconnecting the power cable.
► Turn off the power switch of the instrument when not in use. The power cable should be disconnected from

the power socket before opening the shell when repairing.
► To avoid the risk of electric shock, this equipment must only be connected to a supply main with protective

earth.

1.4 Electromagnetic Compatibility

► This instrument meets the requirements laid down in GB\T18268 relating to transmission and
interference rejection.

► Do not operate this instrument in a place close to high radiation devices (e.g., radio frequency sources
without shielding), or the running of this instrument may be interfered.

► Evaluation of electromagnetic environment is suggested before using this instrument.
► The manufacturer is responsible to provide the EMC information to users.
► The users are responsible to provide proper EMC surrounding to make sure this instrument running

normally.
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Chapter 2 Introduction
2.1 Scope of Application
Based on polymerase chain reaction (PCR) and real-time fluorescence monitoring technology, the STC-96A PLUS real
time PCR system is an automatic analysis product,which is intended for performing qualitative or quantitative detectionof
nucleic acid samples (DNA/RNA) derived from the serum, plasma, urine, virus culture medium, nasal (pharyngeal) swab or
vaginal swab samples or pathogens,as well as post-PCR analysis of the amplified nucleic acid by melting curve analysis.
STC-96A PLUS Real-time PCR System is intended for: 1. Clinical diagnosis in vitro; 2. General laboratory use. The
STC-96A PLUS Real-time PCR System is used exclusively within a laboratory and its users should be trained in PCR
technology and instrument operation and be familiar with related operations.

2.2 Basic Principle
The polymerase chain reaction (PCR) is used to amplify a single copy or a few copies of a piece of DNA across several
orders of magnitude, generating thousands to millions of copies of a particular DNA sequence. The method relies on
thermal cycling, consisting of cycles of repeated heating and cooling of the reaction for DNA melting and enzymatic
replication of the DNA. Primers containing sequences complementary to the target region enables selective amplification.
Typically, PCR consists of a series of temperature cycles and each cycle divides into three stages: denaturation, annealing
and extension.
The Real-Time PCR, which is based on the polymerase chain reaction, is used to amplify and simutaneously quantify the
targed DNA. Fluorogenic oligonucleotide probes or DNA-binding dyes are used as reporters to monitor the PCR reaction.
The increasment in fluorescent signal is proportionate to the amount of amplicon being amplified. Quantification in terms of
genomic units can be calculated by comparison with the Standard Curve. Real-Time PCR is more specific and sensitive
than traditional PCR.

2.3 Main Function
The instrument can perform PCR amplification and real-time fluorescence monitoring of each tube simultaneously. After
amplification, the STC-96A PLUS operating software will analyze the amplification data; perform qualitative/quantitative
analysis or melting curve analysis, and display and print results for each sample automatically, for example, the initial
concentration.

2.4 Main Components
The instrument consists of the following components: the control system, the power supply units, the thermal cycler unit,
the detection unit, instrument housing and software(version:1.0.0).

http://en.wikipedia.org/wiki/DNA_replication
http://en.wikipedia.org/wiki/DNA
http://en.wikipedia.org/wiki/DNA_sequence
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2.5 Main Structure

2.6 Applications
► Detection of clinical pathogens
► Basic scientific research
► Genetic screening
► Food hygiene inspection
► Customhouse import & export quarantine inspection
► Public health and epidemiology
► Detection of animal and plant pathogens

2.7 Panel of the STC-96A PLUS Instrument

Indicator Light

● ● ●

BLOCK A POWER BLOCK B

View of the back of the STC-96A PLUS Instrument
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2.8 Arrangement of Well Positions

2.9 Specifications of the STC-96A PLUS System
General
Dimensions (W×D×H) 386×520×250mm
Weight 18 Kg
Power Supply 230V~, 50Hz
Energy Consumption < 850VA
Noise Level < 55dB (A)
Protection Class Ⅰ

Electromagnetic Emission CLASS B
External Interface USB or RS-232

Environmental Parameters
Temperatures Allowed During Operation 10 ~ 30℃
Relative Humidity Allowed During Operation < 85%
Temperatures Allowed During Storage/Transportation -20 ~ 55℃
Relative Humidity Allowed During Storage/Transportation < 85%
Altitude above sea level < 2000 meters

Performance Specifications of the STC-96A PLUS System
Number of Samples 96 × 0.2mL

Sample Volume 15 ~ 50µL

Temperature Range 4 ~ 99℃
Accuracy of Temperature ± 0.10℃
Uniformity of Temperature ± 0.10℃
Max. Ramp Rate 4.0℃/s
Heating/cooling Method Peltier and Joule
Temperature Control Mode Tube control/Block control
Hot Lid Automatic Hot Lid
Power-off Protection Yes
Advanced Programming Yes
Segments in each Program Max. 9
Steps in each Segment Max. 9
Cycles in each Segment Max. 99
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Holding Time of each Step 00:01~ 99:59 (mm: ss)

Specifications of the Detection Unit
Dye/probe to be detected

Channel No. 1 2 3 4 5 6

Excitation Filter 470nm 530nm 585nm 630nm
Reserved Reserved

Emission Filter 510nm 565nm 620nm 665nm

Max configuration √ √ √ √ √ √

Current
Configuration

√ √ √ √ × ×

Fluorophores FAM
SYBR-Green

HEX
JOE
VIC
TET

ROX
Texas-Red

Cy5 × ×

Light Source maintenance-free LED
Crosstalk between Channels < 1.00%
Sensitivity ≥ one copy
Range of Linearity 100 ~ 1010 copies/mL
Range of Linearity | r | ≥ 0.9990
Reproducibility CV< 1.00%

Product Lifetime
Lifetime 7years
Production date Printed on namecard

The product’s lifetime is determined based on the assessment of lifetimes of its critical components.
Users shall operate, maintenance and repair it as indicated by the operator’s manual. After
maintenance and repair, products that is verified to retain expected safety and performance are
allowed to be used normally.
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Chapter 3 Instrument Installation

3.1 Transportation and Storage
The instrument must be transported in accordance with the shipping requirements in the ordering contract. Original
packaging must be used during transportation to prevent damage to the instrument.
During transportation/storage/packing, the instrument should be stored in a surrounding where the temperature arranges
from -20℃～55℃ with relative humidity below 85% and without corrosive gas.

3.2 Unpacking
The STC-96A PLUS real-time PCR instrument is packed in a cardboard box with palletized Styrofoam filled the space
between instrument and cardboard box. After unpacking please check whether the components mentioned in chapter 3.3 are
missing or damaged.

Do NOT use the instrument and contact your distributor immediately if damage is found after unpacking.

3.3 Packing List
Item Quantity
STC-96A PLUS Main Instrument 1
Power Cord 1
Communication Cable 1
USB-TO-RS232 Converter Cable 1
Sofeware Setup 1
Operator’s Manual 1
Packing List 1
Certification 1
Fuse (Ф5×20mm, 10A, 250V) 2
Blower Brush 1
Dust-Proof Cover 1
Please contact Bioperfectus authorized distributor or contact us via support@bioperfectus.com in time if any

item damaged or missing.

3.4 Installation Requirements
3.4.1 Working Environment

► The instrument must be placed on a stable horizontal workbench away from radiators or heating devices. Avoid
direct sunlight.

► Do not place the STC-96A PLUS instrument next to devices with electromagnetic interference or high inductance
(e.g., refrigerator, centrifuges or oscillators).

► Keep the STC-96A PLUS instrument at least 15cm away from surroundings objects or walls in order to ensure
ventilation and convinent access to the power switch.

The instrument should NOT be covered with anything during operation.
► Keep the instrument indoors at room temperature between 10~30℃, relative humidity below 85%.
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► To avoid electric shock, the instrument must be connected to a three-wired earthed socket which complies with
safety standards. The power supply must be 230V AC (50Hz).

Users of STC-96A PLUS system must be trained by professional technical personnel by the
manufacturer or distributor before install or use STC-96A PLUS system.

3.4.2 PC system Requirements
The computer should meet the following requirements before the STC1.0.0 software is installed:
► Recommended hardware requirements: Intel or AMD Duo Core 2.8GHz CPU, with 4G RAM; Video Memory 2G.
► Operating System: Windows XP/Vista/7/ 8/8.1, with Windows office Word/Excel 2007 or higher version installed;
► Screen Resolution: 1280*768 or higher.

3.5 Software Installation
► Remove the instrument from packaging and place instrument by following the guidelines in 3.4.1.
► Ensure the instrument is in power off state, then connect it to the power socket using the power cable in the

package.
► Insert RS232 cable (the end with a magnetic ring) to the COM1 port of instrument and tighten the screws. Connect

the other end of the RS232 cable following below instructions:
 If there is a COM port in the computer, directly insert the cable into this COM port and tighten the screws;
 If there is no COM port in the computer, connect the cable to the COM port of the USB-TO-RS232 converter

cable and tighten the screws. Note that do NOT insert the converter’s USB port to the computer at this
moment!

► Insert the installation CD into the CD-ROM. Please wait for a moment, then following window will pop up
automatically (Fig 3- 1).

Fig 3- 1
► Click Install STC 1.0.0 and you will see the installation wizard of the program. Click “Next” (Fig 3- 2).

Fig 3- 2
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► Follow the wizard instructions to install software.The specific installation steps are (Fig 3- 3):

A B

C D
Fig 3- 3

► If a USB-TO-RS232 converter cable is needed, click “Install USB Driver” menu on the Autorun screen and follow
the instructions of the installation wizard(Fig 3- 4). Do not connect the USB cable to your PC before installing
USB converter driver. Connect the USB cable to the computer when you get the following hint(Fig 3- 4 B)..

A

B

C
Fig 3- 4

► Remove the installation CD and switch on the instrument. Perform system checking before start using the instrument.
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3.6 System Checking
Please complete following steps to check if the program is installed successfully.
► Switch on the instrument power;
► Push the slider of Block A open and put four empty 0.2mL PCR tubes into well A1, A6, H1 and H6. Close the slider; Push

the blue slider of Block B open and put four empty PCR tubes into wells A7, A12, H7 and H12. Close the slider;

► Open the STC1.0.0 interface. Click the template file “Check” at the top left area of the Experiment Home screen;
► Select Run tab and click Start button in the top right of the screen to start the experiment.
Once the program has started, please carefully observe the experimental process and check the following points:
► The hot lid can be closed successfully.
► The block temperature increases or decreases successfully. Check whether the real-time temperature shown on the

screen is the same as the target temperature;
► Fluorescence detection can be carried out and fluorescence value can be real time displayed on the screen.
► If the check experiment can finish normally, it indicates that the system is installed successfully

If the instrument can NOT start or errors occur during running, please power off the instrument and contact
manufacturer or your distributor immediately!

3.7 Reagent Requirements
If the instrument is used for in vitro clinical diagnosis of diseases, only reagents with a product registration license, a
product permission license and a product certificate issued by national Bureau of Drugs Supervision can be used. Do not
use reagents past their expiry date as detection accuracy may not be ensured.

3.8 Quality Control in STC-96A PLUS System
In order to ensure the detection accuracy of the STC-96A PLUS System, the following points should be complied with:
► In quantitative experiment, standard, negative and positive control samples should be contained in order to monitor

experiment reliability and instrument performance.
► Quality controls samples from the relevant authority should be purchased regularly to the verify performance of

reagents and instrument.
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3.9 Workflow

Create Experiment

Open Instrument

Open Experiment Wizard

Setup Instrument

Define Wells

Input Sample Info

Start the Experiment

Monitor Run

Analyze Data

Print Result

Import

Template

Create Project

Open Project Wizard

Select Project Type

Define Targets

Define Thermal Program

Setup Parameters

Create Rules

Save&Close Project

Sample

Prepare Specimen

Prepare Reagents

Load Plate
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Chapter 4 Experiment

The STC 1.0.0 Program of STC-96A PLUS Real-time PCR System is composed of three functional modules: Experiment,
Project and Tools. This chapter explains the main functions of Experiment. The Experiment is composed of the Home
screen and the Experiment Wizard. Home provides quick access to creating and opening experiments while the Experiment
Wizard gives users a procedural guide to configuring, running and analyzing experiments. Prior to starting operation, please
review the chapter to become familiar with the software. The contents of this chapter are as follows:

► Experiment Home;
► Introduction to Experiment Wizard;
► How to create and run an experiment;
► How to view and analyze an experiment;
► QuickStart Experiment from template;
► Data printing/exporting.

4.1 Experiment Home

Double-click the STC 1.0.0 software icon on the desktop to open the software, or click “Start”> Programs> STC

Real-time PCR System 1.0.0> STC 1.0.0 to enter the home screen of STC 1.0.0. The home screen of STC 1.0.0 Program is
composed of three tabs: Experiment, Project and Tools. Click “Experiment” to the Experiment Home screen (Fig 4- 1).

Fig 4- 1

Experiment Home provides multiple shortcuts to creating or analyzing experiments, as described below:
► Experiment Wizard: Create a new experiment by following the Experiment Wizard.
► Latest Experiment: Create a new experiment with settings and plate from the latest experiment.
► Import Plate Layout: Run an experiment by importing an experiment configuration file in format of csv.
► Open Experiement: Open an experiment file for analysis.

Module Tab QuickStart

Recent Experiments

Run Experiments

Analyze Experiment Task Bar
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► QuickStart from Template: Click a template button to immediately begin an experiment.
► Open Recent Experiments: The list shows experiments that are opened or run recently. Click a file name to

open it.

Right click an experiment to open the folder of the specified file, or delete the file from the list, or clear the
current list.

► Task bar: Display opened or running experiments and Experiment Home. Users can open up to 10 files
(including currently running files) at the same time. Click the tab of experiment name to open it. Click icon

to close the current file; Click icon to switch to Experiment Home, which is always shown in the
bottom left of the task bar

4.2 Introduction to Experiment Wizard
This section describes the interface of Experiment Wizard and its working process, and the basic functions of the Well
Selector and the Well Information Table, which are key elements of the Experiment Wizard. Prior to creating an experiment,
users should read this section carefully to learn the basic operations.

4.2.1 Overview of Experiment Wizard
The interface of the Experiment Home provides multiple shortcuts to the Experiment Wizard--users can access the
Experiment Wizard by either click the “Experiment Wizard” button or the “Open Experiment” button and choose a file.
In a process-oriented manner, the Experiment Wizard guide users through the experiment settings, running, and analysis. In
its interface (Fig 4- 2), you can find the experiment process tabs on the left side, with menu commands available for the
current process on the top. The available functionalities the current process can be found in the middle of the screen. The
menus and functional areas vary with different experiment applications. Below is the experimental analysis tab for the
absolute quantitative experiment.

Click the icon to the right of the menu bar to hide the menu text. While the menu text is hidden, the dropdown
menu will also be hidden.

Fig 4- 2

The table below explains the main functions of tabs of the experiment process.

Module Tab Menu Bar

Functional AreaExperiment Process Tab Task bar
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Experiment Process Work Content Reference

Setup
To show instrument information; edit or display basic information of the
experiments and instrument settings.

4.3.2

Plate
Edit and view reaction well information, including importing projects
and defining well property.

4.3.3

Sample To enter information of the sample, including descriptions of the patient. 4.3.4

Run (before/during
running)

Start the Experiment and monitor real-time data. 4.3.5

Run (after running) Displaying the Temperature Curve and Running Information. 4.4

Analysis Displaying and analyzing the experiment data. 4.4

4.2.2 Working with Well Selector
Well Selector (Fig 4- 3) is a virtual well plate at the bottom of the screens of Plate and Analysis tab. It is used for selecting,
editing and displaying samples. A 12*8 table is displayed in the Well Selector, the location of each cell corresponding to
each well of the reaction blocks in the STC Real-TimePCR instrument. For STC-96A Plus, cells from Column1 to Column
6 represent Block A while and the rest correspond to Block B. The colored well in the Well Selector indicates that there are
samples in the well. Different colors indicate different sample types of which the legends are shown below the well plate.

Fig 4- 3

4.2.2.1 Selecting Well
► Click a well to select it; press the Ctrl key and click a selected well to deselect it. The selected well is colored

grey in its background, while its detailed information is displayed in the well information table and related curve
plots. Please refer to 4.4 for more information.

► After selecting a well, press the Shift key and hold on while clicking another well, then you will select the
continuum between two wells.

► Press the Ctrl key and hold on while clicking multiple wells to select some discrete wells.
► Click the blank area on the top left side of the Well Selector to select all wells.
► Press arrow keys to navigate through the wells.

4.2.2.2 Selecting Sample
► In single-tube experiments, each sample corresponds to a test tube; selecting a well equals selecting a sample.
► In multiple-tube experiments, each sample corresponds to 2 or more test tubes. You can select a well or a sample

as follows:
 To select a sample: Click a well, then you will select a set of wells originated from a sample;
 To select a well: Press <Ctrl> on the keyboard and hold on while clicking one well to select a single well.

If you want to customize preferecne of well selection, please go to Tool > Well Selector Option.
For more information on single-tube or multi-tube experiment, please refer to 5.2.

4.2.2.3 Functions of the Well Selector
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► Change information to display on the well plate: As a default, the project name is displayed on the well plate.
Users can change the information display on the well plate. Right-click the Well Selector, select the menu of
Well Display, and you can choose to display the project name, patient name (Fig 4- 4), label,tube name or
sample name. Users can also open the menu of Preferences and change theWell Display in theWell Selector
Options.

Fig 4- 4

► Hide Well Selector: Right click the Well Inforamtion Table and deselect Show Well Selector.
► Save Well Selector as picture: Right click the Well Selector and select command Save Image as to save the

Well selctor as a picture.
► Omit wells:When there are abnormal data in samples, the program will automatically mark abnormal wells

(such as standards failed to be amplificated) as omitted wells. These omitted wells are marked by white

crosses , while their data are not displayed in Well InformationTable and on the corresponding charts. If
you want to omit wells manually, right-click well selector and select menu Omit Wells to tag the currently
selected wells as omitted wells. Deselect Omit Wells to remove the marks.

► Change trace stytles for selected wells: Select multiple wells in the well selector and mark the curves of
selected wells. For a detailed description, please refer to Curve Styles on Page 20.

4.2.3 Working with Well Information Table
In the screen of Analysis of Experiment, the detailed information of selected samples in the Well Selector is displayed in the
Well Information Table above (Fig 4- 5), including well No., target name, calculation results, and patient information. Users
can make further selection of samples in the Well Information Table. The selected wells are of grey background, while their
curves are displayed on the corresponding charts.

Fig 4- 5

4.2.3.1 Display and Selection
► Hiding/Displaying table columns: Click the Table menu to open the Field Settings dialog box (Fig 4- 6). If

you want to display a column, tick the field; to hide a column, uncheck this field.
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Fig 4- 6

► Modify the order of the columns in the table: If you need to adjust the location of a column in the Well
Information Table, select it in above table and click Move Up or Move Down button.

► Display of Multi-tube Samples: By default, multi-tube samples are separated by dividing lines in
between; if you want to hide the dividing line, go to Preferences in the menu and deselect “Show Sample
Dividing Lines."

► Data Selection: the default data selection is seleting samples. If you want to change the way to select data,
“Data Selection Mode” in the right-click command (or menu Preferences > Well Information Table
Options > Data Selection Mode) provides 4 modes of data selection:
 Target: Click on a cell to select the row that contains the cell. In this way, you can select a single target;
 Well: Click on a cell to select its corresponding well;
 Sample: Click on a cell to select its corresponding sample; if the sample is single-tube, one single well is

selected; if the sample is multi-tube, then multiple wells of a set of samples are selected.
 Cell: Click to select a cell.

4.2.3.2 Filtering and Sorting
► Sample Sorting: By default, the samples in the table are sorted in a top-down mode in the Well Selector

(vertical, A1,B1,...,G1,H1). You can also click on the icon on the column heading of the well to sort data in
the following modes:
 Horizontal: Samples are arranged from left to right, that is, A1,A2,A3 ... ;
 Horizontal and Block A Priority (only for STC-96A Plus/STC-96A): Samples are arranged from left to

right, starting from Block A to Block B, that is, A1,….,A6, B1, …H6, A7, A8…H12;
► Column Sorting: Click on the icon on the column heading (except the column of Well) and select

Ascending (Fig 4- 7), then the data is sorted in ascending order and he sorting icon appears on the column
heading; Click Descending to display the data in descending order; if you want to cancel the sorting, click the
right-click command Clear Sorting.

Fig 4- 7

► Filtering: Click on the icon on the heading of a column, you may filter data by selecting data from the data
list (Fig 4- 8). Click on Custom Filtering to perform advanced filtering on this column (Fig 4- 8).



Version 1.7

20

Fig 4- 8

► Multiple Sorting: Right-click in the area of Well Information Table, selectMultiple Sorting… command, and
the following dialog box appears (Fig 4- 9). You can perform multiple sorts of data on this screen. For example,
if you want to sort Ct values of different targets from different projects in ascending order, select “Project",
“Target” and "Ct” in the “Sort By", “ Then By” and “ Then By,” respectively.

Fig 4- 9

► Clear Sorting and Filtering: Use right-click command Clear Sorting & Filter to clear all sorting and fliter
criteria.

4.2.3.3 Printing or exporting result data
Right-clicking in the area of Well Information Table (Fig 4- 10), you may use the following commnds to get convenience in
data processing:

► Copy Selected Data to Clipboard: Copy Selected Data to Clipboard.
► Export Selected Data: Export Selected Data to Excel.
► Print Selected Data: Print Selected Data.

If you wan to copy or export specific data of the table, select right-click menu Data Selection Mode > cell, then
you are free to select whatever data and export or copy them to the Clipboard.

Fig 4- 10

4.2.4 Working with Chart
Curve charts are displayed on the right side of the Analysis tab in the experiment Wizard; they may vary with different
modes of analysis. The following is the main features of the curve charts; for more information, please refer to Chapter 7
Software Application.
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4.2.4.1 Viewing Curve Charts
Hover your mouse over a curve; then it will be bolded in black and a message box showing the detailed information of the
curve appears; meanwhile, all related information in the screen will be highlighted (Fig 4- 11).

To close the message box, click on Preferences menu and then uncheck “Show details when hovering over
curves” in Chart Options.

Fig 4- 11

► Adjust the maximum value of Y-axis: Dy default, the maximun of Y-axis of a curve chart is fixed, showing the
maximun value of all data. If you want to change the default setting, go to Preferences menu > Chart Options >
Y-Axis Scaling auto-adjust by:

Options Descriptions

All curves
The Maximum value of Y-axis is the maiximun value of all curves in
the Well Selector.

Selected Channels Maximum Y varies with selected channels.

Selected Projects Maximum Y varies with selected projects.

Selected Wells Maximum Y varies with selected wells

► Zoom In/Out: Select Zoom in the right-click menu. In the pop-up window (Fig 4- 12), input the maximum and
minimum values of X Axis and Y Axis. Click Apply and close the window. If you need to restore the scales, click the
Default button or in the right-click context menu, click “Set Scale to Default” command.

Fig 4- 12

► Enlarge a portion of a chart: If you want to view details of a specific area in a chart, place the cursor above and to
the left of the chart area you want to enlarge; then click and drag the mouse down and to the right (Fig 4- 13); the
region within the rectangle that you draged will be automatically zoomed in. To restore the chart to its original size,
click and drag the mouse up and to the left.
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Fig 4- 13

4.2.4.2 Change Curve Styles
Users can customize colors of curves and change styles of curves by adding tags to curves. If you need to modify the style
of a curve, hover the cursor over the curve (when the curve turns black and bold); choose “Trace Styles” in the right-click
menu. In the following dialog box, modify the color of the curve or add tags (Fig 4- 14).

Fig 4- 14

If you want to change the styles of multiple wells at one time, first select wells to be changed in the Well Selector, then
right-click in the area of the Well Selector and select “Curve Style” command to open the following screen (Fig 4- 15), you
can change the curve stytles for all selected wells or a certain target of the selected well(s).

Fig 4- 15

4.2.4.3 Copy and Export
► Save a Chart Image: In the right-click menu, click “Save Image As..." to save the current chart as a picture.
► Copy a Chart Image: In the right-click menu, click “Copy to Clipboard" to copy the current chart to the clipboard.
► Print: In the right-click menu, click “Print...” to print the current chart image.
► Export Curve Data: Select “Export Curve…" in the right-click menu to export data of all curves on the chart to

Excel files.
► Copy Data of Selected Curve: Hover the cursor over a curve; then the curve is bolden in black. In the right-click

menu, click “Copy Selected Data to Clipboard...” to save the data of the curve to the Clipboard.

4.3 How to Create and Run an Experiment
This section describes how to use the STC1.0.0 software to create and run an experiment, as well as the detailed features on
all interfaces. For different experiments, menu options displayed may vary. For more information, please refer to Chapter 7
Software Application.
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4.3.1 Create a New Experiment
❶ Connect the USB Converter cable or the RS-232 serial cable to the computer, and power on the instrument.

The STC1.0.0 software is capable of controlling multiple STC Real-TimePCR systems (including
STC-96A, STC-96A PLUS and STC-48A) simultaneously.
For more information on how to connect the instrument to the computer, please refer to 3.5 Software
Installation.

❷ Double-click the software icon on the desktop to run the software, or click Start > Programs> STC

Real-TimePCR System 1.0.0 to open the software. Click on the Experiment tab at the top of the screen to enter
the maincreen of Experimental Home (Fig 4- 16).

Fig 4- 16

❸ To create a new experiment, click Experiment Wizard button on the left of the Experimental Home screen:
► If there is a single instrument connected to the computer, you will direcly enter the experiment wizard

where the model and serial number of this instrument are displayed in the Instrument area (Fig 4- 17).

Fig 4- 17

► If there are two or more instruments connected to your computer, the following dialog box (Fig 4- 18) pops
up after clicking. Select an instrument to be used from the list, click Confirm button to enter the interface
of experiment wizard.

STC-96A PLUS
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Fig 4- 18

► If no instrument is currently connected to your computer, the following pop-up box (Fig 4- 19) appears
after clicking. You can reconnect the instrument, or click Virtual Mode to enter the virtual mode in which
you can setup an experiment rather than run it.

Fig 4- 19

For more information on creating an experiment, please refer to 4.2.1 Screen of Experiment Wizard.

4.3.2 Define Experiment Properties

Fig 4- 20

❶ Click the Setup tab (Fig 4- 20) and enter the general information in the Experiment Information area:
► In the field of Experiment Name, enter the name of the experiment. The length of experiment name

should range from 1 to 50 characters. The default name is the time of creating the new experiment (format:
YYYY-MM-DD_HH-MM-SS).

► Select the type of experiment in the Experiment Type drop-down list.
► (Optional) You can modify the path in which the file is saved in the “Save Path” field; if you do not

modify the path, the files are saved by default to the Experiment folder in the software installation directory
folder.

► (Optional) if necessary, input information of the operator, the auditor and notes.

❷ In the area of Select Reaction Blocks, select bolck(s) according to your sample quantity. To STC-96A PLUS
isntruments, there are two independently reaction blocks, Block A and Block B.

STC-96A PLUS

STC-96A PLUS

STC-96A PLUS

STC-96A PLUS

STC-96A PLUS
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❸ Select “Use Hot-lid” in the area of Hot-lid Mode. Using hot-lid means that during the experiment the
temperature of the hot-lid will be kept at 105℃, which prevent reagents from evaporating.

If hot lid is not used, olefin oil must be added to prevent reagents from evaporating and condensing,
which may lead to erroneous results.

❹ Choose the temperature control mode in the “Temperature Control Mode” area. By default, Block Control is
recommended.
► Block control means that the holding time of the thermal program does not start to count-down until the

temperature in the reaction block reaches the target temperature.
► Tube control means that the holding time of the PCR thermal program does not start to count-down until

the average temperature of solution in a tube reaches the target temperature. Tube Control is more accurate
than Block Control, but takes more time to complete the experiment.

❺ In Channel Scanning Mode area, select proper scanning mode. By default, Scan All Channels is
recommmended.
► Scan Selected Channels means that the optical system only scans the channels which are used in the

projects. For example, if FAM, VIC and HEX channels are used in a project, the instrument only scans
these three channels.

► Scan All Channels means that the optical system scans all channels (4 channels in all) during the
experiment.

If you select “Scan Selected Channels” and want to add a new project during the experiment, when
the number of channels exceeds that of the first project, then data of the newly added channel is not
recorded. Therefore “Scan All Channels” is recommmended if the reagent is not sensitive to
fluorescence exposure.

For information on project and channel, please refer to 5.2 Create Project .

4.3.3 Setup Well
❶ Click Plate tab to enter the screen for well defining (Fig 4- 21). Choose wells to be edited in theWell Selector.

In case of multi-tube samples, the number of wells you need to select should be at least greater than the well
numbers of a sample.

For more information of the basic operation of the Well Selector, please refer to 4.2.2 Working with Well
Selector.

Fig 4- 21

❷ Select an appropriate project from the project list in the top right of the screen. All project files previously saved
by users in the software are displayed in the project list. Move the cursor to the project name for a preview of the
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thermal program information of the project; click on the icon of the project name to view the details for that
project.

If you cannot find the project file in the project list, you need to create a project file or contact the
reagent manufacturer. Please refer to 5.2 Create Project.
You can run multiple projects in one single experiment. After you select a project from the project list,
project files with the same thermal program as is used in the selected project are still be availble to be
used (Fig 4- 22); while projects of different thermal program are dimmed (unavailable).

Fig 4- 22

❸ Edit the sample type and property in Step 3: Defining Well (Fig 4- 23). By default, the type of the selected wells
is Unknown. If necessary, change the type by clicking the Sample Type drop-down menu.

Fig 4- 23

If necessary, enter information of samples in the Property field. You may edit property for each target
separately in the target table.
► If you need to define replicates, select the Set Replicates check-box and enter a number in Replicate ID

field. The software will perform statistical analyses of SD and CV of those replicates.
► To clear wells, select them and click Delete button, or use right-clicking command Delete Sample.

Sample types and property may vary in different experiment modes. For more information, please refer to
Chapter 7: Software Application.

❹ When you finish well editing, the detailed information of wells is displayed in the top left table of the screen.

Well editing can be done before, during or after an experiment is completed. Once users re-edit well
settings, re-analyze the experiment to generated new result.

4.3.4 Enter Sample Information
❶ Click Sample tab to go to the screen for sample editing (Fig 4- 24). This screen displays all “Unknown” samples

and you can input detailed information for each sample. Click Import menu to import patient information from
external CSV file.
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Fig 4- 24

Click “Table Mode”, “Unknown” samples are listed in a table.
► Click on a cell and enter information, then press the Enter key to confirm and move to the next cell or bring

up a drop-down menu; press the Tab key to move the cursor.
► Copy/Paste: Select a cell, right click and select Copy; then select another cell and right click to choose

“Paste.”
► Use right-click command Delete or Delete button in the menu bar to clear the conten of selected cells.

Patient information of samples can be edit before, during or after an experiment is completed.
❷ The label is used to as a unique mark for the sample in linking to the LIS system. Click Label button on the

menu bar, choose the appropriate range from the drop-down menu of Sample Range, and enter the appropriate
value.

Sample Range Descriptions

All Samples Create lables for all samples

Selected Samples Create lables for selected samples (you need to select specific samples in
the screen in advance).

Project Name Create lables for all samples originated from your selected project.

For example, mark all of the samples of “Shuiyuan” in the order of “20150526-01; 20150526-02;
20150526-03......".

Fig 4- 25

► Select “Shuiyuan” from the drop-down list of Sample Range.
► Enter “20150526-” in the Lable Prefix field.
► Enter “1” in the Initial Value box, “1” in the Interval box and “2” in the Digit box (Fig 4- 25).

❸ If the column of the table does not meet your needs, you can customize new columns by the Table menu (Fig 4-
26).
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Fig 4- 26

For example, if you want to add a new column “Sample Status”, its drop-down list should display “Normal” and
“Jaundice”
► Click the Table menu to open the Field Settings dialog box, then click “New Field“ button at the bottom

of the screen to creacte a new field “Column”
► In the Field Name on the right, enter “Sample State”;
► In the drop-down list of Field Type, select “List";
► Click New Content button and enter “Normal” in its popup screen (Fig 4- 27). Click Confirm. Similarly,

add another default value of “jaundice.”
► In the Select Fields list, select the “Sample Status” field to add it to the Sample table.

Fig 4- 27

4.3.5 Run an Experiment

Fig 4- 28

❶ Click Run tab to enter the Run screen (Fig 4- 28), on which such information as test samples and projects is
displayed. Place sample tubes in the reaction block of the instrument according to the sequence of the Well

Selector. Click the button to run the experiment.
For experiments created in the virtual mode, the Start button is disabled and the experiment cannot be
started.
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❷ Monitor Running: The real time temperature curve and operation status are displayed on the top right of the
experiment Run screen (Fig 4- 29) while the real-time curve is shown at the bottom right.

Fig 4- 29

In case of errors that abort the experiment (such as power cuts), when the program is restarted, a dialog
box will pop up to ask if you will continue run from where it aborted. If you choose to continue, the
aborted experimental data will be resumed and continued. This may lead to unsatisfactory results.

❸ If you need to modify the thermal program during, right-click in the Thermal Program area on the top right of the
screen. Click Add Cycles for current Segment to increase the number of cycles of the current segment; click
“Delete Current Segment" to skip the current segment into the next segment (Fig 4- 30).

Fig 4- 30

❹ When the experiment is finished, the reaction module is cooled and the hot lid is opened automatically. The
software will automatically save results and redirect to the Analysis tab.

Users are allowed to customize wait time for the hot lid to open. Click the Tools tab > Software Option.
Modify the wait time in the Hot-lid setting of the Others section.

4.4 View and analyze an experiment
❶ Click Open Experiments button in the Experiment Home screen or click the Open button in the menu bar in

the Experiment Wizard. In the pop-up window, choose an experiment file and open it.

❷ You can switch between tabs of the Experiment Wizard to view or edit information of the experiment:
► Setup: View the serial number and settings of the instrument; modify the file name or saving path.
► Plate: To view or re-edit the reaction well.
► Sample: To view or re-edit the patient information of samples.
► Run: View the running information, the temperature curve and the time when the experiment

starts/completes at.
► Analysis: View results data, modify parameters, export data, and so on.

For more information about the Experiment Wizard Options tab, please refer to 4.3 How to Create and
Run an Experiment.

❸ Click Analysis tab to enter the Analysis screen (Fig 4- 31). On the left side of the Analysis screen there are the
Well Information Table, Analyze Parameters Table and Well Selector; on the right there are experiment curves
that vary according to different types of analysis.
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Fig 4- 31

Viewing the experiment data
► Select a sample in the Well Selector; then its details are displayed in the Well Information Table at the top while the

curves of the well are shown in curve graphs on the right.
► Hover the mouse over the data in the screen; then all the information associated with the data are displayed together

(data in Well Selector or Well Information table are displayed in bold while the curve is displayed in black bold) (Fig
4- 32). If you need to close this function, click on the Preferences menu, and in the Others area of the pop-up screen,
uncheck High-light Related Information on Hover.

Fig 4- 32

► For multiple-channel experiments, click the Channels buttons to show the data of specific
channels;
If you want to change the way of channel selection, click Preferences menu and change Channel Selection in the
area of Others. “Press Ctrl+Channel button to Select Multi-channels” means that when pressing the channel
button, you only select the data of the current channel; if you want to select multiple channels simultaneously, hold on
the CTRL key and click on multiple channel buttons; “Press Channel button to Select/Deselect” means that you
press the channel button to select it and click again to deselect it.

► To zoom in/out table or graphs, Click and buttons or drag their borders;

For more information of the functions of the Well Information Table and the Well Selector, please refer to 4.2.2 Well
Selector and 4.2.3 Well Information Table.

Adjusting Analyze Parameters
The instrument collects real-time fluorescence data during the experiment; when the experiment is over, the software
automatically processes raw data in accordance with the analysis parameters of the project.
► The most frequently used analysis parameters of the current experiment is displayed in the analysis parameter table

(Fig 4- 33), which is below the Sample Information Table. You can modify the analysis parameters here and click the

Analyze button to reanalyze data.
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Fig 4- 33

► Click the Analysis Parameters memu in the drop-down menu of Analysis to view all the analysis parameters. After
modifying the parameters, click Analyze button to update the results.

To hide the analysis parameters, please click icon.

For more information on analysis parameters of different types of projects, please refer to Chapter 7 Software
Application.

4.5 Experiment Template
An experiment template is pre-stored file containing all settings information such as experiment information, well setting,
and analysis parameters. On the top right of the Experiment Home screen is (Fig 4- 34) the list of experiment templates.
Click a template to enter the Run screen; then press Start button to start the experiment.

Fig 4- 34

4.5.1 Template Manager
In the area of experiment template, right-click and then select Template Manager to enter the following screen (Fig 4- 35).

Fig 4- 35

► Import: Import experiment template fies to the software.
► Export: Save the selected experiment template to another directory.
► Rename: Rename selected template file.
► Delete: Delete selected template fle.
► Display/Hide: select the checkbox at the bottom right of a template to make it appear on the Experiment Home

screen.To hide a template, right-click on it and select Remove from List Command.

4.5.2 Create Experiment Tempate
In the Experiment Wizard screen, click Template in the Export menu to open the following screen (Fig 4- 36). Enter the
file name; if necessary, enter full name and comments. Press Confirm.
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Fig 4- 36
4.6 Export
4.6.1 Export Experiment Data
Click Data in the menu bar to export data of this experiment (Fig 4- 37). Data can be saved in formats of XLSX, CSV or
TXT.

Fig 4- 37

The table below displays the data to be exported. The available data may vary with different types of analyses.

Export: Descriptions

General information Experiment Name and time, Auditor/Operator/Comments, Instrument Setup.

Well Information Table All information of the Well Information Table

Amplifiction Curve Amplifiction Curve of all samples

Raw Amplification Curve Raw Curves of all samples

4.6.2 Export RDML
Click the drop-menu of Export and select Export RDML to export RDML file.

4.7 Print
4.7.1 Print Patient Report
Select sample to print from the Well Selector and then click the Report menu to open the following screen (Fig 4- 38).
Click Print to print all reports; click Print Current to print the report in preview; click Previous / Next to view the reports.

You can only print patient reports of wells with the sample types of “unknown” or “Retested”.
To learn how to customize the patient report template, please refer to Appendix I Patient Report Template.
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Fig 4- 38

4.7.2 Print Experiment Tale
Click the Table menu in the Print menu group to print the Well Information Table (Fig 4- 39).

Fig 4- 39

To set the margins, click menu File>Page Setup (Fig 4- 40).

Fig 4- 40
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Chapter 5 Project
A project is a unique profile of STC Real-TimePCR System, containing experiment type, channel information, PCR profile,
analysis parameter, rules of judgment of results, etc. Usually a project is based on an experiment protocol, it provide a
convenient and quick access to set experiments. Users can create or edit projects according to the experiment protocol, or
contact the reagent manufacturer to acquire project files. The contents of this chapter are as follows:

► Project Manager
► Creating a New Project

5.1 Project Manager

Double-click the STC1.0.0 software icon on the desktop, or click Start> Programs> STC Real-TimePCR System

1.0.0 to enter the software. Click the Project tab in the module bar to enter the Project Manager (Fig 5- 1). The Project

Manager is used to manage all project files saved in the software, including view, editing, copy or import/eport. The screen

of Project Manager contains the following information:

Fig 5- 1

► Project Buttons on the left of the project Manager:
 Creating Project: Open the project wizard to create a New Project.
 Import: Import a project file to the project manager.
 Export: Export the project files in the project manager to other directory. In the Export screen (Fig 5- 2), select the

project(s) to export and the saving path; and then click Export button to export them. Click Export All to export all
projects in the list.

Project ListModule Tab

Project Buttons Preview Project
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Fig 5- 2

► On the right upper side of the project mager screen, all project files classified by experiment types are listed here.
Click a project for a preview of the detailed information at the bottom right of the screen. The buttons on the right are:
 Edit: Edit the selected project file.
 Copy: Copy the selected project file.
 Paste: Paste the copied project.
 Rename: Rename the selected project in the pop-up screen.
 Delete: Delete the selected project file.

5.2 Create Project
❶ Click Create button on the left of the Project Manager screen to open the project wizard (Fig 5- 3).

Fig 5- 3

While the experiment is running, you cannot edit the Project being used by the experiment.

❷ Click the General tab on the left and enter the general information for your project in the screen:
► Project Name: Enter a project name. The string length of the name ranges from 1 to 50.
► Project Type: Select the type of project in the Project Type drop-down list.
► Reaction Volume: Enter the reagent volume. The allowable reaction volume is 15~50μL.
► (Optional) Comments：Input note information for your project if necessary.
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❸ Input target information in Target Information area. A target is a nucleic acid sequence that you want to
amplify and detect. It is identified with a probe labeled with specific fluoesence dye. Probes/dyes that are
supported by the instrument are listed in the following table.

Channel Excitation-emission wavelength Fluorophores

Channel 1 470nm-510nm FAM, SYBR-Green

Channel 2 530nm-565nm HEX, JOE, VIC, TET

Channel 3 585nm-620nm ROX, Texas-Red

Channel 4 630nm-665nm CY5

In terms of the quantity of targets, samples can be divided into single-tube and multi-tube samples. The
Single-tube samples refer to those samples, with fewer nucleic acid sequences to be detected (for example, 1 or 2
targets), which can be measured in one reaction system (one PCR test tubes). During the development of the
real-time PCR technology, more and more complicated experiments have more than 10 target genes to be
detected. However, given the limitation of the dye spectrum, there is a limitation of detection channels in the
real-time PCR instrument. In this situation, users have to put one sample into several tubes and detect them
simultaneously, which is called multi-tube samples, for example, the 13 high-risk types of human papillomavirus
(HPV).

Define targets of a single-tube sample
► Accoding to your kit protocol, determine the appropriate channels by selecting the checkbox below

channels.
► Enter target names. Please note that a target name must be exclusive. Click color-box and select a colour

for this target.
► (Optional) If you need to modify the information of dyes, click the fileds of Fluorophores/Dyes, and then

select dye names in the drop-down menu or enter names of dyes.

Define targets for a multi-tube sample
► According to your kit instructions, enter tube number in the Tube Couts per Sample; then new tubes

“Tube 2”, “Tube 3”… are added. Change the tube names if necessary;
► Setup the tube order by checking the radio buttons of Tube Order. There are two sequences of

arrangement of multi-tube samples;
 Horizontal: Tubes of one sample are arranged from left to right in the Well Selector;
 Vertical: Tubes of one sample are arranged from up to down in the Well Selector;

► Check the right detection channels and enter target names. If there is no target to be detected in one
channel of a certain tube, click its field to open the drop-down menu and selected “N/A”.

There should be at least one target for each detection channel.

❹ Click on the Program tab to go to the thermal program screen (Fig 5- 4). A PCR thermal Program usually
contains 2 to 3 segments, each containing several steps, and sometimes with a Melting Curve.
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Fig 5- 4

The basic items of a thermal program are listed in the following table.

Item Descriptions Valid values

Segment
Temperature cycles composed of 1 or more
steps.

1-9

Cycle
The number of times that the current segment
is to be repeated.

1-99

Step Contains target temperature and holding time. 1-99

Target
Temperature

The target temperature, including denaturation
temperature, annealing temperature or
extension temperature in PCR amplification.

4℃ - 99℃

Holding Time

Holding time, the length of time the
temperature is maintained when the
temperature in the block or tube reaches the set
temperature.

00:01 - 99:59

Fluorescence
detection

Detect the fluorescence signal in the step.
Only one step can
be set in a segment

Melting Curve
Segment

The process of temperaure rising slowly from
one temperature to another. During the whole
process fluorescence signals are detected.

1

Edit a Thermal Program
► Insert Segment: Click on Insert Segment menu to add one segment at the end of the currently selected

segment (marked in red). In the drop-down menu of Insert Segment, you can choose to insert the new
segment before or after the currently selected segment or even at the end of all segments. You can also
insert segments through the right-click command Insert Segment.

If you need to modify the name of a segment, double click the name field and enter a new name.

► Modify Cycles: Click on the Cycle box below the segment and enter the number of cycles.
► Insert Step: Select a step in a segment, and then click Insert Step menu to insert a new step after the

currently selected step. In the drop-down menu of Insert Step, you can choose to insert the new step before
or after the currently selected step or even at the end of the current segment. You can also insert steps
through the right-click command Insert Step.

If you need to modify a step name, double click the name and edit it.
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► Modify Target Temperature: Click on the temperature box and enter a temperature, or drag the
blue line below the temperature box to change temperature.

► Modify Holding Time: Click on the time box and enter the time;

► Set Fluorescence detection: If you need a step for the detection of fluorescence, click the box and

then the icon turns blue , showing that “acquisition” of fluorescence will be performed at the current

step. A common thermal program is shown below (Fig 5- 5).

In a segment, only one step can be set for “acquisition” of fluorescence. A step with the holding time
of less than 15 seconds does not support the acquisition of fluorescence.

Right click the thermal program; select “Save as Figure” to save the current program as a picture.

Fig 5- 5

Advanced Program
The Advanced Program function is used to set the TouchDown PCR or control the heating and cooling rate of the
instrument. Select a step and click Advanced Programming menu to open the following screen (Fig 5- 6).

Fig 5- 6

► Set TouchDown PCR: TouchDown PCR can increase the amplification specificity by gradually reduce the
annealing temperature. Select the TouchDown PCR Setting box and enter the appropriate number of starting
cycles as well as values of temperature/time variation.
 Starting Cycle: The starting cycle is used to determine in which cycle the TouchDown is to be

performed. The starting cycle should not exceed the number of cycles of the current segment.
 Time Variation: From the Starting Cycle, increase or decrease the holdin time in every cycle.
 Temperature Variation: From the Starting Cycle, increase or decrease the target temperature in every

cycle.
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When setup TouchDown PCR, make sure that temperature and time values must be within a
reasonable range (the temperature ranges from 4 to 99℃, while time ranges from 00:01 to 99:59).

► Ramp Rate: It means the rate at which the instrument heats up or cools down to the target temperature. Select
Ramp Rate box and enter an appropriate value. The range of ramp rate is 0.1~4.0℃/second.

The example demonstrates how to edit a thermal program, which is shown below:

Segment Temperature Time Cycle

Segment 1
50℃ 2min 1

95℃ 10 min

Segment 2

95℃ 15s 10

65℃~56℃, dropping by 1℃
during each cycle.

15s

76℃ 20s

Segment 3

95℃ 15s 40

55℃ acquisition of fluorescence 30s

76℃ 20s

► Click on the Program tab, the default segment is shown as follows (Fig 5- 7); Click the Time box of

Segment 1- Step 2, and change Time value to “10:00”;

Fig 5- 7

► Click to select Segment 1, which turns red; click Insert Segment menu and you will find that Segment 2 is
added after Segment 1. Click on the Cycle box at the bottom and enter "10" (Fig 5- 8 left). Click to select
Segment 2-Step 1, then click Insert Step twice, and you will find 2 new steps (Fig 5- 8 right);

Fig 5- 8
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► Click the Time box of Segment 2-Step 1 to enter “15”s; click the Temperature box and Time box of Segment
2-Step 2 and input “65” and “00:15” respectively; similarly, click Segment 2-Step 3 and input the
Temperature values of “76” and “00:20”;

► Click on Segment 2-Step 2, and click the menu Advanced Program. Check TouchDown PCR Setting; enter

“1” in the Starting Cycle box, select in the Temperature Variation box and enter “1”. Press Confirm

button and the screen is shown as follows (Fig 5- 9).

Fig 5- 9

► Select Segment 3- Step 1 and click Insert Step menu. In the newly added Step 2, input Temperature value

“55” and Time value “00:30.” Click to change its color to blue.Input Temperature value “76” and Time
value “00:20” in Step 3. Finally, the thermal program screen is shown below (Fig 5- 10).

Fig 5- 10

Apply Thermal Profile
You can apply the thermal programs of other experiments or projects in the following two ways:
► Click on Import menu to import thermal programs of other projects (Fig 5- 11).

Fig 5- 11

► Right click the thermal program area in either screen; then select Set to Default Thermal Program to set the
current thermal program as default.

❺ (Optional) Click on Parameter tab to enter parameters screen where all analysis parameters are displayed. The
parameters may vary with different projects.
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► The default parameters provided in the software are usually compatible with most commercial kits. You
can also modify the parameters according to test results or the protocol of your reagent kits.

► If you need to copy and paste the parameters, click on the parameter cell and select Copy menu; then select
the cells to be pasted and click Paste menu. The copy and paste functions are available in right-click menu
too.

► If you need to restore the current parameters to default values, click menu Revert to Default.

For more information on analysis parameters of different types of projects, please refer to Chapter 7
Software Application.

Fig 5- 12

❻ (optional) If necessary, click Rule tab to edit interpretation rules or apply external advanced rule file. The
interpretation rules are used to analyze experimental data and then to obtain conclusions of the sample. Please
contact the reagents provider for result interpretation rules. Enter comments in the box of “Result Interpretation”.

Fig 5- 13

❼ Click Save menu and then click Close menu to close the project.

Close the project file after creating or editing it, or you cannot apply it in the experiment.
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Chapter 6 Tools
The Tool module of STC-96A PLUS Real-time PCR System software is composed of three functions: Software Option is
used for configuring the software; Data Query is used to query certain data in multiple reslts; System Information is used to
view the LOG information of the system. This version of STC software only provides the Software Option function. For
more information about other functions, please contact the manufacturer.

6.1 Software Option
The Software Option function (Fig 6- 1) in the Tool tab is useful in modifying the interface display and the default modes
of operation. You can customize the Well Information Table, the Well Selector and the operation and display modes of
curves to your preferences. The Software Option function is valid for future experiment files but invalid for currently
running or existing files.

For currently running or existing files, you can modify the software options by clicking menu Preferences and
Table in the Experiment Wizard (effective only for the current experiment file).

Fig 6- 1

6.1.1 Preferences
6.1.1.1 Well Information Table Options:
► The default order of samples: To learn about how to configure the order of samples in the Well Information Table,

please refer to Page 19.
 Vertical: The samples in the table are sorted in a top-down mode in the Well Selector (A1, B1... G1, H1).
 Horizontal: Samples are arranged from left to right in the Well Selector, that is, A1, A2... A11,A12;
 Horizontal and Block A Priority: Samples are arranged from left to right, starting from Block A to Block B,

that is, A1,….,A6, B1, …H6, A7, A8…H12;
► Data Selection Mode: For more information on how to configure data selection in the Sample Information Table,

please refer to Page 19.
 Target: Click on a cell to select the row that contains the cell. In this way, you can select the infrmation of a

target;
 Well: Click on a cell to select its corresponding well;
 Sample: Click on a cell to select its corresponding sample. If the sample is single-tube, one single well is

selected; if the sample is multi-tube, then multiple wells of a set of samples are selected.
 Cell: Click to select a cell.

► Table Font Size: Set the font sizes of Well Information Table.
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► Using line-marks to delimate samples: If the current samples are multi-tube ones, they are separated by line marks.
Please refer to Page 19.

► Display concentration values in scientific notation: If there are concentration values such as concentration and
average concentration in the Well Information Table, they are displayed in scinetific notation.

6.1.1.2 Chart Options
► Curve Style: customize the thickness of curves in curve charts.
► Curve Color: customize the color of curves for each channel in curve charts (Fig 6- 2).

Fig 6- 2

► Y-Axis Scaling auto-adjust by: Determine how Y-axis displays in curve charts when selecting different wells.
Please refer to Page 21 for more information.
 All Curves: The Maximum value of Y-axis is the maiximun value of all curves in the Well Selector.
 Selected Channels: The Maximum value of Y-axis varies with selected channels.
 Selected project: The Maximum value of Y-axis varies with selected projects.
 Selected well: The Maximum value of Y-axis varies with selected wells.

► Show details when hovering over curves: Hover the cursor over the curve to display all detailed information of the
curve (such as the well No., channel). Please refer to Page 21.

► Amplification Curve normalization algorithm: You can modify the default normalized algorithm of the
amplification curve. After switching the algorithm, you need to adjust the threshold value.
 Relative fluorescence algorithm: The normalized amplification curve is made of the relative fluorescence of

each cycle. The fluorescence of raw data divided by the fluorescence of baseline is the relative fluorescence. The
default algorithm of STC system is relative fluorescence algorithm.

 Absolute fluorescence algorithm: The normalized amplification curve is made of the absolute fluorescence of
each cycle.The fluorescence of raw data subtracts the fluorescence of baseline to obtain the absolute
fluorescence.

► Display selected well on standard curve: If the Ct of a selected sample falls within the range of standard curves, this
sample (concentration and Ct) will be displayed in standard curve chart. Please refer to Page 51.

► Show baseline on Amplification Curve chart: To learn how to display the threshold line onto the amplification
curve, please refer to Page 50.

6.1.1.3 Well Selector Options
► Selection of Multi-tube Sample: To learn about how to setup the selection mode of multi-tube samples, please refer

to P17.
 Sample: In multi-tube experiments, when selecting a well in the Well Selector, all wells associated with this

well are selected, that is, a sample is the minimum unit of selection. If you select the checkbox of Press
Ctrl+well to select a single well, you are allowed to select a single wel by clicking it meanwhile pressing the
“CTRL” key.
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 Well: Click the wells to select them.
► Well Display:Modify the default information on the Well Selector.Please go to P18 for more information.

 Project Name: Displays the project name.
 Name: Displays the names of samples of “Unknown” or “Retest”; for other types of samples, the property of the

samples are displayed in the Well Selector.
 Label: For “Unknown” and “Retest” samples, labels of samples are displayed. For other samples, the Property

values are displayed.
 Tube Name: Display the tube name of the samples in the Well Selector.

6.1.1.4 Others
► Channel Selection: Customize the Channel Select mode according to your preferences. For more information, please

refer to Page 30.
 Press CTRL + Channel Button to Select Multi-channels:When pressing the channel button, you only select

the data of the selected channel; if you want to select multiple channels simultaneously, hold on the CTRL key
and click on channel buttons.

 Press Channel Button to Select/Deselect: Click the channel button to select the channel and click again to
cancel the selection.

► Hot lid settings: After the experiment, the instrument will automatically open the lid. This funtion is used to set the
wait time before the lid opens automatically. Please refer to Page 29.

► High-light Related Information on Hover: Hover the cursor on a specific value (well plate, curve or table), and all
information related to that value is high-lighted (data are shown in boldface while curves are boldfaced and black.).
See P30 for more information.

► Use Parameter Table: To set whether to display the analysis parameter table on the Analysis screen or not. See Page
31 for more information.

► Custom Export: Export experiment data based on an external configuration file.

6.1.2 Table column options
The Table Column option (Fig 6- 3) is used for setting the Well Information Table. Through Table Column, you can set the
information to be displayed or concealed under different types of analyses or define new columns.

Fig 6- 3

► Set the default display columns: Select Analysis Type in the drop-down list of Experiment Type and check the
appropriate field(s) from the field list. To relocate a filed, select it and clickMove Up orMove Down button. To
resume to Default, click default button at the bottom of the screen. Please refer to Page 18 for more information.

► Create new columns: If you cannot find the required column, click the Add Field button to add a new one. To learn
about how to add a column, please refer to Page 27.
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Chapter 7 Software application
The STC-96A PLUS Real-time PCR System supports multiple assay applications, including absolute quantitative /
qualitative detection, endpoint allelic discrimination, melting curve analysis, and high resolution melting curve analysis.
This version STC1.0.0 supports qualitative/absolute quantitative as well as melting curve analysis. This chapter describes
how to perform these assay applications.

7.1 Qualitative / absolute quantitative experiment

7.1.1 Introduction to qualitative / absolute quantitative experiment
Qualitative / absolute quantitative experiments are the most basic and commonly used functions. A qualitative experiment is
to detect whether target genes are existed in unknown samples, in other words, to make positive/negative judgments of
samples. An absolute quantitative analysis, which is useful in detecting the content of virus in clinical diagnosis in vitro, is
to determine the concentrations of target genes in unknown samples (for example, the number of copies per mL). The
following section introduces the theory of qualitative/absolute quantitative analysis, and explains the meanings of the
analysis parameters involved in the software.

About Real-time Quantitative PCR Test
During the initial phase of PCR amplification, the target sequence of DNA segments increased exponentially. However,
with the accumulation of amplification products and the degradation of enzymes activity, the amplification efficiency
declines. As a result, the reaction reaches a plateau period. The system monitors and records the whole PCR process and
draws the amplification curve. The following figure shows a typical amplifiction curve (Fig 7- 1).

Fig 7- 1

The above graph shows that real-time fluorescence PCR Melting Dev Curves are divided into 3 phases:
Baseline period: The baseline period refers to the initial cycles of PCR in which there is little change in fluoresece signal,
usually the first 10~15 cycles. The baseline is used to normalize the fluorescence signals. At the initial stages of PCR, given
the limited number of amplification products, the fluorescence signals are rather weak and are therefore buried in the
fluorescent background. As a result, the baseline period generally reflects the background of the whole system (including
the instrument and the reagents).
Linear period: As the PCR reactions proceed; the fluorescence signals of amplification products keep increasing and
ultimately go beyond the fluorescent background into the linear period. This is represented by an upward slope on the
amplification curve graph. The slope of the linear period can basically reflect the amplification efficiency. Efficiency of
amplification ranges from 0 to 1.
At the initial stages of the linear period, the fluorescence goes into a certain level, called the fluorescence threshold. The
fluorescence threshold is set to be above the baseline and sufficiently low to be within the exponential growth region of the
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amplification curve.When PCR amplification reaches the levelof fluorescence threshold, the corresponding number of
cycles is called Ct value, with C for cycle and t for threshold. Ct is negatively correlated with the raw template amount of
samples.
Plateau period : As the PCR reactions proceed, the amplification efficiency declines and the reaction reaches a plateau
period.

About absolute quantitative experiment and Standard Curve
In the real-time PCR, there is a log-linear relationship between the Ct value of each template and the initial copies of the
template. The more initial copies, the smaller Ct value is.
Absolute quantitative analysis is an analysis that tests a set of gradiently diluted standards of known concentrations and
unknown samples at the same time. At the end of the test, the Ct values of standards and unknown samples are obtained.
With the log value of the concentrations of standards for the X Axis and the Ct values of standards for the Y Axis, the
system draws a standard curve automatically. After the Ct values of the unknown samples are obtained, the initial
concentration of these samples can be easily calculated by means of the standard curve. This approach assumes that all
standards and unknown samples are similar in amplification efficiency. The concentration of of gradiently diluted standards
should include the range of clinical sample concentration and should fall within the linear ranges of the real-time PCR
instrument and the kit protocol.

7.1.2 Create Qualitative / absolute quantitative project

❶ Click Create button on the left of the Project Manager screen.
❷ Then click on the Gerenal tab to go to the following sreen (Fig 7- 2). Enter “HBV” in Project Name field; in the

Project Type drop-down menu, select Qualitative/Absolute Quantitative. Input “30” in Reaction Volumn field. If
necessary, edit the information of unit and comments.

Fig 7- 2

❸ Define the target information. Select the checkbox of Channel 1and enter the target name “HBV”. Similarly, enter “IC”
in channel 2.

❹ Click on the Program tab to edit the thermal program.For more information on how to create a thermal program,
please refer to P31.

❺ Click Parameters tab to modify experiment parameters according to your kit protocol. The parameters involved are
introduced as follows.

Fig 7- 3

Basic Parameters
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The above table is the Basic parameters for Qualitative / absolute quantitative experiment (Fig 7- 3). Every target
defined in General screen has below parameters.
 Analysis Type: If Quantitative is selected, the concentration of the target is calculated by means of an

internal or external standard curve; if Qualitative is selected, the concentration of the target is not
calculated.

 Baseline: Setup the parameters of Baseline Start, Baseline End and Baseline Optimization for the
current target. Given the influence of the probe or other factrors, the baseline of some samples may slope
upwards or downwards slightly, which could be optimized by Baseline Optimization.
► Baseline Start/End: By default, the Baseline Start is “6”, while the Baseline End is “12”. The

Baseline Start should avoid the initial cycles whose fluorescence values are still unsteady; the
Baseline End should be ahead of the linearity region of amplification curves.

► Baseline Optimization: The default Auto optimization will automatically selects the appropriate
baseline start/end values for each target. TheManual Optimization will use the manual baseline
start/end value. If you don’t need to optimize the baseline, select N/A.

 Threshold: The default Auto Threshold will calculate the optimal thershold value automatically. If you
want to determine thershold manually, deselect the checkbox of Auto Threshold and enter the proper
value inManual Threshold field. Beginners are recommended to useAuto Threshold or input the
appropriate threshold according to the kit protocols. The principles for setting the fluorescence threshold
are:
► The fluorescence threshold must be within the linear region;
► If the threshold is too low, detection errors will have a great effect on the experiment results;
► If the threshold is too high, the difference between tubes becomes exaggerated and a weak positive

result may be missed.
► The fluorescence threshold is adjusted to obtain the best linearity of the standard curve. .

 Digital Filter: Digital filter is used to remove jitter errors during detection and apply filter algorithm to
make fluorescence data smooth. “Digital filter” is generally applied when fluorescence signal is weak.

Quantitative Linearity Range
Quantitative Linearity Range is used to set the max/min detection limitations of reagents. Usually, the
quantitative range of a commercial Kit is usually from 500IU/mL to 50,000,000IU/mL. If samples exceed the
detection limitations, the sample concentration will show “Beyond limitations”. You can input the linear range of
quantitative detection by the kit protocol (Fig 7- 4).

Fig 7- 4

Crosstalk Calibration
The Crosstalk Calibration Table is used to calibrate the potential crosstalks between channels of a multi-color
experiment (multi-channel experiment). You can enter proper crosstalk calibrator values (Fig 7- 5) by following the
kit protocol. In a multiplex experiment, the wavelengths of light emitted by the dyes overlap, causing one channel
to pick up signals from more than one dye. This so-called crosstalk, which varies with diferrent kits, can cause
misleading data. Crosstalk calibration (also called color compensation) is required to correct for this bleed-over
between channels in multiplex experiments.
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Fig 7- 5

Use Copy and Paste menu in the menu bar (or the right-click commands) to make the editing more
convenient.

❻ Click the Rule tab to go to the screen of interpretation rules.If the result interpretation rules of the kit is simple, select
Use Basic Rule. If the interpretation rules are too complicated to be performed by Basic Rule, you need to select Use
Advanced Rule. Please contact the reagents provider for advanced rules of the kit. The basic rule (Fig 7- 6) is divided
into three items: Experiment Control is used to determine whether the experiment is vaild or not; Sample Control is
used to determine whether the sample is valid or not; Result Interpreation is used to analyze sample results and
generate conclusions.

Fig 7- 6

Here is an example of a quantitative detection kit for B Hepatitis nucleic acid:
Quality Control: The result of the negative control should be “No Ct”. The concentration of the high positive
control is higher than 1000000 copies/mL.
Results Interpretation: If the concenration of a sample is within 5000 ~ 500000000copies/mL, then the sample
is “Positive”. If the concentration is over 500000000, the conclusion of the sample should be “>500000000”. If
the concentration is less than 5000, the sample is repported as “Negative”.

The following steps display how to edit the above basic rules:
► Click to select Use Basic Rule.
► Select Use Experiment Control and Click Add button to add a new rule. Select “Negative" in the

drop-down menu of Sample Type. Select “HBV” from the drop-down menus of Target. Select “Ct” from
the drop-down menus of Data Type. Select “=” from the drop-down menus of Comparison. Select “NoCt”
from the drop-down menus of Value (Fig 7- 7). This rule represents the fact that the result of the negative
control should be “No Ct”.

Fig 7- 7

► Click Add button again to create a new rule. Select “Positive" and “HBV” for the Sample Type field and
the Target field. Enter “100000000” in the field of Value. In the drop-down menu of Comparison, select
“≤”. Select “Cn” for Data Type field (Fig 7- 8). This rule represent that the concentration of the high
positive control is over 1000000 copies/mL;



STC-96A PLUS Real-time PCR System

49

Fig 7- 8

► Select the checkbox of Use Result Interpretatin. Click Add button to create a new rule. Select “Sample"
and “HBV” for the Sample Type field and the Target field. Enter “5000”, “500000000” in the two fields
of the Value respectively. Select “≤” for two Comparison fields. Select “Cn” for Data Type field. (Fig 7-
9). Enter “Positive” in the field of Conclusion. Select red color in Color box. This rule represent that the
samples with the concentration within “5000-500000000” are given “Positive” conclusions.

Fig 7- 9

► Similarly, edit the rest rule as follows (Fig 7- 10).

Fig 7- 10

❼ Click the Save button; then click the Close buttons to close the project.

7.1.3 Create Qualitative / absolute quantitative experiment
❶ Click Experiment Wizard button on the Experimental Home screen to create a new experiment. Select

“Qualitative / absolute quantitative” from the Experiment Type, input general information of the experiment,
and configure the instrument as needed.

❷ Click Plate tab. Select the well to define on the Well Selector; then select the previously created project “HBV”
from the project list on the top right of the screen. Define the property of the selected wells on the bottom right.
Sample types and properties of qualitative/absolute quantitative experiments are shown in the table below:

Sample Type Descriptions Property

Standards Samples with known quantities, used to generate
standard curves concentration

Unknown Samples to be tested

Retest Suspicious samples to be retested

Negative Negative control samples

Positive Strong positive control samples

Low Positive Weak positive control samples

QC Positive quality control samples with known quantities concentration

NTC No template control samples

Create standards by Auto-Standards:
Select multiply wells in the Well Selector and click Auto-Standards menu in the menu bar to open the
following box which is used to create serial dituted standards. Enter the number of replicates in the Replicates
box.Then enter the appropriate values in the boxes of Initial Concentration and Dilution Factor. As shown in
the figure below (Fig 7- 11), 5 wells are selected, with the concentrations being “1000 ”, “10000”, “100000”,
“1000000” and“10000000”, respectively.
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Fig 7- 11

❸ If necessary, click the Sample tab and enter the patient information.
❹ Click Run tab and then click the Start button on the right of the menu bar to start the experiment.

❺ After the run is finished, a dialog box hinting that the experiment is completed pops up; and the result file will be
saved to the previous defined path. Then push the sliders open gently and remove the reactions tubes. Finally,
close the blue sliders by gently pushing it back. Cover the instrument with a dustproof cover.

For more information about how to perform an experiment, please refer to4.3 How to Create and Run an
Experiment.

7.1.4 Analysis of qualitative / absolute quantitative experiment
❶ After the experiment is complete, the program will automatically analyze data and switch to the Analysis tab

(Fig 7- 12). You can view the experiment data on the Analysis interface. On the top left of the interface is the
Well Information Table. In qualitative analysis, Ct and conclusion will be displayed. In quantitative analysis, Ct,
concentration and conclusions will be displayed in the table. The curve chars displayed on the right include Raw
Amplification Curve, Amplification Curve, thermal program and Standard Curve.

Fig 7- 12

► Amplification Curves: show the normalized amplification curve and the fluorescence threshold line. To
hide the threshold line, click menu Preferences and deselect "Show baseline on Amplification Curve
chart" in the Chart Options. If there are curves of a single target displayed in the chart, users are allowed
to modify the threshold values by dragging the threshold line (Fig 7- 13).
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Fig 7- 13

► Raw Amplification Curve: The Raw Amplification Curve (Fig 7- 14) shows the original fluorescence
curve of the selected sample, which is the actual fluorescence signal detected by the instrument.

Fig 7- 14
For more information on viewing experiment information, please refer to 4.4 View and analyze an
experiment.

❷ In quantitative analysis, the program will calculate the concentrations of samples (Fig 7- 15).

Fig 7- 15

Standard Curve
On the top right of the screen is displayed all the standard curves (Fig 7- 16) of targets of quantitative analysis.
Standard curves can be classfied by sources into external standard curves and internal standard curves. The
internal standard curve refers to the standard curve drawn based on standards in the current experiment. To
export data of standard curve, right-click and select “Export Data”.

Fig 7- 16
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If the selected sample falls within the linear range of the standard curve, the sample will be displayed on the
standard curve. To hide this function, click on Preferences and uncheck "Show selected wells on Standard Curve
chart" in the Chart Options.

Save as external standard curve
To save the internal standard curve, click the Save button in the External Standard Curves menu; check the
project whose standard curve to be saved, input a name and reagent batch information, and then click Save (Fig 7-
17).

Fig 7- 17

Import External Standard Curve
If no standard is set in the experiment or the number of valid standards is less than 2, the software will pop up
the following box (Fig 7- 18 left) to remind users to apply an external standard. When you click Confirm, the
dialog box of Apply External Standard Curve will pop up (Fig 7- 18 right). Check the option Use External
Standard Curve behind the project name, select an appropriate external standard curve in the drop-down menu
of the File Name, and then click Confirm.

Fig 7- 18

If not satisfied with the internal standard curve in the experiment, you can apply external standard curves.

External Standard Curve Management
Click External Standard Curve Manager in the drop-down menu of the Standard Curve to open the following
window (Fig 7- 19). The screen shows all of the standard curves aved by the software. Click Import to import a
standard curves to this folder; select a standard curve in the list and click Export to save it to another path.

Fig 7- 19



STC-96A PLUS Real-time PCR System

53

7.2 Melting Curve Experiment
7.2.1 Introduction to melting curve analysis
The purpose of Melting Curve analysis is to determine the characteristic melting temperature of the target DNA and to
identify or genotype products based on their melting temperature.The temperature at which a DNA strand melts when
heated can vary over a wide range, depending on the sequence, the length of the strand, and the GC content of the strand.
The melting temperature (or Tm) of a sample is defined as the point at which half of the DNA has melted or half of the
probes have melted off the DNA. It varies with different sequences of DNA. Based on the differences in melting
performance and Tm values, we can discriminate the different samples, for example, checking the specificity of PCR
amplification products, genotyping analysis.

7.2.2 Creating Melting Curve Project
❶ Click Create button on the left of the Project Manager screen to create a new project.

❷ Click General tab (Fig 7- 20) and select “Melting Curve” in the drop-down menu of Project Type; Enter project
name and reaction volumn. If necessary, enter comments information.

Fig 7- 20

❸ Define target information (Fig 7- 20) in the table of Target Information according to the kit protocol.More
information on target defining, go to 5.2 Create Project.

❹ Click on the Program tab.Follow the kit protocol, edit the thermal program. The thermal program of melting
curve ususlly composes of a PCR program and a melting segment. To see how to edit the PCR program, please

refer to Page 36. To modify the melting segment, change the temperature of the melting box by dragging it.

Then select proper scanning mode at the bottom of the melting segment. The following table explains the
meaings of the two scanning modes.

Type Descriptions Parameters Description

Continuous

While the reaction block of the instrument
heats up at a given rate, the scanning
system keeps scanning and collecting
signals.

Ramp Rate

The ramp rate of the reaction
module.
Input value within the range of
0.01 ~0.06℃/s.

Step

The scanning system scans and collects
signals at certain temperatures, when the
reaction module sustains the level of
temperature for some holding time.

Scanning
Interval

The scanning intervals of
temperatures for the scanning
system.
Input value within the range of
0.1 ~1℃.

Holding
Holding time of each step
Input value within the range of
8~99s.
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Fig 7- 21

❺ Click Parameters tab to modify experiment parameters. If PCR amplification is included, you may need to
adjust basic parameters. For multi-plex melting curve experiments, sometimes Crosstalk Calibration is necessary.
For more information on Basic Option and crosstalk correction, please refer to Page 47.
TheMelting Curve Parameters tab is used to analyze the melting curves, their functions are introduced as
follows:
► Min temperature: define the minimum temperature of the melting curve. All melting peaks below that

temperature are ignored.
► Max temperature: define the maximum temperature of the melting curve. All melting peaks above that

temperature are ignored.
► Peak Height Threshold: it is used to exclude non-specific peak.

Fig 7- 22

❻ If necessary, click Rule tab to apply the advanced rule file obtained from the reagent manufacturer.
❼ Save and close the project.

7.2.3 Creating Melting Curve Experiment
❶ To create a new experiment, click Experiment Wizard button on the Experimental Home screen.
❷ Click the Setup tab, select “Melting Curve” from the Experiment Type, input general information of the

experiment, and setup the instrument as needed.
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Fig 7- 23

❸ Click Plate tab. Select wells to define on the Well Selector; and then select the previously created project from the
project list on the top right of the screen. Define the properties of wells.

Fig 7- 24

❹ If necessary, click Sample tab and enter the patient information.
❺ Click Run tab and then click the Start button on the right of the menu bar to start the experiment.
❻ After the run is finished, a dialog box hinting that the experiment is completed pops up. Push the sliders open

gently and remove the tubes. Finally, close the blue sliders by gently pushing it back. Cover the instrument with
a dustproof cover.

For more information about how to create an experiment, please refer to 4.3 How to Create and Run an
Experiment.

7.2.4 Standard melting curve analysis
❶ After the experiment is complete, the program will automatically analyze results and switch the Analysis

interface. On the top left of the interface is the Well Information Table, which displays the Tm value and the Rm
value of the target.

Fig 7- 25
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For more information on viewing experiment information, please refer to 4.4 View and analyze an
experiment.

❷ The curves charets displayed on the right include Melt Peak Curve, Normallized Melt Peak, Raw Amplification
Curve, Amplification Curve, Raw Amplification Curve and Thermal Program.
► Raw Melt Curve: The Raw Melt Curve shows the actual temperature Vs fluorescence value curves of the

selected sample.

Fig 7- 26

► Melt Peak Curve: It is also called derivative melting curve. In the chart, the max/min temperature
threshold curves are shown. If the chart only shows curves of a single target, you can adjust the temperature
threshold by dragging the temperature threshold line.

Fig 7- 27

► Normallized Melt Peak: The raw melting curve, after the deduction of fluorescent background in the
baseline period of PCR amplification, derives into the normalized melt peak.

Fig 7- 28



STC-96A PLUS Real-time PCR System

57

Chapter 8 Maintenance

8.1 Cleaning the Instrument
Cleaning the Instrument
► The surface of the instrument should be cleaned periodically with a soft, lint-free cloth dampened with water. If

necessary, use 70% ethanol solution to wipe off dirt.

Cleaning the Sample Wells
► Dust or other impurity fallen into reaction wells may interfere with fluorescent signal collection. Use blow brush

provided by manufacturer to clean the reaction wells per 3 months.
► To prevent dust from entering the sample well, always keep the blue slider closed except when inserting sample tubes,

and cover the instrument with dustproof provided by manufacturer when the instrument is not in use.
► If dust falls into reaction wells, clean the reaction wells with a soft, lint-free cloth dampened with 70% ethanol solution.

Always turn power off and remove the power cord before cleaning the instrument.
Never pour fluids into the reaction wells or the interior of the instrument.
Consult the manufacturer or distributors if users use cleaning solutions which are not recommended by the
manufacturer.

8.2 Instrument Protection
► Do not turn the instrument on and off frequently. There must be an interval of more than 30 seconds between turning the

machine on and turning it off.
► Do not power the instrument off immediately after running as the reaction block is still hot, wait an appropriate time

period (the fans in the instrument will cool down the reaction block ) to let the temperature falls to room temperature.
► Always use power cords provided by the manufacturer.

Boiling the instrument at 99°C or holding at 4°C is strictly prohibited.

Users are forbidden to disassemble the instrument.

8.3 Replacing Fuses
The STC-96A PLUS instrument contains two 10A, 250V fuses located at the rear panel of the instrument. To replace a fuse:
Use a screwdriver to unscrew the cover of the fuse box in counterclockwise direction, then exchange the blown fuse with a
replacement fuse (Φ5×20mm – 10A, 250V) and insert the fuse together with the cover. Plug the power cord after the fuse is
replaced.

Always turn power off and remove the power cord before replacing fuses.

8.4 Handling of Waste
There are a lot of amplification products in the PCR tubes after running, which should be disposed of as quickly as possible.

Do not open the PCR tubes as this will give rise to laboratory contamination.

8.5 Overheating Protection
The thermal cycler unit of the instrument is equipped with an overheating protection device. When the thermal cycler unit
breaks down and its temperature reaches beyond the temperature threshold, the overheating protection will disconnect
automatically and will not resume heating automatically when the device cools down. When this happens, the thermal unit
fails to work properly to control the rise and fall of temperature.

Users must immediately stop using the instrument and contact manufacturer once the above failure occurs.
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Appendix I Patient Report Template

1. Patient Report Manager
In Experiment Wizard screen, click the drop-downn menu of Print and select Patient Report Manager menu to enter the
Patient Report Manager (Appendix 1- 1). Here the software provides multiply templates of patient reports. Click on a
template for a preview. Click Import to save other style templates to the default path; click Export to save the selected
style template to another path.To delete a patient report template, click it and click Delete.

Appendix 1- 1

Please refer to 4.7.1 Print Patient Report for information on how to print patient reports.

2. Create Patient Report Template
Click the drop-downn menu of Print and select New Patient Report Template to create a new template. In the pop-up box,
enter the file name. Click Confirm to open a blank Microsoft word 2007 file, in which you can create the patient report
template. The software locates information by way of finding/replacing keywords. The following table shows all the
information and keywords of a patient report form.

Name Key words

Sample label $label#

Name $name#

Sex $sex#

Age $age#

Hospital $hospital#

Case ID $caseid#

Bed ID $bedid#

Out-patient ID $outpatientid#

In-patient ID $inpatientid#

Date Collected $collectdate#

Test Date $testdate#

Report date $reportdate#

Department $office#

Diagnosis $diagnosis#

Specimen Type $sampletype#

Doctor $doctor#

Operator $operator#

Auditor $assessor#

Target $targetname|extension#
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Ct $ct|extension#

Concentration $cn|extension#

Unit $unit|extension#

Target Conclusion $targetconclusion|extension#

Well Conclusion $wellconclusion|extension#

Sample Conclusion $sampleconclusion|extension#

Threshold $threshold|extension#

Remark $remark|extension#

Amplification Curve $curve#

Project Name $project#

Note: The format of the extension is “project name | tube number|channle number”. If there is only one project in the report,
the name of the project is omitted while the extension is written in the format of “tube number|channle number;” if you need
to print several projects into one report, the project name cannot be omitted.
The following example shows how to create a patient report template (Appendix 1- 2). This report provides information of
the hospital, the patient, the diagnostic conclusion and the PCR Amplification Curve of the patient.

Appendix 1- 2

In the opened word screen, input information and keywords by following the figure below (Appendix 1- 3).

Appendix 1- 3

Insert any picture in the appropriate location. Right-click the picture, select “Size...” to open the following dialog box.

Appendix 1- 4
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Click the Alt Text tab and input “$curve#” in the text box. When the editing of the style template is finished, the template
appears as follows (Appendix 1- 5).

Appendix 1- 5

3. Setup Patient Report Template
Click on the Print drop-downn menu and select Patient Report Setting (Appendix 1- 6). Input the appropriate information
in the Hospital Name field, which will be displayed in the title of the patient report form. Match the right printing form for
the project by clicking the field and selecting a report.

Appendix 1- 6

Click the Print Option tab. You are allowed to give marks to each channel when you print reports by a black-and-white
printer (Appendix 1- 7).

Appendix 1- 7
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Appendix II Fundamental Algorithm
1. The Fundamental Algorithm in Quantitative PCR Detection is derived as follows:

F1 - Original value of fluorescence intensity in reference well 1 at Ct1 cycle
F2 - Original value of fluorescence intensity in reference well 2 at Ct2 cycle
f1 - Fluorescence intensity after normalization in reference well 1 at Ct1 cycle
f2 - Fluorescence intensity after normalization in reference well 2 at Ct2 cycle
K0 - Background fluorescence coefficient
K - Signal fluorescence coefficient
I1 - Exciting light intensity of reference well 1
I2 - Exciting light intensity of reference well 2
C1 - Initial concentration of reference well 1
Ct1 - Ct value of reference well 1
C2 - Initial concentration of reference well 2
Ct2 - Ct value of reference well 2
E - Efficiency of amplification

If amplification efficiency of reference well 1 is equal to well 2 and their background fluorescence coefficients are also the
same, fluorescence intensity of the two wells are,

F1 = K0*I1 + K*I1*C1*（1+E）Ct1
F2 = K0*I2 + K*I2*C2*（1+E）Ct2

Where K0*I is fluorescence intensity in base line.
f1 = LOG（F1/（K0*I1））= LOG（1+（K/K0）*C1*（1+E）Ct1）
f2 = LOG（F2/（K0*I2））= LOG（1+（K/K0）*C2*（1+E）Ct2）

Since normalized fluorescence intensity at Ct cycle of every well is equal, that is to say, f1 = f2 = Fluorescence Threshold,
the following expressions are obtained,

LOG（1+（K/K0）*C1*（1+E）Ct1）= LOG（1+（K/K0）*C2*（1+E）Ct2）
1+（K/K0）*C1*（1+E）Ct1 = 1+（K/K0）*C2*（1+E）Ct2

C1*（1+E）Ct1 = C2*（1+E）Ct2
C1/C2 =（1+E） Ct2-Ct1

Taking the Log of the above converts it to
（LOG（C1）- LOG（C2））/（Ct1 – Ct2）= - LOG（1+E）

The above formula shows that: The LOG value of the initial concentration of the sample under detection is in inverse
proportion to its Ct value. Its slope is -LOG (1+E).

2. The formula to calculate R-Value
The best R-Value is -1, which means all the points of Standards are located in the standard curve. Please refer to reagent
guidelines for the acceptable range of R-Value. Generally the R-Value is -0.99 ~ -1.

The formula to calculate R-Value is:

r =
X − X� Y − Y��

X − X� 2 Y − Y� 2��
Where: r Value in the X axis

X Data in the X axis
X� Average value of all the Data in the X axis.Data in the Y axis
Y Data in the Y axis
Y� Average value of all the Data in the Y axis.
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3. Algorithm for CV Value
CV Value indicates the repeatability of detection. After detecting n tubes with the same initial concentration, the CV value of
these tubes is calculated to check the repeatability. The best CV value is 0% where all values are identical.

The formula to calculate CV-Value is:

CV =
X − X� 2� n − 1

X� × 100%

Where, CV CV Value
X Data
X� Average value of all the Data
n Data count
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Appendix III Troubleshooting
No. Observation Possible Cause Recommended Action

1 Unable to install the STC1.0.0 software or
the software running improperly

1. Operation System
corruption.

2. Computer hardware does
not meet the minimum
requirements.

1. Reinstall the Windows
operating system.

2. Replace your computer
with one of better
configurations.

2 Error Message: “Cannot connect to the
instrument!”

1. The instrument is
powered off;

2. The RS232 cable or
USB-to-RS232 is not
securely connected;

3. The USB adaptor driver
is not installed
successfully.

1. Turn on the instrument;
2. Check the cables

between PC and
instrument;

3. Install USB driver
manually

3 Error Message: “Locating Slider failure!” The slider of the instrument is
not in place.

Push the slider to the right
location.

4 Error Message: “Failed to close hot-lid!” 1. Communcation failure
2. Hot-lid malfunction

1. Check the coomunication
connection between PC
and instrument and then
restart the run;

2. Contact the distributor or
manufacturer.

5 Error Message: “Failed to heat up hot-lid!” Hot-lid malfunction Contact your distributor or
manufacturer.

6 Error Message: “Hot-lid temperature out of
range!”

Hot-lid malfunction Contact your distributor or
manufacturer.

7 Error Message: “Failed to open hot-lid!” Communcation failure Switch off the instrument;
wait a few minitues and then
switch on the instrument

8 Error Message: “Block temperature out of
range!”

Thermal cycler unit
malfunction.

Restart the instrument and
contact the distributor or
manufacturer.

9 Error Message: “Sending commands failed!” Data communcation failure. Restart the instrument/PC.

10 Error Message: “Communication Error!” 1. PC run out of menory;
2. Instrument malfucntion

1. Close unnecessary
applications.

2. Contact your distributor
or manufacturer.

11 Error Message: “Instrument Connection
Failure!”

1. The instrument is
powered off;

2. The RS232 serial cable or

1. Verify the power of the
instrument;

2. Verify the cables
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No. Observation Possible Cause Recommended Action

USB-to-RS232 converter
cable is not properly
connected;

between PC and
instrument;

12 PC/instrument Suddenly loses power during
a run.

External power failure. Turn on the instrument/PC,
and resume the run from
breakpoint.

13 Unsatisfactory correlation coefficient of
standard curve

1. The inaccuracy of
standard’s concentration
caused by repeated
freeze-thaw steps.

2. Operational error.
3. PCR reagents not

functioning correctly.
4. The reagents used are

incompatible with the
STC-96A PLUS
instrument.

5. Wrong input of the
concentrations of the
standards.

1. Redo the serial dilution
of the “standards”.

2. Standardize the
operation.

3. Contact the reagents
provider.

4. Contact the reagent
provider or the
manufacturer.

5. Reenter the
concentrations of the
standards.

14 Real-time fluorescence curves in early cycles
are not clear

1. High thermal capacity of
olefin oil.

2. Poor quality of
fluorescence probe.

3. Air bubble(s) in PCR
tubes

STC-96A PLUS software has
been optimized to eliminate
the effects caused by uneven
curves in early cycles.
However, users are still
required to centrifuge before
PCR test to remove the
bubble(s) or residue reagents
on the tube wall.

15 Some sample(s) with severe slope of
fluorescence baseline

1. Improper sampling or
pretreatment (hemoglobin
release caused by
hemolysis, or
contaminated by other
impurity)

2. Protein/impurity was
included when collecting
supernate.

3. No standardization of the
pretreatment of samples.

1. Remove impurity, avoid
hemolysis, centrifuge to
remove sediment.

2. Be careful when
collecting supernate.

3. Standardize the
pretreatment of samples.

16 All sample(s) with slight slope of
fluorescence baseline

Poor quality of fluorescence
probe.

Select Baseline
“optimization” to minimize
unwanted slope.
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No. Observation Possible Cause Recommended Action

17 Sporadic sample(s) with slight slope of
fluorescence baseline

The tubes are leaking or the lid
is loose.

Select Baseline
“optimization” to minimize
unwanted slope.

18 Sporadic sample(s) with severe oscillation of
fluorescence curves

Low fluorescence signals,
empty well(s), empty tube(s),
or no fluorescence substance,
such as water, etc.

Designate the free sample
wells as “Blank”.

19 All sample(s) with slight oscillation of
fluorescence curves

Low fluorescence signals. Select “Digital Filter” to
smooth the curves
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